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About this Guide

Using this Guide

This Guide provides the Installation Roadmap for the Centric 8 PLM Software Application. The
document outlines the hardware and software Installation checklist as well as the Pre-
requisites for Installing the Centric 8 Application. This document also provides a detailed
step-by-step explanation on how to install the Application on either a Single Server or a Dual

Server.

Technical Support

Customer Support is available to all registered users of Centric 8.
1.866.796.6218 8:00 AM-8:00 PM EST

Email: support@centricsoftware.com

Providing feedback on Documentation

Email us your feedback regarding documentation to documentation@centricsoftware.com

stating the following in the subject line:

Feedback regarding “Document Name”’

Getting more information
We provide a range of online documents for registered users:

=  Administrator Guide
=  PDF Print Service Installation Guide
= Image Service Installation Guide

= Requirements Guide

Conventions

This document uses the following conventions:

Example Indicates

In the Choose Database Server Location In the Choose Database

dialog box, select the Local database radio Server Location dialog box,

button. use the mouse to click on the
radio button corresponding to

Vi


mailto:support@centricsoftware.com
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the Local database.

Select Tasks » Detach Select the Tasks menu item
and then select Detach from
the options.

Press ALT+TAB On the keyboard, press both

ALT key and the TAB key
simultaneously.

This document uses the following font conventions:

Font Convention Indicates Example
Bold Field Name, Dialog box name, Click on Next.
Screen or Page name, Button
or Radio button name,
keyboard keys
Italics Topic Reference If you are planning to configure shared WebAccess
directory refer to WebAccess Shared Directory
Installation on page 100.

Text in brown Path/File Name/Folder Name <centricinstalldirectory>\ wildfly-
(Font type: 8.1.0\standalone\ configuration\ standalone-
Garamond) pi.xml

This guide also uses the following terms for mouse actions. Use the left mouse button unless
instructed otherwise.

Actions Example |
Click Click the mouse button

Right-click Click the right mouse button

Double-click Click the mouse button twice without moving the mouse

vii
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PART I: INSTALLATION & CONFIGURATION
REQUIREMENTS

Included inPart | :

I =  Chapter 1: Installation Roadmap

PART 1: INSTALLATION & CONFIGURATION REQUIREMENTS 8
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1. INSTALLATION ROADMAP

1.1 INSTALLATION

You have two installation paths when installing Centric 8 on either Single Server or the Dual
Server. For more information on Server requirements, refer Centric 8 Requirements Guide.
1.1.1 Single Server Installation

In the case of a Single Server Installation, install the application software, database and the
FileVault on a single server which communicates with the Microsoft 11S Web Server to deliver

content to the client systems.

Figure 1-1: Single Serwer Installation
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1.1.2 Dual Server Installation

In case of dual server installation, install the application software and FileVault on Server 1
and the database on Server 2. Servers 1 and 2 communicate through JDBC, and Server 1
communicates with the Microsoft 11S Web Server to deliver content to the client systems.

Figure 1-2: Dual S erver Installation
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1.1.3 Installation Roadmap

Refer to the following flowchart (Figure 1-3) below, which explains the process of installation

depending on whether it is a Single Server or Dual Server Installation.

Figure 1-3: Installation Roadmap
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PART II: INSTALLATION, CONFIGURATION &
TESTING

Included in Part II:

=  Chapter 2: Centric 8 Installation Checklist

= Chapter 3: Single Server Software Installation

=  Chapter 4: Dual Server Software Installation

= Chapter 5: Configuration & Testing

= Chapter 6: Application Software Installation
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2. CENTRIC 8 INSTALLATION CHECKLIST

Review the following checklists before starting the Centric 8 software installation; this list is
based on the requirements for an OOTB Centric 8 installation. Use this checklist to determine
how best to configure Centric 8 including server set up recommendations. These checklists
apply to both the Single Server and Dual Server installation except where noted.

2.1 HARDWARE CHECKLIST

1.

If you install the Centric 8 server database on a shared server, it must be a separate ‘instance’ to
minimize the impact of other database (Dual Server configuration).

Use a 64-bit operating system with Windows 2012 Server or Windows 2008 Server or 2008 R2
and Microsoft 1S Web Server version 7.0 or above.

On the database server, verify that the SQL instance port is not blocked by the Firewall. If it is
blocked, set it as exception.

Split the database and the temporary database (TEMPDB) between two separate physical disks.

If the database tables are located on virtual drives, verify that the TEMPDB is on virtual drives at
the physical level, and are completely independent. In other words, do not simply use another
virtual drive that is a “slice” across a disk array used to support other virtual drives. If you are
using RAID technology, ensure 1 RAID array for TEMPDB and a different RAID array for C8 DATA
TABLES.

Allow additional disk space for Filevault expansion based on projected image and document
storage.

2.2 SOFTWARE CHECKLIST

1.

When you select the Filevault location, you must select a local disk, if you are using Single or
Dual server installation. For cluster setup, select a network shared folder.

Determine the administrator username and password before installation and always use the same
username and password for the first installation as well as for future upgrades or reinstallation.

U The following characters are not supported in SQL Administrator
- password in Centric 8 installation: 26, ™, &, *, O, “

e —
IMPORTANT

Verify that C8 username and password match in server and application installation; if they do not
match, the installation will fail.

If the Wildfly service is not manually stopped, the installer automatically stops it before
installation, upgrades, restoration and reinstallation.

Close all applications including the Window Services dialog box before installation.

You must have SQL Server administrator rights to create tables and the database, as well as for
mixed mode authentication. Make sure SQL Instance port is configured to use static port.

You must have the following Microsoft 1IS Web Server Port details:
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= Set to port 80 (this is the default HTTP port).
= Set other web servers to a separate port address.

=  Set user account to IUSER-<machine-name>; you must have both read and execute
permission to the installation directories

If you are using the Microsoft IIS Web Server version 7.0 or above, you must
add the ISAPI and CGI modules when installing IIS.

Do not use an underscore “_” character in the machine name as it is not

supported in the host name by Internet standards and may cause an error.
Machine names must contain only alphanumeric characters (use upper and
lowercase letters, and/or numbers) or the dash “-” character; however, a dash
character cannot appear at the end of a machine name.

eyt
IMPORTANT

8. If you are planning to configure Wildfly Cluster, refer Appendix B, Wildfly Cluster.

9. If you are planning to configure shared WebAccess directory refer to WebAccess Shared Directory
Installation on page 185.

2.2.1 Supported Browsers

IE9, IE10, IE11, Firefox and Chrome.

2.3 PRE-REQUISITES

1. System Admin Privilege

To create and set up an Oracle database for Centric PLM software, the user who is preparing
the database must have System Administration authority over the system and the database
to be created.

U The following characters are not supported in SQL Administrator
password in Centric 8 installation: %, ™, &, *, ), “

e
IMPORTANT

2. HTTPS

If the server has HTTPS redirect rule enabled on 1S, disable it before proceeding with the
installation, else the installation will fail.

3. Oracle 11G Software Installed

The Oracle Database 11G Enterprise Edition Release 2 (11.2.0.3+) 64- Bit is recommended.
The Database hosting system has to meet the minimum Hardware requirements specified in
the Oracle Database Installation Guide. To achieve better performance for Centric PLM
Software, the Oracle database should be configured on an efficient machine.

4. Oracle Database Software

Before creating an Oracle database to serve Centric PLM, the Oracle Database Software must
be installed.
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5. Minimum Required Oracle DB Components

This guide provides a minimal list to create a database using DBCA or upgrade an existing
database to meet Centric PLM requirement.

6. Oracle Database Components
Centric PLM requires the following Oracle Database Components:

= Oracle Workshop Manager

= Oracle Database Catalog Views

= Oracle Database Packages and Types
= Oracle XML Database

7. Drive Structures
For better performance, it is best to have the drive structure as mentioned below.

FOR SINGLE SERVER

C: OS & Program Drive (C: drive for C8 Program installation)
D:\SQLDATA C8 Database files (.mdf/*.ndf)

LASQLLLOG C8 Database files (*.Idf)

FAFILEVAULT C8 Filevault directory (Image and print service Log)
T\SQLTEMP Temp Drive (for Windows and SQL Temp files only)

FOR DUAL SERVER - APPLICATION SERVER

C: OS & Program Drive (C: drive for C8 Program installation)
FAFILEVAULT C8 Filevault directory (Image and print service Log)
T:\WINTEMP Temp Drive (for Windows Temp files only)

FOR DUAL SERVER - DATABASE SERVER

C: OS & Program Drive (C: drive for C8 Program installation)
D:\SQLDATA C8 Database files (.mdf/*.ndf)

LASQLLLOG C8 Database files (*.Idf)

TA\SQLTEMP Temp Drive (for SQL Temp files only)

To install C8 using LDAP Authentication, contact technical support for configuration details.

Contact technical support for SMTP details. For information regarding settings and how to
configure it on your production server refer Appendix E, Configuring SMTP_on Windows 2008
Server.

For technical support, collect the product details from the Centric 8 Cover Page, and contact
Customer Technical Support:

Telephone: 866.796.6218 (8:00 AM — 8:00 PM Eastern Standard Time)

Email: support@centricsoftware.com
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3. SINGLE SERVER SOFTWARE INSTALLATION

Proceed Installation with

the Database Selection

Oracle /SQL
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3.1 SINGLE SERVER SOFTWARE INSTALLATION

Use the following set of instructions to install the server software for your Single Server
installation.

Before starting this installation, verify that all hardware and software
specifications are met based on Centric Software recommendations;
see the Centric 8 Requirements document for more information.

I’ Note that during database installation, the Database Administrator user

NOTE name and password are used to create the database user csidba, and

I to create the database and table. Once the database is created,

— database access from Wildfly uses the database user csidba user name
and password created during installation.

If you install Centric 8 Server database on a shared server it must have
a separate SQL instance to minimize the impact of other databases.

1. Select your domain name and log into the domain as Administrator.

2. Close all open Windows applications. Copy the \\install\C8Server directory to the server.

U To install Centric 8, right-click Setup.exe and select Run as
Administrator.

e
IMPORTANT

3. The Welcome dialog box is displayed. Read the contents of the Welcome page.

Figure 3-1: Welcome dialog box

‘Welcome bo the Centnic B Selup program. This
peogeam il install Centnc B on pour computer,

It is stronghy recommendad that wou et all Windows programs
bedote nnning this Setup program.

Chick Cancel to quit Setup and then closs any progeams pou
have running. Chick Next 1o continue with b Setup progeam.

WARNING: Thes program i protected by copyight law and
ntetnational reaties.

Unauthonzed reproduction o distibubion of this program, or ang
poitson of i, may resull in severe civl and ciminal penalties, and
wall be prosecuted to the mammum extent possible under Law.

] oo |

4. To begin Installation, click on the Next button. The End User License Agreement dialog box is
displayed.
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Figure 3-2: End User License Agreement dialog box

End User License Agreement

Pleace read the: followang icense agresment. Llze the scroll bar to view the rest of
thiz agreement.

| CENTRIC SOFTWARE END USER LICENSE AGREEMENT -
WOTICE TO END USER: CAREFULLY READ THE FOLLOWING LEGAL

AGREEMENMT. USE OF THE SOFTWARE PROVIDED WATH THIS

AGREEMEMT ITHE SOFTwAREN CONSTITUTES YOUR ACCEPTANCE

OF THESE TERMS. IF Y'0OU DO NOT AGREE TO THE TERMS OF

THIS AGREEMEMNT, FROMFTLY RETURN THE 50F TWARE AND THE

ACCOMPANYING ITEMS TO THE LOCATION WHERE YOU OBTAINED

THEM FOR A FULL REFUND.

IT IS5 EXPRESSLY AGREED THAT THE TERMS OF THIS AGREEMENT

SHaLL SUPERCEDE THE TERMS OF ANY CUSTOMER PURCHASE ORDER

OR OTHER ORDERING DOCUMENT. IF AS THE END USER Y0OLU HAVE

AN EXISTING AND/OR ADDITIOMAL SIGNED LICEMCE AGREEMEMT

'WITH CENTRIC SOFTWARE. THAT AGREEMEMNT WILL TAKE PRECEDENCE.

1. Obgect Code Licenze Grant. Centric Software grants :[

D3 pou accept all the teims of the preceding boense agresment? [f so,
chick on the Yes push button. If you select Mo, Setup will cloze.

¢ Back | Yes I Ho [

5. Read the license agreement, and then click on the Yes button to accept the license agreement.
The User Information dialog box is displayed.

User Information

6. In the User Information dialog box, Enter your user name and company name in the Name and
Company fields respectively, and click on Next.

Figure 3-3: User Information dialog box.

: Pleaze anber pour name and the namas of the company fon whom
e:8ht you wark.

« Back, Heat » Cancel

7. The Choose Destination Location dialog box is displayed as show below.
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Figure 34 User Information dialog box

Frtup vl nstal Contag B i el dolceng fokh

T weniall 1os Hh ok, k. Heat

Tomatall b difecent folder, chick Bacsvse and select another
L]

ot can chioode niod ba ksl Cenine 8 by chobng Canced by et

[Dheatmabion Fobds
C:\Progeam Files\Cenisic SoltwarehC8 Ejowrze
<ok [THedz | Conce |

8. To accept the default destination folder, click on Next. Else, to select a different destination
folder, click on Browse and click on Next.

|<< BACK TO FLOWCHART

Install Centric 8
9. The following Install Centric 8 or Database Only dialog box is displayed.

Figure 3-5: Install Centric 8 or Database Only dialog box

Install Centric 8 or Database Only

Fleass choose to install ether Ceninc 8 with database or ondy the
databaze
& Leniric 8 (nchudes database]
" Database Oy
¢ Back Mest > Cancel

10. Select Centric 8 (includes database), and then click on Next.

11. The first time Centric 8 is installed, the Choose Centric 8 License Location dialog box is
displayed.

SINGLE SERVER SOFTWARE INSTALLATION
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Figure 3-6: Choose Centric 8 License Location dialog box

Choose Centric 8 License Location

« Back Mest » Cancel

12. Click on Browse and navigate to the folder containing the C8.lic license file; click on Next.

Once you select the file location, Centric 8 confirms the license file and
installation process continues and the Choose new or Existing
r Application Server dialog box is displayed.

NOTE . . . .
However, if you cannot locate the license file, an error message will be

— displayed and the installation will terminate. If you are upgrading or
installing a new build on the machine, the Choose License Location
dialog box will not be displayed.

13. The Choose New or Existing Application Server dialog box is displayed.

|<< BACK TO FLOWCHART

Wildfly Service Installation

14. In the Choose New or Existing Application Server dialog box, install Wildfly on your system,
select the Install Wildfly radio button. To use a previously installed instance of Wildfly running
on your system, select the Use Installed Wildfly radio button. Click on Next.
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Figure 3-7: Choose New or Existing Application Server

Chioose f pou want to matal Wikdly o f pou sheady have
';ut-iudhl'ﬂ'lrmhﬁﬂm computer and do nol need o natall

% |rystall Wikdity
7 Ues Irsstabed Wikdily

< Back Mest Cancel |

|44 BACK TO FLOWCHART

Centric Authentication

15. The Select Authentication Mode dialog box is displayed.

a. If you want to use the Centric8 Authentication, click on the Centric Authentication radio button
and click on Next. This will take you to the Choose Java Development Kit (JDK) Installation

directory dialog box.

If you select Centric Authentication, it will not integrate with LDAP,
# which means that users have to be created manually.
NOTE . . . . .
If you choose LDAP Authentication, you can integrate with Active
s Directory Services (LDAP) where Domain users with their information
can be synchronized in real time.

SINGLE SERVER SOFTWARE INSTALLATION
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Figure 3-8: Select Authentication Mode dialog box - Centric Authentication

Select Authentication Mode E

Plezze select which Authentication mode you plan to use with
Cenin: 8

%" Centic Autherfication
™ LDAP Authenticaion

¢ Back | e » | Cancel

b. If you want to use LDAP Authentication, to enter LDAP Server information, select the LDAP
Authentication radio button and click on Next.

Figure 3-9: Select Authentication Mode dialog box - LD AP Authentication

Select Authentication Mode B

- Flease select which Authentcafion mode you plan o use wilh
e:8ht Centic

(™ Centic Authenticaion
¥ L[WP Authentication

¢ Back Mt Cancel

16. In the Enter LDAP Server Information dialog box, enter details for the following fields:

= Server Address

= Root Search DIR
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= Search Base
= Bind Username

Note: The Bind Username field details should be in the format Username@I D APDomainname

= Bind Password

17. Click on Next.

Figure 3-10: Enter LDAP Server Information dialog box

Enter LDAP Server Inlormalion

Pleas erder b Servel Saddeess. Root Search Dinectory and
Semarch Base string for LIMP futivenbic ston

Hole: i ancrpmoun binds are nol alowed, please enter Bind
Uzt and Pasoword Oithervns, laave it blark

[T — |L|:|.H:n A2 1BR 10 2% 2

Fhoot Seach QIR [r.n-:.l:-m 5 do=lab, dosfamed ech,do=com

SewchBase  [1.ssmbliers dbab. do-fearnetoch d-cam

Bind Usesnaner, [Achmaniststor s

i Pt [1

« Back et > Carcel |

18. To enable SSL functionality for LDAP, refer Appendix J, LDAP Setup.

19. If you do not have the Java Development Kit (JDK) version 1.8.0_45 already installed on your
system, the Choose Java Development Kit (JDK) Installation directory dialog box will be
displayed. To choose the destination folder for the JDK files, click on the Browse button. Click on
Next.

Figure 3-11: Choose Java Development Kit (JDK) Installation Directory dialog box

Choose Java Development Kit {JDK) Installation Directory

Select the bocaton to instal the Java Development Fi

r- Destinahion Folder

€\ \CENTRI“1\CE\di1. 8.0_45 Biowse.._ |
¢ Biack ITl Cancel ]
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|<< BACK TO FLOWCHART

Select Database Type
20. The Select Database Type dialog box is displayed.

Figure 3-12: Select Database Thpe dialog box

Flaase select whach lype of database pou plan bo use with
Centric 8.

« Back I et > I Cancel

21. Select either Microsoft SQL Server or Oracle as the database type; follow the appropriate
instructions based on your selection in this dialog box:

=  Microsoft SQL Server on page 25

= Oracle Database on page 30
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3.1.1 Microsoft SQL Server

Follow the step given below if you are using a Microsoft SQL Server database.

a. Select the Microsoft SQL Server radio button and click on Next.

b. The Choose Database Server Location dialog box is displayed. Select the Local database
radio button. Click on Next.

Figure 3-13: Choose Database Server Location dialog box

Choose Database Server Location

¢ Back Heod > Cancel |

c. The MS SQL Server Information dialog box is displayed.
Figure 3-14: MS SQL Server Information dialog box

M5 SOL Server Information

Pleass arder the lobowing MS SOL Seever indomation

Mote: Leanss SOL Inshance Hame fiskd blank § pou chooss 1o
uge Dafsulk nstarce,

SOL Adminisirator U sesnaens: [’*’

SIOL Administraloe Patsword |

SOL Irstance Mame: |

< Back I Best > I Cancel ]

d. Enter the username and password in the corresponding fields, and enter the SQL instance name
in the SQL Instance Name field OR leave this field empty to use the default instance name.
Click on Next.
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e. The Enter Centric 8 Administrator Username and Password dialog box is displayed. Enter
the username and password, and confirm the password; click on Next.

Figure 3-15: Enter Centric8 Administrator Usernanme and Password dialog box

Enter Centric § Administrator Username and Password B
Please enter the Ceninie B Administrator usemane and
: password
818ht

for Centric8 Administrator user (for example, include alphanumeric

i !i The Username and Password cannot be identical. Use strong passwords
o upper and lowercase letters, numbers and symbols).

f. The Enter Centric 8 Database Information dialog box is displayed.

Figure 3-16: Enter Centric 8 Database Information dialog box

Enter Centric & Database Information

Flaase anter the lollowarg Cantric B Databate nfomation.

‘wiaring: D stabass neee dhould not b ang special
chaactors e dashes, underscones. spaces oo

Lissananmec |¢='¢d

Pagawoed |

Conlim Password: |

Databaze: |

chock [ Hets | concel |

password and csidba user password in Centric 8 installation: %6, ™, &,

= >0,

i ' The following characters are not supported in SQL Administrator
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Use strong passwords for Centric8 Administrator user (for example,
include alphanumeric upper and lowercase letters, numbers and
symbols).

e
IMPORTANT

g. In the Username field, enter the username. Enter details in the Password and Confirm
Password fields. In the Database field, enter the database name. Click on Next.

h. The Choose New or Existing Database dialog box is displayed.

Figure 3-17: Choose New or Existing Database dialog box

Choose Mew or Existing Database E |

Choose if you want io create a new database of use an extsting one.

Elght ‘Waming: Creating a new database will delete any existing database.

% Create Hew Database

" Use Exssting D atabase

i. Click on the Create New Database radio button and click on Next; the Choose Database
Location dialog box is displayed.

Figure 3-18: Choose Database 1ocation dialog box

Choose Database Location

Please choose the dueciosy that wall contan the Centnc B
database.

Destination Folder

e\ \eentic soltware\c\database Browse... |

< Back New> |  Cancel |
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j. To accept the default destination folder, click on Next OR to select a different destination folder
click on Browse. Then, click on Next.

k. The Choose FileVault Location dialog box is displayed. To accept the default destination folder,
click on Next OR to select a different destination folder, click on the Browse button. Then, click
on Next.

Figure 3-19: Choose File 1 ault Location dialog box

Choose File Yault Location B I
Please choopes the drechon that will contam the: File vaul
Hote: We necommend the Fie vault fokder should reside on
apphealion sl machirs.
Daztination Folder
£\ \centic soltwars\c8\ilevaul _Biowss__|
cgack | Hes | Concel |

I.  The Choose WebAccess Location dialog box is displayed. If the WebAccess directory has to be
configured under a different directory on the same machine or a shared directory on a different
machine, click on Browse and select the right location.

Note: If you are planning to install WebAccess using shared directory feature, refer
WebAccess Shared Directory Installation.

Figure 3-20: Choose WebAccess Location dialog box

Please choose the deectory that will contain the Chent
Weblcoess fles.
Mote: We recommend the 'WebAccess folder should reside on
zpphcation server machine.
- Diestination Folder
CAACENTRIMACB\Webdiccass Brovse...
¢ Back Med » Cancel I
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m. The Check Setup Information dialog box is displayed. Verify the details displayed under the
Current Settings section. To make changes, click on the Back button ELSE to confirm the
settings and proceed, click on Next.

Figure 3-21: Check Setup Information dialog box

Check Setup Information [ x|

Setup has enough information to begin the installation.
|F pau want ko review or change any of the

zattings. click Back. |f you are satisfied with the
zettings, click Mexst to begin.

Current Settings:

User Information: -
Windows Uzer
Centric

Destination Directony:
CAPROGRA™TSCENTRINES

Application Server: Wwildly

Aildfly Application server installation Directarny:
CAPROGRATMCEMTRI1MCS wildfly-8.1.0

4] 3
< Back I Mext > I Cancel |

n. To complete the installation process, click on the Finish button.

Figure 3-22: Setup Complete dialog box

Setup Complete

Seiup has completed the installation of the Cenitic 8 [C8) Server.

Fiefer to the: C8 Instalation Manual, CentnicB Installation
Gusde pa, bocated i the C: \Progeam Fies\Cenimc
Soltwaie\CB\Help for configunng the C8 5 erver Compesents.

Chck Finish to complete sebup,

|<< BACK TO FLOWCHART
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3.1.2 Oracle Database

Follow the steps given below, if you are using an Oracle database.

0. In the Select Database Type dialog box, select the Oracle radio button and click on Next.

Figure 3-23: Select Database Thpe dialog box

Select Database Type E3 |

Pleaze select which type of database you plan to use with
Ceniric 8

" Miciosolt SOL Server

< Back Mot » Carcel

p. In the Choose Database Server Location dialog box, select the Local database radio button
and click on Next.

Figure 3-24: Choose Database Server Location dialog box

Choose Database Server Location

¢ Back Hed > Cancel

g. The Enter Oracle Service Name dialog box is displayed. In the Service field, enter details
which identifies the Oracle server, and click on Next.
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Figure 3-25: Enter Oracle Service Name dialog box

Enter Oracle Service Name E3

Oracle databases allow more than one database server running
on a host. Each database server iz called an "instance”. Each
instance iz belonged to a service.

Enter the service name ["'zervice_names" parameter value]
which identifies your Oracle server.

Service:

< Back I Memt = I Cancel

r. The Oracle Server Information dialog box is displayed. In the Username field, enter the
Oracle Server Username details. Enter details in the Password and Port fields and click on
Next.

Figure 3-26: Oracle Server Information dialog box

Dracle Server Inlormation E

Plaass erbe the lollowng Orachs Sencer Infamation.

Usemame: ﬁ

Password I...... =]

Pt ||521

< Back Mest > Carcel |

s. The Enter Centric 8 Administrator Username and Password dialog box is displayed. Enter
details in the Username, Password and Confirm Password fields; click on Next.

The Username and Password cannot be identical. Use strong passwords
for Centric8 Administrator user (for example, include alphanumeric
upper and lowercase letters, numbers and symbols).

Bt
IMPORTANT

SINGLE SERVER SOFTWARE INSTALLATION
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Figure 3-27: Enter Centric 8 Administrator Username and Password dialog box

Enter Centric 8 Administrator Username and Password

Please erter the Cenbric 8 Administraton usemame and
passwond.

L zamname:

Password: f

Confirm Pagsword [

< Back Hest > Cancel |

t. The Enter Centric 8 Database Administrator Username and Password dialog box is
displayed. Enter details in the Username, Password fields and click on Next.

The Username and Password cannot be identical. Use strong passwords
for Centric8 Administrator user (for example, include alphanumeric
upper and lowercase letters, numbers and symbols).

.
IMPORTANT

Figure 3-28: Enter Centric 8 Database Adpiinistrator Username and Password

Enter Centric 8 Database Administrator Username and Password

Please enber the Centic B [ atsbase Admnitstor usesmams

u. In the Choose New or Existing Database dialog box, select the Create New Database radio
button and click on Next.
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Figure 3-29: Choose New or Existing Database dialog box

Choose New or Existing Database |

Dot | pou wand by create & new datsbass of use an siing one.
E'Bht Wamingy Crasfing 8 rave databisss vl b any ssiting dabsbana

& Coeate Mew Database

" U Exating Databane

Cfock | Hetr | Cowe

v. The Choose Database Location dialog box is displayed; to accept the default destination folder,
click on Next OR to select a different folder, click on Browse. Click on Next.

Figure 3-30: Choose New or Excisting Database dialog box

Choose Database Location E3

Pleaze choose the directary that will contain the Centric: 8
database.

" Destination Folder

dihegldata Browze. . |
< Back I et = I Caticel |

w. The Choose File Vault Location dialog box is displayed; to accept the default destination folder,
click on Next. Else, to select a different folder, click on Browse. Click on Next.
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Figure 3-31: Choose File 1 ault Iocation dialog box

Choose File Yault Location E |

Fleass chooss the drectony that will contain the File vault

Mote: Whe recommend the File vaul foldes should reside on
apphcation server maching

1 Destination Folder

e\ hceniric softwarshcEflevaul Browse...

< Back Het> |  Cancel |

X. The Choose WebAccess Location dialog box is displayed; to accept the default destination
folder, click on Next. Else, if the WebAccess directory has to be configured under a different
directory on the same machine or a shared directory on a different machine, click on the Browse
button to select the right location.

Note: To install WebAccess using the shared directory feature, refer WebAccess Shared
Directory Installation.

Figure 3-32: Choose WebAccess Location dialog box

Choose WebAccess Location

: Pleaze choose the deectory that wl contain the Clent
E-|8ht Wbtieoess Fes.
Hote: e nacommend the \Webdicoess foider thould ieside on
Bpphcalion serves machine.
Dhestination Folder
CAAENTRIF1VDNwebhocess Browse
Bk [ News Cancel |

|44 BACK TO FLOWCHART
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SMTP setup

22. The Enter SMTP Mail Server name and Email Address dialog box is displayed.

Figure 3-33: Enter SMTP Mail Server name and Email Address dialog box

Enter SMTP Mail Server name and Email Address

Please erter the name of the SMTF Mad Server and Emal
addeess sequined by the Centric 8. Emad oddiess i used to nelay
mestages in Cening B and seport any peoblems encounbeed

sMTe |

Emal [

¢Bsck [ Hets | camce |

23. Enter details in the SMTP and Email fields and click on Next. The Select Program Folder
dialog box is displayed.

Figure 3-34: Select Program Folder dialog box

Select Program Folder E |

Sehup will add progeam icons to the: Progeam Fokdes bsted belovw.
You may lvpe & new folder name, o select one from the exating
Folders ist. Chck Mext lo contiue.

Program Folders:

Cerinc Product Imelbgence
Ghostscrnpt

Miciosalt SOL Server 2005
Miciosalt Visusl Studa 2005
RealvNC

Staitup ;]

cBack [ Hets |  cancel |

24. To use the default program folder click on Next. The Check Setup Information dialog box is
displayed.
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Figure 3-35: Check Setup Information dialog box

Check Setup Information

Setup has enough information to begin the installation.
IF poL want to review or change any of the

zettings. click Back. |f you are satisfied with the
seftings. click Mext ta begin.

Current Settings:

User Information: -~
‘windowes Uzer
Centric:

Destination Directony:
CAPROGRA™INCENTRIT1MCE

Application Server: ‘Wildfly

Wwildtly Application server ingtallation Directany:
CAPROGRA™TACENTRI-1MC8wildfly-2.1.0

K| 3

< Back I MHext » I Cancel |

25. Verify the details under the Current Settings section. To make changes to the settings, click on
Back. Else, to accept the settings and proceed with the Installation click on Next.

26. Once the installation is complete, the Setup Complete dialog box is displayed.

Figure 3-36: Setup Complete dialog box

Setup Complete

Setup has completed the installation of the Centric 8 [C8] Server.

Fiefer ta the C8 |nstallation Manual, Centric Installation
Guide pdf, lozated in the C:\Program Files\Centric
SoftwarshCBYHelp for confiquring the C8 Server Companents.

Click Finigh to complete setup.

ITIFIHIS

27. Click on Finish.

Relocate database files location

28. If you have followed the Drive Structure as mentioned in the Pre-requisites section, you need to

move the C8_txlog.ldf to L:\SQLLOG. To do this, go to step 29.

29. Stop Wildfly Services.

30. In Start menu, click SQL Server Management Studio. In the Connect to Server dialog box,
enter details for the Server name, Login and Password fields. Then, click on Connect.
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Figure 3-37: Connect to Server dialog box

-_lr.mmfr, L Lo Server
ﬁ Microsoft®
2 SQLServer2008r2
Server lype: | Database Engne =
Server name: [2xes26BR2AR =
Authenfication: [SOL Server Authentication |
Login [r2 2
Password ™
™ ' Remember passvword
| Cornect I Cancel | Help I Dptiorss »»

31. Right-click on the C8 Database, and select Tasks » Detach.

E | Oe-MIRROR (S0L Server 10.50,2500 - =)
= [ Databases

& [ Syibern Dt sty

® [ Database Snapshots

& j fSorph Database s b
= Taske 3 Detach...
®
- | Pl E Taba Ciffline
=20 Faosts Bring Ordne
[ Seourd
[ Served St Powwer Shel ek b
% [ oepe|
& [ Mansg Reports ’ BackLp...
® s a Bastone k
Deslate ...
Aafredh Linrch Dotaburie Mirmorirg Mord o, .
Properties Ships Traressction Logs....

32. In the Detach Database dialog box, ensure that the Drop Connection and Update Attributes
check boxes are selected. Click on OK.
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Figure 3-38: Detach Database dialog box

Senver
CHO-MIRROR

o] o |

33. Once the databases are successfully detached, go to the D:\SQLDATA folder.

34. Cut C8_TXLOG.If file and paste it in L.:\SQLLOG.

35. In the Start menu, click on SQL Server Management Studio. Enter details for the Server

name, User login 1d and Password fields. Then, click on Connect.

36. Right-click on Databases and select Attach.

Object Explorer

Connect~ % % m [ 2] .5

« 0

@ L Securty
+ [ Server Ob
# [ Replicatio
¥ [0 AhwaysOr
# [J Managerr
# [ Integratio
(2 S0L Serve

= [_ﬂ WINZE12-CONFIG (0L Server 12.0.200
5 Ca

Mew Database..

Attach...
Restore Database...
Restore Files and Filegroups...

Deploy Data-tier Application...
Import Data-tier Spplication..,

Start Poweershell
Reports 3

Refresh

37. In the Attach Databases dialog box, click on Add.
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Figure 3-39: Attach Databases dialog box

2 e s > I3 e
[ratabeasns o sitach
WOF Fle Locafion [1afabace Mo [ [
an - »
s =
[t St
OugraiFieMame  Flelyps  Cusent Fie Pl ez
- Connecton
Sarver
SOPMIRROR
Correcion
L]
% 'en connechon oropete;
h ol [ —
Finady
= ]

38. Select C8_data.mdf and click on OK.

Figure 3-40: Attach Databases dialog box

Database Data File location: DASOLDATA | @ ‘ | E‘
@ CB_data md
| -3 $RECYCLEBIN
[+ JCP_Backup_Cleaninstal_06_15_2015
{3 SOLDATA
-1 System Volume Information
F:
E-Ca L
=EaT
Flle name: | CB_datamdr | [Database Data Fies(".me) v]
| ok | ‘ Carcel |
-
NOTE You can now proceed to Chapter 5, Configuration & Testing to configure the
l database.

|44 BACK TO FLOWCHART
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4. DUAL SERVER SOFTWARE INSTALLATION

Computer 1 Computer 2
Installation Installation

=
=
=
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4.1 Computer 1 Installation

Use the following set of instructions to install computer 1 of your Dual Server installation.

Before starting this installation, verify that all hardware and software specifications are met
s based on Centric Software recommendations; see the Centric 8 Requirements for more
information.

NOTE

L For Single Server installation instructions, see Chapter 3, Single Server Software
Installation.

1. Select your domain name and log into the domain as Administrator. Close all Windows
applications.

2. Close all open applications. Copy the \\install\C8Server directory to the server.

U To install Centric 8, right-click on setup.exe and select Run as
Administrator.

R
IMPORTANT

3. The Welcome dialog box is displayed as shown below.

Figure 4-1: Welcome dialog box

mml  ‘welcome bo the Centric B Sebup progeam. This
pragram wall instal Centnc B on pour computer,

Itis stromgly recomenended that you et all Windows programs
before nunning this Selup peogram.

Chick Cancel bo quit Setup and then close any progeams pou
harve nurning. Lhick Mext o contires wath the Setup progeam.

WARMING: This program s protected by copmght law and
mhemational biesbies.

Unauthionzed reproducton o distbution of thes progiam, of any
paothion of i, may resull in seveds civll and chirinal penalies, and
will b prosecubed to the masamum exhent possble undar Lave.

4. To begin installation, read the details in the Welcome dialog box and then click on Next. The
End User License Agreement dialog box is displayed.
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Figure 4-2: End User License Agreement dialog box

End User License Agreement

Flease read the folovang Bcense agresment. Use the scooll bar bo view the resd of
this: asresestnent.

MOTICE TO EMD USER: CAREFULLY READ THE FOLLOMWING LEGAL

CEMTRIC SOF TWARE END USER LICENSE AGREEMENT i'
FEEMEMT. USE OF THE 50FT'WARE PROVIDED WATH THIS

THEM FOR A FULL REFUND.

IT 15 EXPRESSLY AGREED THAT THE TERMS OF THIS AGREEMEMNT

SHALL SUFERCEDE THE TERMS OF ANy CLUSTOMER PURCHASE DRDER

0OR OTHER ORDERING DOCUMEMNT. IF A5 THE END USER Y0U HAVE

EXISTING AMD/OR ADDITIOMAL SIGNED LICEMCE AGREEMEMT

TH CENTRIC SOFTWWARE, THAT AGREEMENT 'WiILL TAKE PRECEDEMCE.

1. Obsect Code Licenze Grard. Cenine Softwars grarts ﬂ

Do ywou sccept ol the bems of the preceding boense sgresment? If 50,
chck on the ez puth button I pou select No. 5 etup vall clage.

< Back Yes o |

User Information

5. To accept the license agreement, read the license agreement details and click on Yes. The User
Information dialog box is displayed as shown below.

Figure 4-3: End User License Agreement dialog box

User Information E3
Pleaze enter pour name and the name of the company for whom
oL wark.

I ame: |
Company: |

< Back I Heut = I Cancel |

6. Enter your user name and company name in the corresponding fields, and click on Next. The
Choose Destination Location dialog box is displayed.
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Figure 4-4: Choose Destination 1 ocation dialog box

Choose Destination Location

Setup wall install Certic B in the following older,
T nstall 1o this fobder, chick Nesd
IT;d:;sbnl i & ciffenent folder, chck Browse and select anothes

*iou can chooge not io inglall Centiic B by ciicking Canced bo st
Setup.

Dhesivation Folder
C:\Progeam Files'\Cenine Software\ LB Browse

cBack [ Mesds | Cancel |

|« BACK TO FLOWCHART

Install Centric 8

7. To accept the default destination folder, click on Next OR to select a different destination folder
click on the Browse button. Click on Next. The Install Centric 8 or Database Only dialog box
is displayed.

Figure 4-5: Install Centric 8 or Database Only dialog box

Install Centric 8 or Database Only [ x| I

Pleate choose o inslall sithes Cantric 8 with dalabase of only the
dalabas

& [Carhns § [nchudes datsbase]
" [iatabase Ok

chack [ Meas | cocm |

8. Select the Centric 8 (includes database) radio button, and then click on Next.

9. The first time Centric 8 is installed, the Choose Centric 8 License Location dialog box is
displayed as shown below. Click on the Browse button and navigate to the folder containing the
C8.lic license file; click on Next.
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Figure 4-6: Choose Centric 8 License Location

Choose Centric B License Location

cBack [ Het> | Cancel |

Once you select the file location, Centric 8 confirms the license file and
installation continues displaying the Choose new or Existing Application
Server dialog box. However, if you cannot locate the license file, an error
NOTE message displays, and installation ceases.

If you are upgrading or installing a new build on the machine, the Choose
License Location dialog box does not display.

|« BACK TO FLOWCHART

Install Wildfly Services

10. The Choose New or Existing Application Server dialog box is displayed. To install the Wildfly
Server on your system, select the Install Wildfly radio button. Else, to use a previously installed
instance of Wildfly on your system, select the Use Installed Wildfly radio button. Click on Next.
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Figure 4-7: Choose New or Existing Application Server dialog box

Ot # jou wank bo matal Wil oo f pou sieady have
:ﬂdqdwiﬂmhinm computer and do nod need o natal

¥ Irostall \a/ildiyy
1™ Lo st Wikdily

¢ Back Mast > Cancel |

|44 Back TO FLOWCHART

Application Authentication

11. The Select Authentication Mode dialog box is displayed.

12. To use the Centric8 Authentication, select the Centric Authentication radio button. Click on
Next. This takes you to the Choose Java Development Kit (JDK) Installation directory dialog
box.

If you select Centric Authentication, it will not integrate with LDAP
& which means that users will have to be created manually.
NOTE . . . .
If you choose LDAP Authentication, you can integrate with Active
L8 Directory Services (LDAP) where Domain users with their information
can be synchronized in real time.

Figure 4-8: Select Authentication Mode dialog box

Sehect Authentication Mode

[Pleape patect which Authenbcaion mode you plan fo use wih
Centic 8
& Cont e
(" LDAP Authertication
< Back Hea 3 Cancel
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13. To use LDAP Authentication, select the LDAP Authentication radio button and then click on
Next.

Figure 4-9: Select Authentication Mode dialog box

Pleane pebect which Suffenicabon mode vou plan fo upe wih

eiaht Cenic &

1 Ceriie Authanbioations
(¥ LDAP Autheskication

¢ Back Mestt > Carecel

14. In the Enter LDAP Server Information dialog box, enter details for the Server Address, Root
Search DIR and the Search Base string. Enter details for the Bind Username and Bind
Password fields and click on Next.

Note: The Bind Username must be in the format Usermane@I.D.APDonainnane.

Figure 4-10: Enter LDAP Server Information dialog box

Enter LDAP Server Information

Fleasze enter the Server Address, Root Search Directory and
Search Baze string for LDAP Authentication,

Mate: If anonymous binds are not allowed, please enter Bind
Uszer and Pazswaord. Othenwize, leave it blank.

Server Address: ILdapa"f"l 92.168.10.26:389

Foat Search DIR: Iu:n=U zerg,do=lab,do=frametech, do=com

Search Baze: Iup,u:n=U zerg,do=lab,do=frametech,dc=com

Bind sername:; I.-’-\drnini&trator@lab

Bind Password: Ix”mﬁ

< Back I Mext » I Cahcel
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To enable SSL functionality for LDAP, refer Appendix J, LDAP Setup.

15. If you do not have the Java Development Kit (JDK) version 1.8.0_45 already installed on your
system, the Choose Java Development Kit (JDK) Installation directory dialog box will be
displayed. To choose the destination folder for the JDK files, click on the Browse button. Click on
Next.

Figure 4-11: Choose Java Development Kit (JDK) Installation Directory dialog box

Choose Java Development Kit {(10E) Installation Directory

Sedach the locahon 1o mstal he ) ava Development Kt

Drestination Folder

C\ ACENTRI“T\CENd B.0_45 Biowse. .
¢ Batk Mesd » Cancel |

16. The Select Database Type dialog box is displayed.
Figure 4-12: Select Database Thpe dialog box
select DotabaseType —_____H|

Ploace select which lype of dalabace you plan lo upe with
Centiic 8

= [Micoosoft SOL Served
" Oracls

tgock | Hets | coca |

|44 Back TO FLOWCHART
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Select Database Server Location

17. Select either Microsoft SQL Server or Oracle as the database type, and click on Next. The
Choose Database Server Location dialog box is displayed. Select the Remote database radio
button and then click on Next.

Figure 4-13: Choose Database Server Location dialog box

Choose Database Server Location

Chacein il waand 10 use local of namctn datahadn with Conts B

™ Locsl datshans
0 Ferete dalabaze

4 fack et » Cancel

|44 Back TO FLOWCHART

Database Authentication and Centric Application Authentication
18. In step 17 above, if the database type selected was SQL Server then the SQL Server Database

Server Information dialog box will be displayed; enter the database domain name and port
details, and click on Next.

Figure 4-14: Database Server Information dialog box

Database Server Information

Please enter the Centric 8 database server name and SOL
Instance Port.

Name:  [2KBR2-52KER204

Port: I'I 439

< Back I NE I Cancel
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19. In step 17, if the database type selected was Oracle, then the Oracle Database Server
Information dialog box is displayed; enter the database domain name and port details and click
on the Next button.

Figure 4-15: Database Server Information dialog box

Database Server Information B I

Pleate enter the Cenine 8 datsbase server mioimation
Mobe: Mame must be Fully Uusshed Domen Name [FULDMN]

Hlares ]

[Prort: |

¢ Back Heat > Carcel |

20. The Enter Oracle Service Name dialog box is displayed. Enter Oracle Service name and click on
Next.

Figure 4-16: Enter Oracle Service Name

Enter Oracle Seryice Name E

Oracle databazes allow mare than one datsbaze server running
on a host. Each databaze server iz called an "ingtance”. Each
instance iz belonged to a service.

Enter the service name ["'zervice_names" parameter valug]
wihich identifies pour Oracle server.

Service:

< Back I Mext > I Cancel

21. The Enter Centric 8 Administrator Username and Password dialog box is displayed.
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Use strong passwords for Centric8 Administrator user (for example,
include alphanumeric upper and lowercase letters, numbers and

symbols).

Bt
IMPORTANT

Figure 4-17: Enter Centric 8 Administrator Username and Password

Enter Centric 8 Administrator Username and Passwond

Fliease endes the Cenbic B Administabor usemane and
[

Ll zemanme: m

Pazswoad I

Confum Passwoed: [

« Back I e > I Cancal

22. Enter details in the Username, Password and Confirm Password fields and click on Next.
Ensure that the Username and Password are not identical. The Enter Centric 8 Database

Information dialog box is displayed.

Figure 4-18: Enter Centric 8 Database Information dialog box

Enter Centric § Database Information x|

Pleaze enter the fallowing Centric 8 D atabase information.

wharning: Databaze name should not have any special
characters like dashes, underscores, spaces efc,

Usemame: ICSldba

xxxxxx

Password: I

xxxxxx

Confirn Pazsword: I

[ atabase: IC8

< Back Memt » Cancel

23. Enter details in the Username, Password and Confirm Password fields and click on Next.
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example, include alphanumeric upper and lowercase letters, numbers

U Use strong passwords for Centric8 Database Administrator user (for
and symbols)

Bt
IMPORTANT

24. The Choose File Vault Location dialog box is displayed.

Figure 4-19: Choose File 1 ault Location dialog box

Choose File ¥ault Location
Pleate choose the diecton that wil contain the File vauk.
Hote: We recommend the File vaul folder should reside on
apphcation server maching.
- Destination Folder -
e\ Aceninic soltwaie\cH\evaul Browse... |
Bock | Hets | comcsl |

25. The Choose WebAccess Location dialog box is displayed. If the WebAccess directory has to be
configured under a different directory in the same machine or shared directory in a different
machine, click on Browse and select the right location. If you are planning to install WebAccess
using shared directory feature, refer to WebAccess Shared Directory Installation.

Figure 4-20: Choose WebAccess Location dialog box

Choose WebAccess Location
p Pheane chooge the: drectony that wil contan fhe Clerk
E|8ht Webdrces: et

Miotec We pecommend e Webdces: boldes should reside on

sppbeation senves machine,
Drestination Folder
C ACEMTRE1MCBV W ebArcess Browss

< Back Nest » Cancel |
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26. To accept the default destination folder, click on Next. Else, to select a different destination
folder, click on the Browse button and select the right location. Click on Next. The Enter SMTP
Mail Server name and Email Address dialog box is displayed.

U Centric recommends installing the application server and FileVault on
separate disks.

s
IMPORTANT

|44 BAcK TO FLOWCHART

SMTP Configuration

27. Enter your SMTP mail server name and email address in the corresponding fields, and click on
Next. The Select Program Folder dialog box is displayed.

Figure 4-21: Enter SM'TP Mail Server name and FEmail Address dialog box

Enter SMTP Mail Server name and Email Address

Plaara arder e name of the SMTP Mal Server and Emad
address required by the Certric 8. Emad address is used bo relay
messages in Centric 8 and repor any problems encountered

T) I |

Emai [

< Back Hesa 3 Cancel
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Figure 4-22: Select Program Folder dialog box

Select Program Folder E I

Srtup vall add program icond o the Progeasn Folden ksbed below.
"o ey Bppe & nsw Bolder name, of pelect ane fom the edsting
Folders st Clhck Nesd o continus.

Erogeam Folders:

Cenimc: Fioduct Inteligence

Ghostsoaipl

Miciosoft SUL Sere 2000

Mlicaceoft Yisual Shudeo 2005

FRealHC

Startup |

« Back I Hend » I Cancel I

28. Click Next to use the default program folder. The Check Setup Information dialog box is
displayed.

Figure 4-23: Check Setup Information dialog box

Check Setup Information

Setup has enough information to begin the installation.
If pous want bo review or change any of the

zeftings, click Back. If vou are zatizfied with the
seftings, click Mext to begin.

Current Settings

User Information: -
‘windows User
Centric:

Destination Directon:
CAPROGRA™TACEMTRI1MCE

Application Server: Wwildily

tafildily Application server installation Directary:
CAPROGRA™TACEMTRITSC8 wildily-8.1.0

i of

< Back I Mext » I Cancel |

29. Verify the details under the Current Settings section. To make changes, click on the Back
button. Else, to continue with the current settings and begin installation, click on Next. Once the
installation process is completed, the Setup Complete dialog box is displayed.

30. Click on Finish. Proceed to Computer 2 Installation.

|44 BAcK TO FLOWCHART
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4.2 Computer 2 Installation
Use the following set of instructions to install on computer 2 of your Dual Server installation.

1. On computer 2, select your domain name and log into the domain as Administrator.

During database installation, the Database Administrator user name
and password are used to create the database user ‘csidba’ and to
) create the database and table. Once the database is created, database
access from Wildfly uses the database user ‘csidba’ user name and

MNOTE . . .
password created during installation.

If you install Centric 8 Server database on a shared server it must have
a separate SQL instance to minimize the impact of other databases.

2. Copy the \\install\C8Server directory to computer 2.

U To install Cenric 8, right-click Setup.exe and click Run as
Administrator.

et
IMPORTANT

3. The Welcome dialog box is displayed.

Figure 4-24: Welcome dialog box

Walcome bo the Ceninc B Setup piogram. This
progeam wall nstall Centnc B on pour computes.

It iz strongly recommended that pou et all Windows peodrams
befiane nunring thes Sebup progiam.

Chick. Cancel to quit Setup and then closa any programs you
have running. Chck st bo continue vath Ehe Setup program

WARNING: Thes program iz probected by copenght b and
nbamaticnal bieabes.

Unsuthosed repioducticn or distribution of this program, or ary
pastion of R, may result in severs ool and cominal penake:, and
vall be: procecuted bo the maamum exdant possble under law,

] oo

4. To begin the installation process, read the Welcome dialog box details and click on Next. The
End User License Agreement dialog box is displayed.

DUAL SERVER SOFTWARE INSTALLATION 54



Centric 8 INSTALLATION GUIDE

Figure 4-25: End User License Agreement dialog box

End User License Agreement

Fleasa rsad the followng icense agresment. Lize the zcooll bar to view the rest of
this agreement.

MOTICE TO END USER: CAREFULLY READ THE FOLLOWING LEGAL
IAGREEMEMT. LSE OF THE SOFTWARE PROVIDED WITH THIS
AGREEMEMT (ITHE SOFTWRAREI CONSTITUTES 'YOUR ACCEPTANCE

(OF THESE TERMS. IF vOU DO MOT AGREE TO THE TERMS OF

THIS AGREEMEMNT. FROMPTLY RETURM THE SOFTWARE AMD THE
ACCOMPANYING ITEMS TO THE LOCATION WHERE YOU DBTAINED

THEM FOR & FULL REFUMD.

IT 15 EXPRESSLY AGREED THAT THE TERMS OF THIS AGREEMENT
SHALL SUPERCEDE THE TERMS OF ANY CUSTOMER PURCHASE ORDER
OR OTHER ORDERING DOCUMEMNT. IF AS THE END USER YOU HAVE

AN EXISTING AND/OR ADDITIONAL SIGNED LICENCE AGREEMENT

'wiTH CENTRIC SOFTWARE, THAT AGREEMEMNT 'WILL TAKE PRECEDENCE.
1. Dbpect Code Licensze Grard. Centne Software grants -

Do you accept all the lems of the preceding icense agreement? If 5o,
click on the ‘ez push button. [IF pou select No, Setup will close.

cEnk[IﬁI Ho [

CENTRIC SOFTWARE END USER LICENSE AGREEMENT i‘

5. To accept License Agreement, read the contents of the Welcome page and click on Yes. The User
Information dialog box will be displayed.

User Information

6. Enter your user name and company name in the corresponding Name and Company fields, and
click on the Next button. The Choose Destination Location dialog box is displayed.

Figure 4-26: User Information dialog box

Plagse enter your nama and the name of the company for wihom

eight you vk

Hlarre: FW'ni}m Uz

Compary:  [Cenind

¢ Back I Nﬁ% I Camcel
T

DUAL SERVER SOFTWARE INSTALLATION 55



Centric 8 INSTALLATION GUIDE

Figure 4-27: Choose Destination 1 ocation dialog box

Choose Destinathon Location

Setup wll el Cantic 8 in the followng folkder,
Too irestal B this b, click Mesdt.

To matal b0 & chiferent fokder, chick Biowse and selact another

fedet
You can choose not b instal Centac 8 by chcking Cancel o et
Sehup.

- Diestiation Foide

C-\Program Fies\Caniric Soltware\C8 Buowse

7. To accept the default destination folder, click on Next. Else, to select a different destination
folder, click on Browse and select a different destination folder. Click on Next. The Install
Centric 8 or Database Only dialog box will be displayed.

|44 Back TO FLOWCHART

Select Database

8. Click on the Database Only radio button and click on Next. The Select Database Type dialog
box is displayed. Select Microsoft SQL Server and click on Next.

Note: If you select the Oracle radio button, go to Step 11

DUAL SERVER SOFTWARE INSTALLATION
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Figure 4-28: Install Centric 8 or Database Only dialog box

Please choabe ko riolal edher Canin 5 et databace of onily e
bt

" Cantric 8 fnohades database]
% |Dakahade Ol

« Fack Heod > Cancel

Figure 4-29: Select Database Thpe dialog box

Golect Datahase Type I

Flaats salacl wiech type of dalsbace pou plan 1o use with
Cartae 8

 [Mfisosoft SGL Serves
1 Oracks
< fack Hea > Cancel |

9. The MS SQL Server Information dialog box is displayed. Enter details for the SQL
Administrator Username, SQL Administrator Password and the SQL Instance Name fields.

U The following characters are not supported in SQL Administrator
password in Centric 8 installation: %6, ™, &, *, ), “

e
IMPORTANT
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Figure 4-30: MS SQL Server Information dialog box
s s serverinformation K

Pleass enbe the ol MS S0 Serves mhamaton
Mot Lessron SOL Ire arece K feld blarh. § pou chders by
uze Diefsult Palanoe

SOL Adminmbiaior Lsermemes: |4

SO Admrmilor Padiend '
SOL Instance Hame

< fack e > Corel
’ If you are installing on a SQL Server instance, you must enter the SQL
NOTE Server administrator user name and password to create tables and the
| database.

Database Authentication and Application Authentication

10. Click on Next. The Enter Centric 8 Administrator Username and Password dialog box is

displayed.

Figure 4-31: Enter Centric 8 Adpuinistrator Username and Password dialog box

Enber Centric 8 Administrabor Username and Password E
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11. Enter details for the Username, Password and Confirm Password fields and click on Next.
The Enter Centric 8 Database Information dialog box is displayed. Go to Step 18.

The Username and Password must not be identical. Use strong
passwords for Centric 8 Administrator user (for example, include
frar alphanumeric upper and lowercase letters, numbers, and symbols).
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U The following characters are not supported in csidba user password in
Centric 8 installation: %6, ™, &, *, (), “

et
IMPORTANT

Figure 4-32: Enter Centric 8 Database Information dialog box
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12. In the Select Database Type dialog box, click on the Oracle radio button and click on Next.
Figure 4-33: Select Database Thpe dialog box

select Databasefype £

Pleass sadact vhach tape of databae pou plan bo e with
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« Back I Hend » I Cancel

13. The Enter Oracle Service Name dialog box is displayed.

14. Enter Oracle Service name and click on Next.
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Figure 4-34: Enter Service Name

Enter Oracle Service Name

Oracle databases allow mare than one database server running
on a host. Each database server iz called an “instance®. Each
instance iz belonged to a service.

Enter the zervice name [ 'service_names" parameter valug]
which identifies your Oracle zerver.

Service:

¢ Back I Mext > I Cancel |

15. The Oracle Server Information dialog box is displayed. Enter details for the Oracle Server
Username, Password and Port and click on Next.

Figure 4-35: Oracle Server Information dialog box
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16. Enter the server login and password details in the corresponding fields and click on Next. The
Enter Centric 8 Administrator Username and Password dialog box is displayed.

Use strong passwords for Centric 8 Administrator user (for example,
include alphanumeric upper and lowercase letters, numbers, and
S symbols)
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Figure 4-36: Enter Centric 8 Administrator Username and Password dialog box
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17. Enter the username and password details in the corresponding fields and click on Next.

Figure 4-37: Enter Centric 8 Database Adpinistrator Username and Password dialog box

Enter Centric 8 Database Administrator Username and Password

Please enber the Centac 8 Database Adminishahor usesname

+ Biack. Mot » Cancel

18. Enter details in the Password and click on Next. The Choose New or Existing Database

dialog box is displayed.
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Create Database

19. Select the Create New Database radio button and click on Next. The Choose Database

Location dialog box is displayed.
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Figure 4-38: Choose New or Existing Database dialog box
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Figure 4-39: Choose Database 1 ocation dialog box

Choose Database Location
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20. To accept the default destination folder, click on Next OR to select a different destination folder,
click on Browse and select a destination folder. Click on Next. The Select Program Folder

dialog box is displayed.
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Figure 4-40: Select Program Folder dialog box

Select Program Folder

Setup will add program icons to the Program Folder listed below,
You may lwpe a new folder name, or select one from the exizting
Folders list. Click Mext to continue,

Frogram Folders:

Exigting Folders:

Acceszones -
Adminiztrative T ools

Centric Product Inteligence
Ghostscript

Microzoft SQL Server 2005

Microzoft Wisual Studio 2005
Real/MC

Startup Ll

< Back I Mest = I Cancel I

21. To use the default Program folder, click on Next. Else, select a new program folder from the list
under Existing Folders and then click on Next. The Check Setup Information dialog box is
displayed.

Figure 4-41: Check Setup Information dialog box

Check Setup Information

Setup haz enough information to begin the installation.
|f v want bo review or change any of the

zettings, click Back. If wou are satisfied with the
zettings, click Nest ta begin,
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Usger Information: -
Windows Lzer
Centric
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Application Server: \Wildfly

WWildfly Application server installation Directony:
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22. Verify the details under Current Settings section. To make changes to the current settings, click
on Back. Else, to continue with the settings and begin the installation process, click on Next.
Once the installation is completed, the Setup Complete dialog box is displayed.
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Figure 4-42: Setup Complete dialog box

Setup Complete

Setup has completed the installation of the Centric 8 [C8] Server.

Refer to the CB Installation Manual, Centricd Installation
Guide. pdf, located in the C:\Program Filez\Centric
SoftwarehC3Help for configunng the C8 Server Components.

Click, Finizh to complete zetup.

23. Click on Finish.

Move log file

If you have followed the Drive Structure as mentioned in the Pre-requisite section, you need to move
the C8_txlog.ldf to L:\SQLLOG. To do this, go to step 24.

24. Stop Wildfly Services.

25. In the Start menu, click on SQL Server Management Studio. Enter details for the Server
name, User login 1d and Password fields. Then, click on Connect.

Figure 4-43: Connect to Server dialog box

2 ¥ Connect to Server

‘Y@ Microsofts
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26. Right-click on the C8 Database. Select Tasks » Detach.
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Figure 4-44: Detach Database dialog box
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27. In the Detach Database dialog box, verify if the Drop Connection and Update Attributes
check boxes are selected. Click on OK.

Figure 4-45: Detach Database dialog box
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28. Once the databases are successfully detached, go to the D:\SQILLDATA folder.
29. Cut C8_TXLOG.Ildf file and paste it in L:\SQLLOG.

30. In the Start menu, click on SQL Server Management Studio. Enter details for the Server
name, User login Id and Password fields. Then, click on Connect.

31. In the Explorer window, right-click on Databases and select Attach.
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Figure 4-46: Explorer window
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32. In the Attach Databases dialog box, click on the Add button.

Figure 4-47: Attach Database dialog box
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33. Select C8_data.mdf and click on OK.
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Figure 4-48: Locate Database Files dialog box
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NOTE You can now proceed to Chapter 5 Configuration and Testing to
i configure the database.
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5. CONFIGURATION AND TESTING

£

=

@
=
=
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5.1 Configure Wildfly

Once you install the server software, you are ready to configure Wildfly for the server
configuration.

If this is a fresh installation, you must complete all of the configuration
= steps in this section. However, if this is an upgrade you may proceed to
Server Installation Testing on page 71.

NOTE

— For information about changing Wildfly memory usage, see Appendix
C, Wildfly Memory Usage on page 189.

5.1.1 Previously Installed Wildfly

If you have previously installed and configured Wildfly to work with a Microsoft 11S Web
Server, you must modify the configuration to work with the Centric 8 installation. Configure
your Wildfly- 1S plug-in to handle the servilet context named: csi-requesthandler

I<< BACK TO FLOWCHART

5.1.2 Adding the Wildfly Plug-In & Virtual Directory Set Up

After you install Wildfly using the Centric 8 installation, you must add a Wildfly ISAPI plug-
in. This plug-in enables Wildfly to communicate with I1S, and enables request handling. Once
you add the Wildfly plug-in, you must create a virtual directory for the Wildfly plug-in for the
Microsoft I11S Web Server.

5.1.2.1 Toregister the ISAPI filter

1. In the Centric 8 directory, locate the file: iis_redirect.reg

<Centric8InstallDirectory>\wildfly-8.1.0\bin\win32\i386\

2. To register the ISAPI filter, double-click on the file.
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5.1.2.2 To add a Wildfly Plug-in (Microsoft |IS Web Server 7.0 and 8.0)

1. On the Start menu, select Programs » Administrative Tools » Internet Information
Services (11S) Manager.

2. Under Connections, expand the top-level server name, and then expand the Web Sites folder.

3. Click Default Web Site, and in the center pane under 11S, right-click on the 1SAPI Filters and
select Open Feature.

4. In the right pane under Actions, click on Add. The Add ISAPI Filter dialog box is displayed.

5. In the Filter name field, type wildfly.
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6.

7.

Click on the Browse button and locate the ISAPI filter file isapi_redirect.dll located in

<Centric8InstallDirectory>\wildfly-8.1.0\bin\win32\i386\
Select the file. To close the Add ISAPI Filter dialog box, click on OK.
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5.1.2.3 Virtual Directory Set Up (Microsoft 11S Web Server 7.0 and 8.0)

1. On the Start menu, select Programs » Administrative » Tools Internet Information
Services (11S) Manager.

2. In the Internet Information Services (11S) Manager, under the Connections section, right-
click on Default Web Site and select Add Virtual Directory. The Add Virtual Directory dialog
box displays.

3. In the Add Virtual Directory dialog box, type the alias name in the Alias field (case sensitive):
Jakarta

t - - - -
NOTE In order for Centric 8 to function properly, the name of this virtual
| directory must be jakarta.

4. In the Physical path field, browse to and select the
<Centric8InstallDirectory>\wildfly-8.1.0\bin\win32\i386 folder, and then click OK.

5. In the Internet Information Services (11S) Manager, under Connections, expand the
Default Web Site and click on jakarta.

6. In the center pane, under 11S, right-click on Handler Mapping and select Open Feature.

7. In the right pane under Actions, click on Edit Feature Permissions. The Edit Feature
Permissions dialog box is displayed.

8. Select the Execute checkbox, and then click on OK.

9. In the Internet Information Services (11S) Manager, under Connections section, right-click
on Default Web Site and select Add Virtual Directory. The Add Virtual Directory dialog box
is displayed.

10. In the Add Virtual Directory dialog box, type the alias name in the Alias field (case sensitive):
WebAccess

11. In the Physical path field, browse and select the <Centric8InstallDirectory>\WebAccess folder,
and then click on OK.

12. In the Internet Information Services (11S) Manager, under the Connections section, click
on the top-level server name.

13. In the center pane, under 11S, right-click on ISAPI and CGI Restrictions and select Open

Feature.
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14.

15.

16.

17.
18.

In the right pane, under Actions, click on Add. The Add ISAPI or CGI Restriction dialog box is
displayed.

In the ISAPI or CGI path field, browse to
<Centric8InstallDirectory>\wildfly-8.1.0\bin\win32\i386 folder and select the file isapi_redirect.dll.
In the Description field, enter a description for the restrictions.

Select the Allow extension path to execute checkbox, and then click on OK.

In order for the changes to take effect, it is necessary to restart the Microsoft IS Web Server. In
the right pane, under Manager Server, click on Restart.
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5.1.3 Server Installation Testing

Use the following steps to test your server installation.

-

NOTE Use the Options menu on the Security tab to add the website as a

trusted side in Internet Explorer.

Open Internet Explorer. On the Tools menu, click on Internet Options.
On the General tab, in the Browsing History section, select Delete » Delete files.

In the Delete Files dialog box, click on Yes to clear the cache. Click on Close, and then click on
OK. Close Internet Explorer.

On the Start menu, select Programs » Administrative Tools » Services.
In the Services window, right-click on Centric Wildfly Service and click on Start.

Once the service restarts, make sure that the login page is displayed by opening a browser
window and logging into Centric 8.

|<< BACK TO FLOWCHART
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6. APPLICATION SOFTWARE INSTALLATION
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6.1 Before Installing

Before you install the application software, verify the following:

= You have a dedicated machine on which to install the Centric 8 Applications server

= Single or Dual Server software installation was successful (For more information, see
Single Server Installation on page 9 and Dual Server Installation on page 10)

=  For all future upgrades, use the username and password from the first installation.

|44 Back TO FLOWCHART

6.2 Centric 8 PLM Application Software Installation

To install the application software, follow these steps:

1. Select your domain name and log into the domain as Administrator.

2. To verify that Wildfly is running, on the Start menu, select Programs » Administrative Tools »
Services.

Close all Windows applications.

4. Copy the \\install\C8Applications directory to the server.

U To launch the Wizard, right-click on setup.exe and select Run as
Administrator.

e
IMPORTANT

5. The Welcome dialog box is displayed as shown below.

Figure 6-1: Welcome dialog box
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6. To begin the installation process, read the details on the Welcome dialog box and click on Next.
The End User License Agreement dialog box is displayed.
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Figure 6-2: End User License Agreement dialog box
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7. Read the license agreement, and click on Yes to accept the license agreement. The Enter
Centric 8 Administrator Username and Password dialog box is displayed.
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Enter the credentials

8. Enter your administrator username and password in the corresponding Username and
Password fields. Ensure that you use the same Username and Password used earlier (in Chapter
2 or Chapter 3). Click on Next. The Choose Application dialog box is displayed.

Figure 6-3: Enter Centric 8 Adpinistrator Username and Password dialog box

Enter Centric 8 Administrator Username and Password I

Please enter the Centric 8 Administrator usemame and
pazsword.

Usemame: IAdministrator

Pazswond: I ******* 1
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Select Application

9. Select Centric 8 PLM, or select the desired configuration installation, and click on Next. If you
select Centric 8 PLM, the Choose Centric 8 Modules (Optional) dialog box is displayed.

If you choose Centric 8 Operations, refer Centric 8 PLM Application Software Installation on
page 73.

Figure 6-4: Choose Application dialog box
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The following modules are available in Centric 8:
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Figure 6-5: Centric 8§ Modules

Choose Centric & Modules {Optional) E

Flease select the optional modules you want to install

[~ Business Planning

[T Calendar Management
™ Collection Bock

[ Enterprize Search

[~ Matesial Management
[T Pioduct Specification
™ Quaiity

[~ Repoting

[T Sourcing

= Business Planning

Define currencies and exchange rates, configure business markets, formalization of planning
buckets, linking to sourcing libraries for target and forecast buckets and plan by products
(material or style).

= Calendar Management

Track Technical Data Sheets (TDS) as tracked activities, tracked PO, manage materials and
material approval.

= Collection Book

This module contains details about a Product at the Marketing and Sales level. Use this module to
set up data for a collection book iPad application. The module also acts as an interface to setup
vendors and the sales division.

= Enterprise Search

This module employs advanced search tools that allow users to define search criteria in
predefined search profiles. Users can search the Centric 8 product data using predefined search
criteria or define a custom search profile.
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= Material Management

Using this module, users can create materials that can be used throughout the system. This
module can also be used to define libraries for creating logical groupings based on individual
business needs.

= Product Specification

Define and deliver specification details and also create the season hierarchy capturing valuable
ideas, comments and feedback.

=  Quality

Using this module, users can define quality assurance testing methods, standards, procedures
and expectations on Materials and Style Types defined in Centric 8.

= Reporting

Reports can be generated as per customer requirements. The output can be either in a PDF
format, an Excel Sheet or a graphical representation.

= Sourcing

This module can be used to define supplier, factory and shipping details. The module also assists
in improving supplier collaboration and performance tracking, fabric and color approval by
supplier as well as sample and cost management - from product concept stage through final
product delivery.
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Choose Modules

10. To select one or more of the optional modules, select the checkbox adjacent to the required
module. Click on Next. For example, select the module Enterprise Search. The Enter Centric
Insight Information dialog box is displayed; enter the Insight server information and click on
Next.
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Figure 6-6: Choose Centric 8 Modules (Optional)
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Figure 6-7: Enter Centric Insight Information dialog box
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NOTE Verify that the Centric 8 Application Server and Centric Insight Server

| are in the same domain.

11. The Check Setup Information dialog box is displayed.
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Figure 6-8: Check Setup Information dialog box

Check Setup Information

Setup has enough miomation to begin the nstallstion.
IF ypous want bo rerviews of chiamge ang of the

seltings, chck Back |f you are satighed vath the
seltings, chck Med to begin.

Cusrerit Settings:
Centiic 8 B
O phioral b odules:
Sourcng
Calerdar Management
Product 5 pecific.ation
M atenal M anagement
WES
Business Planning
Cost Scenano
Quably
Reparting
Collection Book

o o

¢ Back Next > Cancel |

12. Verify the application and module settings under Current Settings. To change the current
settings, click on the Back button. Else to continue with the current settings and begin the
installation process, click on Next.

13. If you are installing Centric 8 PLM without adding any of the optional modules, proceed to step
17.

14. If one or more optional modules have been selected in the Choose Centric 8 Modules
(Optional) dialog box,

= The configuration files will be uploaded

= The installer will stop the Wildfly service

= Centric Wildfly Service Restart Required dialog box is displayed as shown below:
Figure 6-9: Centric Wildfly Service Restart Required dialog box

Centric Wildfly Service Restart Required E

& Flease restart Centric WildFly-3. 1.0 Service from Services dialog.
).-' After restart, make sure wou can login ko Centric & and then click.
-,

|« BACK TO FLOWCHART

Start Wildfly Services

15. To view the desktop, on your keyboard Press Alt+Tab. On the Start menu, select Programs »
Administrative Tools » Services. In the Services window, right-click on the Centric Wildfly
Service and select Start.

16. Once the service restarts, open a browser window and log into Centric 8, this is to verify
successful install of the Centric 8 application.To log out of C8 click on Sign Out.
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17. Press Alt+Tab to return to the installation. Else, to complete the installation, in the Centric

Wildfly Service Restart Required dialog box, click on OK.

18. On completion of the installation process, the Setup Complete dialog box is displayed.

Figure 6-10: Setup Complete dialog box
|
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19. To complete the installation process, click on Finish. To verify whether or not you can

successfully log in to the application, use the following link: http://localhost/webaccess

20. You are now ready to log into Centric 8 and either configure the Centric 8 PLM OR install the

Centric 8 PDF Server. For more information on installing the server, see Appendix H, PDF Print
Server on page 229.

6.3 Centric 8 Operation Application Software Installation

1.

To verify whether or not Wildfly is running, on the Start menu, select Programs »
Administrative Tools » Services.

Select your domain name and log into the domain as Administrator.
Close all Windows applications.

Copy the \\install\C8Applications directory to the server.

U To launch the Wizard, right-click on Setup.exe and select Run as
Administrator.

—
IMPORTANT

5.

The Welcome dialog box is displayed.
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Figure 6-11: Welcome dialog box
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6. Read the contents of the Welcome dialog box. To begin installation, click on Next. The End
User License Agreement dialog box is displayed.

Figure 6-12: End User License Agreement dialog box

Plascin raid thy Folkiwara) et agroerreant. Ui th scool b 12 vatwr s 1t o
L e

' CERTRIC SOFTWARE EWD USER LCENSE AGREEHENT -
NOTICE TD EMD USER: CAREFULLY READ THE FOLLOWIHG LEGAL
MGREEMEMNT. LSE OF THE SOFTWSAE PRVIDED WATH THIS
AGREEHENT [ITHE S0FTwWAREN COMSTITUTES WYOUR ACCEPTANCE
|.'.IF THESE TERMS. IF DU [0 ROT AGREE TO THE TERMS OF
THIS AGREEMENT, FROMFTLY RETURM THE & AND THE
LACCOMPAKYIMG ITEMS TO THE LOCATION WHERE YOU OBTAIMED
THEM FDR & FULL REFUND
IT IS EXFPRESSLY AGREED THAT THE TERMS OF THIS AGREEMEHT
SHALL SUPERCEDE THE TERMS OF Anny DU TOMER PURCHASE ORDERA
OR OTHER DRCERMG DOCUHENT. IF AS THE END USER WU HAVE
AN EXISTIRG ANDUDR ADDNTIONAL SIGHED LICENCE AGREEMENT
(el TH CEMTRIC S0FTWRRE, THAT AGREEMEMNT WILL TAKE PRECEDENCE
1. Diject Coda Licenss (ant. Canb Soltwee granks ,:l

Dl s el ol the tesms ol the preceding kcence sgeament T IF so.
chl oo e Wieck prussh butior, I pou sebech Mo, 5 stup vl chobe

ok | v | He |

7. Read the license agreement. To accept the license agreement, click on Yes. The Enter Centric 8
Administrator Username and Password dialog box is displayed.
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Enter Centric 8 Credential

8. Enter your administrator username and password in the corresponding Username and
Password fields. Ensure that you use the same Username and Password, used earlier in Chapter
2 and Chapter 3. Click on Next. The Choose Application dialog box is displayed.

APPLICATION SOFTWARE INSTALLATION 81



Centric 8 INSTALLATION GUIDE

Figure 6-13: Enter Centric 8 Administrator Username and Password dialog box
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Select Application

9. Select the Centric 8 Operations radio button and click on Next.

Figure 6-14: Choose Application dialog box:
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10. The Check Setup Information dialog box is displayed. Click on Next.
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Figure 6-15: Check Setup Information dialog box
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11. On completion of the upload process of configuration files, the installer stops the Wildfly service
and the Centric Wildfly Service Restart Required dialog box is displayed as shown below:

Figure 6-16: Centric Wildfly Service Restart Required dialog box:
Centric JBoss Service Restart Required Ei

; Plaace restart Centric WildFly-8.1.0 Service from Services dislog.
After restart, maks sure you can bagin bo Centric § and then dick
Ok,

|
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Start Wildfly Services

12. Press Alt+Tab to view your desktop. On the Start menu, select Programs » Administrative
Tools » Services. In the Services window, right-click on Centric Wildfly Service and select
Start.

13. Make sure there is no error in the PI_Centriclog file. To complete the installation, in the Centric
Wildfly Service Restart Required dialog box, click on OK.

14. Once the installation process is completed, the Setup Complete dialog box is displayed.
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Figure 6-17: Setup Complete dialog box
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15. To complete the installation, click on Finish. To check if you can successfully log in to the
application, use the following link: http://localhost/webaccess
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7.1 Centric 8 Backup and Recovery Procedures

Your Centric 8 database and FileVault contain all of your project data; backup your data on
a regular basis to avoid data loss and to allow for data restoration and migration.

During the backup procedure, it is necessary to back up both the database and the FileVault.
You can manually backup your database using the Microsoft SQL Server Management Studio.

The FileVault is a repository for all of the customer data. When you back up the FileVault, a
backup of the directory sub-tree is created.

If the Filevault data is stored in multiple FilevVault folders, backup all of the data into the
same folder.

You can create scripts that allow you to automatically backup your database and FileVault.
When you automate the backup process, use the following parameters:

=  Set the backup process to run when no users are working in Centric 8
= You can back up the database and FileVault simultaneously

On completion of the backup procedure, run the restoration procedure to verify that the
backup is successful.

For a successful restoration, verify that you have an original backup and that the SQL Server
target instance and database used for restoration have the same collation as the source
instance and database.

Restoration is possible for the following two conditions:

= Restore Database on Same Server

Means restoring on the same database on which Centric 8 is installed. For example, you have a
Test Server and you wish to restore a previous backup of the Test Server database.

= Restore Database on a Different Server

Means restoring a database that is from a different server. For example, you have a Production
Server and a Test Server, and you wish to update the Test Server with a database backup from
the Production Server.

For detailed restoration steps, refer Chapter 10: Restoration Procedures for SQL servers on page
107.

|« BACK TO FLOWCHART

7.1.1 Frequency of Backups and Recovery

Depending on your IT failover and disaster policy, the following is recommended:

= Backup Centric 8 database and Filevault on daily and/or weekly basis.
=  Full backup (Cold) of database and Filevault at non-business hours.

= Incremental backup (Hot) of database and Filevault on a daily basis.
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= Do not put backups on same hard disk where database resides. Consider restoration time
when scheduling backups.
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7.2 High Availability and Disaster Recovery Procedures

Based on Centric 8 usage, the Administrator can determine the tolerance / downtime for the
PLM application. For high availability, Centric recommends the following:

1. Mirror SQL database

Setup SQL replication and mirror server such that when the SQL server is offline/not available,
the mirror server can be online and available.

2. Create Failover instance for database

If the SQL cluster is in use, setup Failover instance for SQL so it can be brought in during down
time.

3. Filevault in sync

Have a mirror server setup with Filevault backup either using DFS or manual copy of folders.

4. Application Failover

Setup a failover instance for the application, configure URL to point to a new server during down
time.
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7.3 Periodic Audit of Hardware and Network Usage; Plan for
Upgrade

Evaluate your database needs based on projected use, implementation, and integration of
existing data. The Filevault expansion plan can be based on the projected image and
document storage.

Based on your implementation, accumulation of log files, and projected image and
i ' document usage, your mimimum requirements may wary.

— Work with Centric Software Client Services or Contact Centric Technical Support for
specifications based on your disk space capacity needs.

Centric recommends that you evaluate the current Centric 8 data usage periodically, say
every 6 months, and evaluate the projected use.

You may be adding more users to the system or adding modules for production use etc.
Based on that, plan for upgrading hardware (adding more memory/upgrading CPU
processors etc).
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7.3.1 Monitoring Centric 8 Servers

Following is a list of things that you (Customer IT) should monitor on Centric 8 Servers:

= Disk usage

Check for free space availability regularly to minimize interruption

= CPU usage

During peak usage of Centric 8, use monitoring tools such as Perfmon to monitor CPU usage,
capture the results

=  Memory usage

Ensure that sufficient memory is allocated for the App server (wildfly) and SQL database
based on current usage in order to get optimal performance. Adjust the memory settings

accordingly.

During peak load periods, monitor the PDF printing usage. Setup multiple PDF servers to
distribute the load.

= Monitor Centric 8 log files (located in <C8 Install>\Log folder) and report them to the
Technical Support Team

=  Support if any errors found

= Monitor database performance by capturing SQL queries using SQL profiler tool and send
us the trace files

= If your database server is hosting other databases, monitor database activity regularly
and ensure that it does not interfere with Centric 8 database

= If the application server is hosted on a VM, monitor VM host server CPU and memory
usage and adjust settings accordingly
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7.4 Index Database Tables

= Reindexing script is available in the Centric 8 installation path in the Database Scripts
folder.

= Reindexing command: BATCH_RebuildAllindexes.bat DBServerName sa sa_password
CentricDBName.

e Open Command prompt.
¢ Navigate to Database scripts folder under C8 Installed directory.

e Execute the Batch file BATCH_RebuildAlllndexes.bat DBServerName sa sa_password
CentricDBName.

= Index Centric 8 database tables for improved performance.
U = Re-index database tables weekly, process takes approximately 20 minutes.

= Schedule re-indexing time so as to least impact your business and IT
RS processes; note that Centric 8 remains online during re-indexing but
performance may be affected
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8. POST INSTALLATION CHECKLIST
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8.1 Post Installation Checklist

1.
Home page is OK.

Figure 8-1: Centric 8 Setup Page
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Displaying 20 of 320 results.
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2. Verify whether or not you are able to print ad-hoc PDF.

To print ad-hoc PDF, navigate to Home » Style » Season tab. From the Export drop-

down list, select PDF. Verify whether or not the Data Package prints is OK.

Figure 8-2: Excport to PDF option

(1} My Home || Style || Material Specification Sourcing Documents Issues Reports Select Sets Busine:
Seasons Shapes Themes Styles Style Gallery Colorways Style Samples Sample Storage || Style SKUs
Views [Default ~lgpr @ é Export || Results:20 = | ) Suspend

! Excel ? =
mber of Styles Image Actions B3

Excel (Flat)
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ewf

(Ally Ay

|
|

W8

3. Ensure that the Image Service is working as expected and the images can be viewed when an Al

file is added as a document.

To add an Al file as a document, navigate to Home » Documents » Documents tab.
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Figure 8-3: Adding Al file on the Documents tab
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Performance Tuning
1. Wildfly Memory Setting (standalone.conf.bat)

Adjust java memory based on available system memory and number of concurrent users.

= The default memory is 4GB (suitable for 20 users). You can increase 2GB memory for
each additional user (up to 10 concurrent users)

4

NOTE
I

For information about changing Wildfly memory usage, see Appendix
C. Wildfly Memory Usage on page 189.
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2. DB connection pool and Java thread settings (standalone-pi*.xml)

Adjust max DB connection pool and max threads count based on number of active concurrent
users.

= Search for max-connection pool string in standalone-pi*.xml file. The default pool size is
25. Increase it to number of active users count

<pool=
<min-pool-size>Z</min-pool-size>
{max—puul—siZEFESFfmax—puul—size}

= Search for max-threads string in standalone-pi*.xml file. The default thread size is 50.
Increase it to 10 less than max DB connection pool setting

<long-running-threads>
<core-threads count="50"/>
<gqueue-length count="50"/>
<max-threads count="45/"/>
<keepalive-time time="10" unit="seconds"/>
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= Increasing the db connection pool else the thread setting will increase Wildfly Java
memory. Ensure that the system has enough memory available before making this
change.

I
rem & JvM memory allocation pool parameters - modify as appropriate.
set "JAVE_OPTS=-Xmsil2M ->xmxd 006M -XiMaxPermsize=312M"
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3. SQL Memory Setting (SQL management studio)

= Adjust the memory setting for the SQL instance based on Centric 8 database size

e Based on the PLM usage and user activity, set maximum memory for SQL instance in
SQL management studio on the Instance properties » Memory tab

e Ensure that the max memory setting is greater than the C8 database size
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4. Consider allocating 2GB for Operating system and 2GB for PDF/Image
services.
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9. BACKUP PROCEDURES FOR SQL SERVER

?
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9.1 Backup

Your Centric 8 database and FileVault contain all of your project data; backup your data on
a regular basis to avoid data loss and to allow for data restoration and migration.

During the backup procedure, ensure back up of both the database and the FileVault.

9.1.1 Manual Database Backup
You can manually backup your database using the Microsoft SQL Server Management Studio.

|44 Back 10 FLOWCHART

9.1.2 Backup — Database Backup (SQL Server)

The SQL Server Management Studio is an integrated environment used for configuring,
managing, administrating, and developing components of the SQL Server.

|« BACK TO FLOWCHART

9.1.2.1 Back up the database using the SQL Server Management Tools
1. Before taking a backup, ensure that the Wildfly Services are stopped. Else, the backup will fail.

2. On the Start menu, select Programs » Microsoft SQL Server 2008 R2 » SQL Server
Management Studio. The Connect to Server dialog box is displayed.

Figure 9-1: Connect to Server dialog box

Select Server name or
Server Name/Server
Instance

|
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L
Click on Connect
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3. On the Server name menu, select the <server name=> to which you wish connect to the default
instance OR select <server name=>\<instance name=> to select a named instance on the
server.

4. To use the database system administrator user name, ‘sa’, and the corresponding database
system administrator password, on the Authentication menu, select SQL Server
Authentication.

ELSE

If you have administrator rights on the server and wish to login using your user name and
password, select Windows Authentication

5. Click on Connect. The Microsoft SQL Server Management Studio window is displayed.
6. In the Object Explorer pane, expand the server group, and then expand Databases.

7. Under Databases, right-click on the C854 database icon (or the database name specified in the
standalone-pi-mssql.xml file), select Tasks » Back Up.

8. The Back Up Database dialog box is displayed. Under Select a page, click on General. The
General dialog box is displayed in the right pane.

Figure 9-2: Back Up Database — C854 dialog box — General Page
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Recovery model I SIMPLE
Backup ype: [Fu =]
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¥ Databaze
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Nane: | C854 Full D atabase Backup

Description: |
Backup set will expire:

@ Aer -
C O /3172015 v
. Destination
ITTEST Back up to:  Ditk

Connection L-\\Program Files\Microsoit SOL 5
sa

B¢ Wisw connection pioperties

Ready

9. In the Source section, from the Database drop-down menu, select the database you wish to
back up.

10. From the Backup type drop-down menu, select Full.
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11. In the Backup set » Backup set will expire, click on the After radio button and select O days.

4 It is necessary to select After in the Backup set will expire option, and set
NOTE the field value to O. Else the backup file is rendered useless after a given
L delay or date.

12. Under Destination, the Back up to window displays the last location used to generate the
backup file.

13. Click on Disk. To add a new destination file, click on Add OR to remove the currently selected
destination, click on Remove. Additionally, you can click Contents to view the media set
(device) location.

14. Under Select a page, click on Options. The Options dialog box is displayed in the right pane.

Figure 9-3: Back up Database — C854 dialog box — Options Page
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15. Under Overwrite media, click on the Back up to the existing media set and then click on one
of the following options:

a. Append to the existing backup set: Adds a new set of data to the media set; the new set of
data is added as a new backup set inside the original backup. During restoration, this selection
allows you to select which back up to restore.

b. Overwrite all existing backup sets: Overwrites all data with the current media set contents.
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#

NOTE
|

To eliminate duplication and reduce the file size, Centric Software
recommends selecting Overwrite all existing backup sets option.

16. To safeguard the backup media from accidental overwrite, select Check media set name and
backup set expiration. Type the name of the media to be used for the backup operation in the
Media set name field OR leave the field blank to specify that the system check only the backup
set expiration.

17. For backup completion verification, under the Reliability section, click on Verify backup when
finished.

#

NOTE Under the compression section, choose compression backup
|

18. Click on OK. Allow the database backup to progress; depending on the database size and the
installation server capacity, the backup process takes from a few seconds to a few minutes. Once
the backup process is completed, the following confirmation message is displayed:

Figure 9-4: Successful backup confirmation message

Microsoft SQL Server Management Studio E3

'-6.' The backup of database 'C854" completed successFully.

19. Click on OK, and then close the SQL Server Management Studio window.
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9.1.3 Backup —FileVault

The FileVault is a repository of all customer data. When you back up the FileVault, you create
a backup of the directory sub-tree.

4

NOTE
|

If your FileVault data is stored in multiple FileVault folders, backup all of the data
into the same folder.
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9.1.3.1 Locate the FileVault path

1. Locate the Filevault installation folder.

For example: C:\Program Files\Centric Software\C8.
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If you do not know the location of the FileVault folder, you can locate the folder in one of two
ways:

= Search the file: pi-configuration.properties OR

= Review the database table
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9.1.3.2 Search the pi-configuration.properties file

1.

Open the file pi-configuration.properties in Notepad. The file is located in your Centric 8 program
folder on your system:

<Centric8InstallDirectory>\ Centric 8\wildfly-8.1.0\Standalone\ configuration
Search for the following string:

'com.centricsoftware.server.FilePublisher CENTRIC_FILE_VAULT.VaultFolder'
The FileVault folder location appears at the end of this line of code, for example:

= C:\\PROGRA—~1\\CENTRI—=1\\Centric 8\\FileVault
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9.1.3.3 Locate the FileVault folder in the database table

1.
2.

In the SQL Server Management Studio dialog box, create a new query on the database.
Enter the following code in the query window:
SELECT  [File_URL_ID]
, [Version]
[NodeName]
, [PublishedTime]
[Publisher_URL_ID]
, [PublishedSize]
[Content]
[VaultFullPath]
FROM [Database Name].[dbo].[Centric_file_version]

Click on Execute.

The FileVault folder location is displayed in the VaultFullPath column in the Result pane.
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Figure 9-5: Filel ault folder location
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9.1.3.4 Backup the FileVault

If you have multiple FileVault folders, be sure to backup all the folders.

1. On the system where Centric 8 is installed, open Windows Explorer.

2. Make a copy of the FileVault sub-tree structure, and paste the FileVault data into a backup folder
location.
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9.2 Automatic Database Backup

You can create scripts that allow you to automatically backup your database and FileVault.
When you automate the backup process, use the following parameters:

=  Set the backup process to run when no users are working in Centric 8

= You can back up the database and FileVault simultaneously

|44 Back to Flowchart

9.2.1 Application Server Script— Stop Server

Once the backup process is completed, create two batch (.bat) files. One of the .bat files is
used to stop the application and the application server. The other .bat file is used to restart
the application and application server.
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’ After the application server stops, allow the stop service scripts to conclude
NOTE before continuing with the backup; this allows asynchronous activities to come to
L= a complete stop on the application server.

9.2.1.1 Stop the application server
1. Create a batch file with the name: StopPIApparel.bat.
2. In the batch file, add the following command:

net stop <service name>

Where <service name=> represents the default Centric Wildfly Service, for example,

net stop 'Centric Wildfly-8.1.0 Service’
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9.2.2 Database Backup Script—Backup Environment

Create a batch file to set the backup environment and execute an SQL Server script.

9.2.2.1 Set the backup environment and execute the SQL Server script
1. Create a batch file called BackupCentricCSIPI1DataBase.bat.

2. Add the following script to the batch file to set the environment, and to execute the SQL Server
script:

echo on

echo

echo *** Centric 8 Database Backup Start ***

echo
sglemd -U <admin login> -P "<admin password>" -S <database server>

-d <database name> -i "<backup sql script path=>"

echo echo

*** Centric 8 Database Backup End ***

echo
pause

Where the following is true:

v <admin login> is the system administrator login (for example, sa)

v <admin password> is the corresponding password

»  <database server> is the database server name or IP address

= <database name> is the name of the Centric 8 database; the default name is CSIPI1

v <backup sql script path> is the full path to the SQL Server script that is to follow
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For example:

echo on

echo

echo *** Centric 8 Database Backup Start ***

echo
sglemd -U sa -P "123!abc" -S DBServer -d DBPLM —i"E:\PLMBackup.sql"

echo

echo *** Centric 8 Database Backup End ***

echo

pause
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9.2.3 Database Backup Script—SQL Server Script

Create a batch file to back up the database.

9.2.3.1 Create the SQL Server script
1. Create a batch file called DatabaseBackup.sql.

2. Create the following script to automatically back up the database after setting the environment
with the following file:

BackupCentricCSIPI1DataBase.bat

BACKUP DATABASE [<database name>] TO DISK = N'<backup path>\<database
name=>.bak' WITH NOFORMAT, INIT, NAME = 'Not <database name>-Complete database
maintenance’, SKIP, NOREWIND, NOUNLOAD, STATS = 10

GO

Where the following is true:

v <database name> is the name of Centric 8 database; the default value is CSIPI1

v <backup path> is the full path to the backup directory; the database backup is then
included in the .bak file
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9.2.4 FileVault Backup Scripts (Application Server) — Copy File Tree
Script

On the application server, back up the FileVault and create a batch file to copy the file sub-
tree.
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9.2.4.1 Locate the FileVault path

1. Search the pi-configuration.properties file for the FilevVault location:
a. Open the file pi-configuration.properties in Notepad.

b. Search for the string:

‘com.centricsoftware.server.FilePublisher.CENTRIC_FILE_VAULT.VaultFolder®

2. The FileVault folder location appears at the end of this line of code, for example

C:\\PROGRA~1\\CENTRI—=1\\Centric8\\FileVault
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9.2.4.2 Copy the file tree
1. Create a batch file on the application server called BackupCentricFileVault.bat.
2. Add the following script to the file:
set dir_name=FileVaultBackup_%DATE:~7,2%_%DATE:~4,2%
md <backup path>\%dir_name%o
xcopy /S <file vault location> <backup path=>\%dir_name%o
Where the following is true:
= dir_name is any FileVault in a directory matching the backup day
= <file vault location> is the full path to the FileVault folder

v <backup path> is the full path to the backup directory

0 Always back up the database and FileVault in the same session. If you have
multiple FileVault folders, use this script to back up all FileVault folders.
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9.2.5 FileVault Backup Scripts (Application Server) — Scheduled

The Microsoft Windows integrated backup tool allows you to schedule FileVault backup by
calling the BackupCentricFileVault.bat file.

o You can use the Scheduled Tasks window to automatically backup the database.

e
IMPORTANT
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9.2.5.1 Schedule the automatic backup
1. On the Start menu, click on Control Panel.
2. In the Control Panel window, double-click on Scheduled Tasks.

3. In the Scheduled Tasks window, click on Add Scheduled Task. The Scheduled Task Wizard is
displayed. Click on Next.

Figure 9-6: S cheduled Task Wizard (1) dialog box
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4. Click on Browse to locate and select your FileVault batch file BackupCentricFileVault.bat. Click on
Next.

Figure 9-7: S cheduled Task Wizard (2) dialog box
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5. Enter a name for the task. To set the backup to run daily, click on the Daily radio button and
then click on Next.

Figure 9-8: Scheduled Task Wizard (3) dialog box
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6. In the Start time field, select a start time. Under Perform this task:, click on the Every Day
radio button. In the Start date: field, select the start date. Click on Next.

Figure 9-9: Scheduled Task Wizard @) dialog box
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7. Enter details in the Enter the user name, Enter the password and Confirm Password fields.
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To modify your scheduled task setup:
=  On the Start menu, click on Control Panel.

. = In the Control Panel window, double-click on Scheduled Tasks.
| = |n the Scheduled Tasks window, right-click on your scheduled task and

select Properties. Modify your scheduled task as necessary. To save
changes, in the Properties dialog box, click on OK.
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9.2.6 Application Server Script— Start Server

On completion of the backup procedure, restart the application server.

9.2.6.1 Start the application server
1. Create a batch (.bat) file named StartP1Apparel.bat.
2. In the batch file, add the following command:

net start <service name>
Where <service name=> represents the default Centric Wildfly Service, for example,
net start 'Centric Wildfly-8.1.0 Service'
3. On completion of the backup procedure, restart the system by running the StartPIApparel.bat file.

#

NOTE To verify that the backup is successful, run the restoration procedure. For more

information, refer RESTORATION PROCEDURES FOR SQL SERVERS on page 107.
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10. RESTORATION PROCEDURES FOR SQL SERVERS

=¥
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10.1 Database Restoration

For a successful restoration, always back up the database and FileVault using the procedures
described in the section “Backup” on page 95. Verify that you have an original backup and
that the SQL Server target instance and database used for restoration have the same
collation as the source instance and database.

1. Restore Database on Same Server

If you are restoring on the same database on which Centric 8 is installed, for example, you
have a Test Server and you wish to restore a previous backup of the Test Server database,
use the steps provided in the section Centric 8 Backup and Recovery Procedures on page 87.

2. Restore Database on a Different Server

If you are restoring a database that is from a different server, for example, you have a
Production Server and a Test Server, and you wish to update the Test Server with a database
backup from the Production Server, follow the steps in Centric 8 Backup and Recovery Procedures
on page 87 and then use the steps in Database Restoration: Different Server Instance on page
113 to complete the restoration.

|« BACK TO FLOWCHART

#

NOTE Ensure that the same C8 software is installed and working.
|

10.2 Restore the Database

To restore the database:

1. In the Services window, right-click on Centric Wildfly Service, and select Stop.

2. On the Start menu, select Programs » Microsoft SQL Server » SQL Server Management
Studio. The Connect to Server dialog box is displayed.

3. Log into the database server. The SQL Server Management Studio window is displayed.
4. In the Object Explorer pane, expand the server group, and then expand Databases.

5. Under Databases, right-click on the database and select Tasks » Restore » Database.

-

NOTE To verify the database name, refer the standalone-pi.xml file.
|
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Figure 10-1: Microsoft SQL. Server Management Module dialog box
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6. The Restore Database window appears.

7. In the General page, under Destination for restore, verify that the database name is the
database name specified in the standalone-pi-mssql.xml file.

8. Under Source for restore, click From device and select Browse. The Specify Backup dialog
box is displayed.

Fignre 10-2: Specify Backup dialog box
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9. In the Specify Backup dialog box, click on Add. The Locate Backup File dialog box appears.

10. In the Locate Backup File dialog box, locate and select the desired restoration file of type .bak.
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Figure 10-3: Locate Backup File dialog box
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11. Click on OK. The selected file name is displayed in the Specify Backup dialog box in the Backup

location pane.
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12. To close the Specify Backup dialog box, click on OK. The selected file is displayed in the

Restore Database dialog box.
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Figure 10-5: Restore Database CSIPIT
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13. In the Select the backup sets to restore pane, in the Restore column, select the checkbox
adjacent to the required file name (to be used for restoration).

4 A single backup file can contain more than one backup. The backup date and the

NOTE server name are available in this window; check the date and server information
L to verify that you are selecting the backup you wish to use for the restoration.

14. In the left pane under Select a page, click on Options; the right pane displays the restoration
options.

15. In the right pane under Restore options, select the parameters for the restoration.

o The database file path may change from one server to another; update all file
paths in the Original File Name as necessary.

IMPORTANT

a. Under Restore options, select the Overwrite the existing database checkbox.

b. Under Restore the database files as, review the file names and make sure there are no
duplicate file names. If there is a duplicate file name, modify the name.

c. Under Recovery state select Leave the database ready to use by rolling back
uncommitted transactions.
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Figure 10-6: Back Up Database - CSIPIT dialog box
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16. After setting up the restoration parameters, click on OK. The restoration progress displays at the
bottom of the left pane; allow the restoration process to finish. When the restoration process is
completed, a confirmation message is displayed as shown below:

Figure 10-7: Message confirming successful completion of the restoration procedure
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10.2.1 Runthe sp_change_users_login script on the master database

1. Verify that the Wildfly Service is stopped.

2. In the SQL Server Management Studio dialog box, right-click on the top-level database icon
and select New Query.
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3. In the query window, type the sp_change_users_login script:

use <database name>
exec sp_change_users_login ‘'update_One’', ‘csidba’, ‘csidba’
For example,
use PLMCentricDB
exec sp_change_users_login 'update_One', 'csidba’, 'csidba’
4. Click on Execute.
5. Click on OK and close Microsoft SQL server Management Studio.

6. In the Services window, right-click on the Centric Wildfly Service and select Start.

If you are restoring the database on a different server instance, proceed to
Database Restoration: Different Server Instance on this page. Else, proceed to
RGN FileVault Restoration on page 114
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10.3 Database Restoration: Different Server Instance

If you are restoring on a different server instance, once you restore the database by following
the instructions in the section Database Restoration on page 108, you then delete the log files,
and update the user login.
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10.3.1 Delete Log Files

= Delete the .log files located in the following location:
<Centric8InstallDirectory>\ Centric8\LOG

On completing deletion of the log files, follow the steps given below to restore the database
on a different server instance.
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10.3.2 Runthe sp_change_users_login script on the master database

1. Verify that the Wildfly Service has stopped.
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2. In the SQL Server Management Studio dialog box, right-click the top-level database icon and
select New Query.

3. In the query window, type the sp_change_users_login script:

use <database name>

exec sp_change_users_login ‘update_One’, ‘csidba’, ‘csidba’
For example,

use PLMCentricDB

exec sp_change_users_login ‘'update_One’', ‘csidba’, ‘csidba’

4. Click on Execute.
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10.4 FileVault Restoration

Once the database is restored, it is not possible to restore the FileVault.
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10.4.1 FileVault Location

The FileVault location is determined during installation. When restoring a server or duplicating
a configuration on a different server, you must verify, and if necessary, update the FileVault
location to reconnect the files with the application.
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10.4.1.1 Locate the FileVault Path

1. Search the pi-configuration.properties file for the FileVault location:
a. Open the file pi-configuration.properties in Notepad.

b. Search for the string:

‘com.centricsoftware.server.FilePublisher.CENTRIC_FILE_VAULT.VaultFolder®

2. The FileVault folder location appears at the end of this line of code, for example:

= C:\\PROGRA—~1\\CENTRI—=1\\Centric8\\FileVault
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10.4.1.2 Rename or remove the current FileVault data

1. Locate the FileVault folder, for example, <Centric8InstallDirectory>\Centric8\FileVault.
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0 If your FileVault data is stored in multiple FileVault folders, copy all of the data
into the same restoration folder.

IMPORTANT

2. Overwrite the contents of the FileVault folder.
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10.4.1.3 Locate the original FileVault file location in the database

1. In the SQL Server Management Studio dialog box, create a new query on the database, and enter
the following code in the query window:

SELECT [File_URL_ID]

, [Version]
, [NodeName]
, [PublishedTime]
, [Publisher_URL_ID]
, [PublishedSize]
, [Content]
, [VaultFullPath]
FROM [Database Name] . [dbo] . [Centric_file_version]

2. Click Execute.

3. The FileVault path displays in the VaultFullPath column in the Result pane. Use this path to
complete the dependency script in Run the FileVault dependency script on page 116.
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Figure 10-8: Microsoft SQL. Server Management S tudio
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10.4.1.4 Restore the FileVault

= Copy the desired FileVault backup to the FileVault location to restore the data.
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10.4.1.5 Run the FileVault dependency script

It is possible that the FileVault path may change during backup and restoration. To update
the FileVault path, run the dependency script where <soure File Vault path> represents the
backup FileVault path (defined in Locate the original FileVault file location in the database on page
115) and <target File VVanlt path> represents the new FileVault path.

1. In SQL Server Management Studio, right-click on the database and select New Query. Paste
the following script into the Query pane; be sure to replace <source File 1anlt path> and <target File
Vault path> with the correct FileVault paths:

SET NOCOUNT ON

SET ARITHABORT ON;

SET CONCAT_NULL_YIELDS_NULL
ON; SET QUOTED_IDENTIFIER
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ON;

SET ANSI_NULLS

ON; SET
ANSI_PADDING ON;
SET ANSI_WARNINGS
ON;

SET NUMERIC_ROUNDABORT OFF;

DECLARE @ROWCOUNT INT;
DECLARE @TOTROWCOUNT INT; SET
@TOTROWCOUNT=0

DECLARE @BeforePartialStringnvarchar(100);SET @BeforePartialString='<source File Vault
path=\"

DECLARE @AfterPartialString nvarchar(100);SET @AfterPartialString="'<target File Vault path>\'

SET ROWCOUNT

10000 SET @ROWCOUNT = -1
WHILE @ROWCOUNT

<>0

BEGIN

UPDATE dbo.Centric_file_version

SET VaultFullPath=REPLACE (VaultFullPath, @BeforePartialString, @AfterPartialString)
WHERE CHARINDEX(@BeforePartialString,VaultFullPath) > O;

SET @ROWCOUNT =@@ROWCOUNT;
SET @TOTROWCOUNT=@TOTROWCOUNT +
@ROWCOUNT; IF @ROWCOUNT = 0

PRINT CONVERT(varchar(12),@TOTROWCOUNT)+'Centric_file_version.VaultFullPath columns
updated so far'

END;

2. Click on Execute.
3. On completion of the script execution, a success message is displayed in the Messages pane.

4. Delete the log files.
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10.4.1.6 Restart Wildfly Service

Once the restoration is complete, restart the Wildfly service.

» How to start Wildfly Service
1. On the Start menu, select Programs » Administrative Tools » Services.
2. In the Services window, right-click on Centric Wildfly Service and select Start.

3. Allow a few moments for the batch files to finish running in the background.

|« BACK TO FLOWCHART

RESTORATION PROCEDURES FOR SQL SERVERS 118



Centric 8 INSTALLATION GUIDE

11. ORACLE DB BACKUP AND RESTORE PROCEDURE
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11.1 Backup

Your Centric 8 database and FileVault contain all of your project data. To avoid data loss and
to allow for data restoration and migration, ensure that you backup your data on a regular
basis.

During the backup procedure, ensure that you back up both the database and the FileVault.
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#
NOTE Use the DMPDIR1 directory. Use all directories to view default directories.

11.2 Database Backup

1. Open the Command Prompt and type sg/p/us and press the Enter key. Type oracle Administrator
username and password.

Figure 11-1: Administrator: Command Prompt - sqlplus
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2. Type Select directory_name from all_directories; and click on the Enter key.

Note: All current default directories will be displayed.
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DIRECTORY_NAME
DMPDIR

XMLDIR

DATA_PUMP_DIR
ORACLE_OCM_CONFIG_DIR

Figure 11-2: Administrator: Conmand Prompt — SQL. Plus (2)
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3. In SQL Plus, type Create Directory DMPDIR1 as ‘C:/DMPDIR1".

4. Create a New folder DMPDIR1 under C:/ Drive.

Figure 11-3: Creating a new folder under 1ocal Disk (C:)
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5. In SQL Plus, login as Administrator and type the command GRANT READ,WRITE ON
DIRECTORY DMPDIR1 TO CSIDBA; and press the Enter key.

Grant Permission to the directory.

Figure 114: Administrator: Conmand Prompt — SQL. Plus (3)

L>» GRAMT R LWRITE ON DIRECTORY DHPDIRL TO CEIDEA;

Grant succosded.

6. Type the following command

expdp CSIDBA/CSI1nstall schemas=CSIDBA directory=DMPDIR1 dumpfile=exp.DMP
logfile=exp.log

Figure 11-5: Administrator: Command Prompt
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11.3 Backup FileVault

The FileVault is a repository for all of the customer data. When you back up the FileVault,
you create a backup of the directory sub-tree.

NOTE If your FileVault data is stored in multiple FileVault folders, backup all of the data
| into the same folder.

|« BACK TO FLOWCHART

11.3.1 Locate the FileVault path

1. Locate the Filevault installation folder.

For example: C:\Program Files\Centric Software\C8.

If you do not know the location of the FileVault folder, you can locate the folder in one of the
following two ways:

= Search the pi-configuration.properties file, or

= Review the database table

|« BACK TO FLOWCHART

11.3.2 Search the pi-configuration.properties file

1. Open the file pi-configuration.properties in Notepad. The file is located in your Centric 8 program
folder on your system:
<Centric8InstallDirectory>\ Centric 8\wildfly-8.1.0\Standalone\ configuration

2. Search for the string:
‘com.centricsoftware.server.FilePublisher.CENTRIC_FILE_VAULT.VaultFolder®

3. The FileVault folder location appears at the end of this line of code, for example:

= C:\\PROGRA—~1\\CENTRI—=1\\Centric 8\\FileVault

|44 Back TO FLOWCHART

11.4 Database Restore Procedure

For a successful restoration, always back up the database and FileVault using the procedures
described in Database Backup on page 120. Verify that you have an original backup and that
the Oracle Server target instance and database used for restoration have the same collation
as the source instance and database.

|44 Back TO FLOWCHART
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11.5 Restore Database

If you are restoring the Database on the machine on which Centric 8 is installed, for example,
you have a Test Server and you wish to restore a previous backup of the Test Server

database, use the steps explained in the section Restore the Database on page 108.

1. Stop the Wildfly service in the application server.

Figure 11-6: Services window
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2. Inlocal host command prompt, type Sg/plus CSIDBA/ CSI1nstall as syshda.
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Figure 11-7: Administrator: Command Prompt

o+ Administrator: Command Prompt - Sglplus CSIDEA/CSTInstall as sysdba

CislzerssAdninistrator? Sglplus CSIDBA-CElinztall as sysdba
sQL=Flus: Release 11.2.8.4.8 Productionm on Sun Feb % 21:43:1% 2814
Apyright <c) 1982, 28013, Oracle. Hll rights reserved.

Connected to:

Dperac le Databaze 11g I‘.-I'Itll.'l'l!J"l-.:ﬁL:‘ Edition Releaze 11.2.8.4.8 - 64bit Production
lith the Partitioning. OLAF. Data Hining and Real Application Testing options

3. In the SQL command prompt, type Drop user CSIDBA CASCADE; and press on the Enter key.

Figure 11-8: Adprinistrator Conmand (2)

Administrator: nand Prompt - Sglplus CSIDBA/CSIInstall as sysdba
SGL> Drop u ™

User deopped.

SQL>

Drop and create user to restore the schema or else the db will prompt you
already exit error message.

4. Type Create user CSIDBA identified by CS11nstall;

Figure 11-9: Administrator: Conmand Prompt (3)

Administrator: Command Prompt - Sglplus CSIDBA/CSI1nstall as sysdba
SQL> Create user CSIDBA identified by CSIinstall;

Uzer created.

S0QL >

5. Type Grant resource,connect,create view to CSIDBA; and press on the Enter key.
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Figure 11-10: Administrator: Command Prompt (4)

[ Administrator: Command Prompt - Sglplus CSIDEA,/CSI1nstall as sysdba

view to CSIDBA;

6. Type GRANT READ,WRITE ON DIRECTORY DMPDIR? TO CSIDBA, and press on the Enter
key.

Figure 11-11: Administrator: Command Prompt (5)

v Adminkstr ator: Command Prompt - Sqlplus CSIDBA/CSI1nstall as sysdba
SQL>» GRANT READ.WRITE OM DIRECTORY DMPDIRL TO CEIDBA:

Grant succeeded.

SGLY _

7. In the local host command prompt, type:

impdp CSIDBA/ CSI1 nstall schemas=CSIDBA directory=DMPDIRT dumpfile=exqp.DMP logfile=inp.log
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Figure 11-12: Adprinistrator: Commaand Prompt (6)

mimand Prompt

» Administrato dp CEIDPBA-CEIlnstall schemas=C5IDBA directory=DHFDIR
1'||.:n]:|: ile=jaiexp.DHP 1 ile=imp. log

Import: Releasze 11. 2.8.4.8 Production on Sun Feh 9 21:54:2 14

Copyright (c» 1¥82, 2811, Oracle and-sor itz affiliates. HAll rights reserved.

Connected to: Oracle Database 11g Enterprize Edition Releaze 11.2.8.4.8 - 64bit
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8. Create the cf_safeToNumber and safeToBoolean functions as CSIDBA user.

In C:\, type Sqplus CSIDBA/password@SID
CREATE OR REPLACE

FUNCTION cfT_safeToNumber

( str VARCHAR?2

)

RETURN NUMBER DETERMINISTIC

AS

num NUMBER(37,10);

BEGIN

ORACLE DB BACKUP AND RESTORE PROCEDURE 127



Centric 8 INSTALLATION GUIDE

num:= TO_NUMBER(str);
RETURN num;
EXCEPTION

WHEN OTHERS THEN
RETURN NULL;

END;

/

CREATE OR REPLACE
FUNCTION cf_safeToBoolean
( str VARCHAR2
)
RETURN NUMBER DETERMINISTIC
AS
num NUMBER(37,10);
BEGIN
RETURN
CASE
WHEN str = 'true’ THEN 1
WHEN str = 'false’ THEN O
ELSE NULL
END

END cf_safeToBoolean;

/

9. Run impdp utility as the SYSTEM user credential.

In C:\, type impdp SYSTEM/ password@SID schemas=CSIDBA directory=DMPDIR
dumpfile=EXP052813.DMP logfile=exp.log

Clean up import errors: recreate IX_AVE_BOOLEAN ON index and recompile procedures.
* In C:\, type Sq/plus CSIDBA/ password@S1D
= Type SQL> DROP INDEX IX_AV'E_BOOLEAN.

=  Type SQL> CREATE INDEX IX AV'E _BOOLEAN ON
ATTRIBUTE_VARIANT_ELEMENT (ValueBooleanTABLESPACE C8_index.

" Type SQL> exec dbms_utility.compile_schema('CSIDBA');)

|44 BACK TO FLOWCHART
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11.6 FileVault Restoration

Once you restore the database, you are ready to restore the FileVault.

|« BACK TO FLOWCHART

11.6.1 FileVault Location

The FileVault location is determined during installation. When restoring a server or duplicating
a configuration on a different server, you must verify, and if necessary, update the FileVault
location to reconnect the files with the application.

|44 Back TO FLOWCHART

11.6.2 Locate the FileVault path

1. Search the pi-configuration.properties file for the FilevVault location:

a. Open the file pi-configuration.properties in Notepad.

b. Search for the string:
'com.centricsoftware.server.FilePublisher. CENTRIC_FILE VAULT.VaultFolder'

2. The FilevVault folder location is displayed at the end of this line of code, for example:

= C:\\PROGRA—1I\\CENTRI—1\\Centric8\\FileVault

|44 Back TO FLOWCHART

11.6.3 FileVault Dependancy Script for Oracle DB

1. Open Notepad and paste the following content:

SET SERVEROUTPUT ON;
-- @D:\Insectarium\Database\CentricHub\Oracle10g\Filevault.sql

/*****************************************************************************

SR * X

This standalone script must first be edited, to include correct 'before’ and 'after' path details. Run
this script against an Oracle database to synchronize the file vault paths stored in the database
with the revised physical file vault paths, ususally occurring when restoring the file vault on a
different server.

AEEA A A A A A A A A A AET AT A A A A A A AEA A A A A A A A A AA A A AAAXAXAXAAAAAAAAAAXAAXAAAAAAAXAAAAALALAXA XX KXXX

/

/* MSSQL T-SQL implementation

SET NOCOUNT ON

SET ARITHABORT ON;

SET CONCAT_NULL_YIELDS_NULL ON;
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SET QUOTED_IDENTIFIER ON;

SET ANSI_NULLS ON;

SET ANSI_PADDING ON;

SET ANSI_WARNINGS ON;

SET NUMERIC_ROUNDABORT OFF;

DECLARE @ROWCOUNT INT;

DECLARE @TOTROWCOUNT INT;
SET @TOTROWCOUNT=0

DECLARE @BeforePartialString nvarchar(100);SET @BeforePartialString="<source File Vault
path=\"

DECLARE @AfterPartialString nvarchar(100);SET @AfterPartialString='<target File Vault path>\'
SET ROWCOUNT 10000
SET @ROWCOUNT = -1
WHILE @ROWCOUNT <> 0
BEGIN
UPDATE dbo.Centric_file_version
SET VaultFullPath=REPLACE(VaultFullPath,@BeforePartialString, @AfterPartialString)
WHERE CHARINDEX(@BeforePartialString,VaultFullPath) > O;
SET @ROWCOUNT =@@ROWCOUNT;
SET @TOTROWCOUNT=@TOTROWCOUNT + @ROWCOUNT;
IF @ROWCOUNT > 0

PRINT CONVERT(varchar(12),@TOTROWCOUNT)+" Centric_file_version.VaultFullPath columns
updated so far'

END;

*/

SET SERVEROUTPUT ON;

/

DECLARE

v_rowcount number(12);
v_totrowcount number(12) := 0;

v_BeforePartialString varchar2(100) :='<source File Vault path>\"; /*** YOU MODIFY THIS PATH

***/

Vv_AfterPartialString varchar2(100) :='<target File Vault path>\"; /*** YOU MODIFY THIS PATH

Fxxf

BEGIN

-- v_BeforePartialString := 'BEFORE'; -- DUMMY for testing
-- v_AfterPartialString := 'AFTER'; -- DUMMY for testing
v_rowcount := -1;

WHILE v_rowcount <> 0

LOOP
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2.

Vv_rowcount := 0;
-- DBMS_OUTPUT.PUT_LINE('"dummy stmt");

UPDATE Centric_file_version c1 SET VaultFullPath =
REPLACE(VaultFullPath,v_BeforePartialString,v_AfterPartialString)

WHERE COALESCE(INSTR(c1.VaultFullPath, v_BeforePartialString),0)> 0 AND rownum <=
10000;

v_rowcount := SQL%ROWCOUNT; DBMS_OUTPUT.PUT_LINE('v_rowcount=" ||
COALESCE(v_rowcount,-88));

v_totrowcount := v_totrowcount + v_rowcount;

END LOOP;

COMMIT;

DBMS_OUTPUT.PUT_LINE('v_totrowcount="|| COALESCE(v_totrowcount,-99));
END;

/

--list

--show errors

Define the Source and Target FileVault Path in the above mentioned code as shown below.

Figure 11-13: Source and Target Filel anlt Path defined in the Code

DECLARE
v_rewcount momber(ll) !
v_Tonrowosust nmmber{il) =

v_BeforeFarcialicring varchard | )} 1= & & Vault pack p fEee P00 HODIFY THIZ PATH ===/
v_hiterfarcialicring wvarchard({ } 1= Srarget Vaslt pat p fEe= FOU0 HODIFY THIS FATH ===/

S BEGIH

v BeforeFartialdtsing = "DEFORL': -- DOMDMY for testing

Under C:, create a directory named OracleBackup.
Save the notepad file under the name filevault.sql.
In the command line prompt execute the following line:

sqlplus csidba/manager@CSIC8 @c:\OracleBackup\filevault.sql

Login to the application and check whether the Export Definition and Export Jobs
are listed properly. (Setup - Services - Export/Import - Export Jobs)

|44 Back TO FLOWCHART
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12. UNINSTALL CENTRIC 8

» How to uninstall Centric 8
1. Select your domain name and log into the domain as Administrator.
2. Close all Windows applications.

3. On the Start menu, navigate to Programs » Centric 8 » Administration and select Uninstall
Centric 8. The Confirm File Deletion dialog box is displayed.

4. To confirm that you wish to uninstall the Centric 8 software, click on Yes.

5. The Remove Programs From Your Computer dialog box is displayed. On completion of the
uninstall process, click on OK.
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PART 1V: APPENDICES

Included inPart IV:

=  Appendix A: Oracle Admin

=  Appendix B: Wildfly Cluster

=  Appendix C: Wildfly Memory Usage

=  Appendix D: Image Upload Timeout

=  Appendix E: Configuring SMTP on Windows 2008
Server

=  Appendix F: Configuring SMTP on Windows 2012
Server

=  Appendix G: Licensing & Administrator Password
Management

=  Appendix H: PDFE Print Service

=  Appendix I: Image Service

=  Appendix J: LDAP Setup

= Appendix K: HTTPS Support

=  Appendix L: Enable HTTP Compression in 11S

=  Appendix M: Change SMTP Server information in
Wildfly

=  Appendix N: Jasper Setup

=  Appendix O: Configure HTTPS
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A. ORACLE ADMINISTRATOR

1. Pre-requisites

= System Admin Privilege

To create and set up an Oracle database for Centric PLM software, the user who is preparing the
database must have System Administration authority over the system and the database to be
created.

= Oracle 11G Software Installed

The Oracle Database 11g Enterprise Edition Release 2 (11.2.0.3+) 64-bit is recommended. The
database hosting system has to meet the minimum hardware requirements specified in the
Oracle database installation guide. To achieve better performance for Centric PLM software, the
Oracle database should be configured on effective and efficient machine.

Before creating an Oracle database to serve Centric PLM, you must have installed the Oracle
database software.

= Database must be created with the AL32UTF8 CHARACTER SET.

Step 9 of Create Centric 8 Database

=  Minimum Required Oracle DB Components

This guide will provide a minimal list to create a database using DBCA or upgrade an existing
database to meet Centric PLM requirement.

= Prior to Centric PLM version 4.9.5, there are only 3 Oracle database components
required to have the software work.

e Oracle Workspace Manager
e Oracle Database Catalog Views
e Oracle Database Packages and Types

e Centric PLM version 4.9.5 will require Oracle XML Database component to successfully
function.

2. Create Oracle Database for 11.2.0.3+

To install Oracle Software, refer Oracle installation software and manual available at
www.oracle.com.

Prior to creating the Centric 8 database, users must verify whether or not RAC and ASM are
installed.

RAC settings do not affect database creation. However, ASM impacts the storage method of
the database. This Guide uses File System for storage.
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» How to create an Oracle Database 11.2.0.3+

1. Go to (File path folder) and run the setup file.

2. The Database Configuration Assistant dialog box is displayed; to start the configuration
process, click on Next.

Figure A - 1: Database Configuration Assistant — Welcome dialog box
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3. In the Database Configuration Assistant, Step 1 of 12: Operations dialog box, select
Create a Database option and click on Next.

Figure A - 2: Database Configuration Assistant, Step 1 of 12: Operations dialog box
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4. In the Database Configuration Assistant, Step 2 of 12: Database Templates dialog box,
select Custom Database option and click on Next.

Note: The following components will not be installed:

= Oracle JVM

= Oracle Text

=  Oracle Multimedia

= Oracle OLAP

= Oracle Spatial

= Enterprise Manager Repository
= Oracle Application Express

= Oracle Warehouse Builder

= Oracle Database Extension for .NET

Figure A - 3: Database Configuration Assistant, Step 2 of 12: Database Tenplates dialog box

B Dbl (g sl bl ad, weg §oall 10 Bl abees §imgla s

Tpraid b Pl oo ol 8PS | DSEp P Pl o ol b B LD e TP 0 e W o o Sy
AEBDELE P FEE b OB B B R B PR 1S TPl el Bl L mP
PR B L™ B e W B e B Da R [AOR DR, el R BT e e
e TR L R

el  Tesapinle Wndhies Dalaliey
e PR v e F # L (3]
1 CLEE YR (]

S Darladn

e Pl | ﬂll] Pl b

5. In the Database Configuration Assistant, Step 3 of 12: Database Identification dialog box,
enter the Oracle Database name (ORACLE_SID) and click on Next.

The Global Database Name can be SID.domain (eg. CSIC8.centricsoftware.com);
s’ this is a Service name.
NOTE
B If you use SID.domain as Global Database Name, the connection URL in the
configuration file should display the service name instead of SID.
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Figure A - 4: Database Configuration Assistant, Step 3 of 12: Database Identification dialog box
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To install the Enterprise Manager, in the Database Configuration Assistant, Step 4 of 12:

Management Options dialog box, select the Configure Enterprise Manager option. Oracle

installs Automatic Maintenance Tasks to self-manage the database.

Oracle Enterprise Manager is Oracle's single, integrated solution for managing all
aspects of the Oracle Grid and the applications running on it. It aids managing

NOTE the database.

If not installed here, you can install the Enterprise Manager later.

Figure A - 5: Database Configuration Assistant, Step 4 of 12: Management Options dialog box
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7. On Automatic Maintenance Tasks tab, select the Enable automatic maintenance tasks

checkbox to enable the tasks.
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Figure A - 6: Database Configuration Assistant, Step 4 of 12: Management Options dialog box
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In the Database Configuration Assistant, Step 5 of 12: Database Credentials dialog box,
select the Use the Same Administrative Password for All Accounts option. Enter details for

the Password and Confirm Password fields. Click on Next.

Figure A - 7: Database Configuration Assistant, Step 5 of 12: Database Credentials dialog box
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In the Database Configuration Assistant, Step 6 of 12: Database File Locations dialog box,
select the Use Database File Locations from Template option and click on Next.
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Figure A - 8: Database Configuration Assistant, Step 6 of 12: Database File Locations dialog box
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10. In the Database Configuration Assistant, Step 7 of 12: Recovery Configuration dialog box,
select the Specify Fast Recovery Area check box and click on Next.

s

NOTE DBCA displays all the default values. You need not provide any values.
|

Figure A - 9: Database Configuration Assistant, Step 7 of 12: Recovery Configuration dialog box
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11. In the Database Configuration Assistant, Step 8 of 12: Database Content dialog box,
uncheck all displayed components as C8 PLM Software requires only Oracle XML DB.

s

NOTE The unchecked components can be installed later.
|

Figure A - 10: Database Configuration Assistant, Step 8 of 12: Database Content dialog box
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12. Click on the Standard Database Components button. In the Standard Database
Components dialog box, select the Oracle XML DB option and click on OK.

&

NOTE De-select all the other components.
|

Figure A - 11: Standard Database Components dialog box
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13. In the Database Configuration Assistant, Step 9 of 12: Initialization Parameters dialog
box, click on the Typical radio button. Select the Use Automatic Memory Management check

box.

NOTE In order for Oracle to performan effectively, provide at least 12G memories.

Figure A - 12: Database Configuration Assistant, Step 9 of 12: Initialization Parameters dialog box
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To view the default values, click on the Sizing tab.

’ Oracle provides 150 Processes as default. Processes parameter value should be
NOTE set according to the size of Web Access Connection pool + 50 for Oracle Server’s
L= house- keeping processes.

Figure A - 13: Database Configuration Assistant, Step 9 of 12: Initialization Parameters dialog box
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14. On the Character Sets tab, select the Use Unicode (AL32UTF8) option. Change other settings
accordingly. Click on All Initialization Parameters button.

Figure A - 14: Database Configuration Assistant, Step 9 of 12: Initialization Parameters dialog box
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15. In the All Initialization Parameters table, change the value of gpen_cursors option to “400” and
processes option to MaxConnectionSize + 50. Click on Close.

Figure A - 15: All Initialization Parameters T able
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16. Since this database is created using file system, it performs better if the Temp data file location

and LOG files are separated from main Data files.
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Increase Log file size and group number will reduce the log switch frequency and wait time for
read consistency.

Default setting:

HD1: SYSTEM, SYSAUX, UNDOTBS, USERS, Control files
HD2: TEMP TBS files, Flash back area

HD3: Log files, future INDEX TBS

HD4: future DATA TBS

17. In the Database Configuration Assistant, Step 10 of 12: Database Storage dialog box,
a. Enlarge TEMP Tablespace by:
e Moving temp file to 2nd HD.

e Increasing temp files for Temporary tablespace. Oracle 64bit default 8k block size has
limitation on file size: up to 32G, therefore add the second temp file and/or third file

to default Temporary tablespace (temp).

Figure A - 16: Database Configuration Assistant, Step 10 of 12: Database Storage dialog box
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b. Increase Redo Log Files by:
= Increasing File size from default 51200K to 512M.

= Moving files location to 3rd HD.

= Increasing file group number from 3 to 6 by clicking on the Create button.
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Figure A - 17: Database Configuration Assistant, Step 10 of 12: Database Storage dialog box
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18. In the Database Configuration Assistant, Step 11 of 12: Creation Options dialog box,
select the Create Database and Save as a Database Template checkbox and click on Finish.

Figure A - 18: Database Configuration Assistant, Step 11 of 12: Creation Options dialog box
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19. To create a database, in the Confirmation dialog box, click on OK.
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Figure A - 19: Confirmation dialog box
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20. The Database Configuration Assistant dialog box is displayed as the database creation is in

progress.

Figure A - 20: Database Configuration Assistant dialog box
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21. On completion of the database creation process, click on Exit.
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Figure A - 21: Database Configuration Assistant - Database creation complete dialog box
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3. Create Oracle Database for 11.2.0.4+

» How to create Oracle Database for 11.2.0.4+

1. Go to the Oracle Setup folder/database and run the Setup.exe file.

. install 1/23/2014 1:51 AM

L. Fesponss 123/2014 1:51 AM

. stage 1/23/2014 1:53 &M
2 |readme 10/22/2013 12:34 AM
setup 10/22/2013 12:31 AM
2 welcome 10/22/2013 12:34 AM

File: Folder

File Folder

File folder

HTML Document
Application
HTML Document

2. In the Oracle Database 11g Release 2 Installer — Installing Database — Step 1 of 11
dialog box, de-select the 1 wish to receive security updates via my oracle support checkbox

and click on Next.
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Figure A - 22: Oracle Database 11g Release 2 Installer— Installing Database — Step 1 of 11 dialog box
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3. To continue installation, click on Yes.

4. In the Oracle Database 11g Release 2 Installer - Installing database — Step 2 of 11 dialog

box, select Skip software updates and click on Next.

Figure A - 23: Oracle Database 11g Release 2 Installer— Installing Database — Step 2 of 11 dialog box
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5. In the Oracle Database 11g Release 2 Installer - Installing database — step 3 of 11 dialog
box, select the Create and configure a database option and click on Next.

ORACLE ADMINISTRATOR

147



Centric 8 INSTALLATION GUIDE

Figure A - 24: Oracle Database 11g Release 2 Installer— Installing Database — Step 3 of 11 dialog box

M= E]
SRACLE q4e

ODATARASE

D ailke Dol sbase 100 Rebeass 7 badtalled - [nslalleng dlal shuise - Seg 3ol 10

Selact Instalistion Optien

St vy of B Il inttel cplions

|
T\w Vot Fpo woand b upgradie an evisting O acis Dabsbeyte U7 5 Fesieace 2 redance soiec] "Uegr sce an evng

v inmbalation. Opeien el o
. i aiafion {aficre. e
Il g BCS AR DNy
g B g da et
g wgect | et L Concal |

6. In the Oracle Database 11g Release 2 Installer - Installing database — Step 4 of 11 dialog
box, select the Server Class option and click on Next.

Figure A - 25: Oracle Database 11g Release 2 Installer— Installing Database — Step 4 of 11 dialog box
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7. In the Oracle Database 11g Release 2 Installer - Installing database — step 5 of 11 dialog
box, select the Single instance database installation option and click on Next.

Figure A - 26: Oracle Database 11g Release 2 Installer— Installing Database — Step 5 of 11 dialog box
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8. In the Oracle Database 11g Release 2 Installer - Installing database — step 6 of 11 dialog
box, select the Advanced Install option and click on Next.

Figure A - 27: Oracle Database 11g Release 2 Installer— Installing Database — Step 6 of 11 dialog box
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9. In the Oracle Database 11g Release 2 Installer - Installing database dialog box,

a. In the Available Languages box, click on a language and then click on the >» arrow button. The
selected language will be displayed in the Select Languages box.

b. Repeat step a, to add one or more Languages.

To continue the installation process, click on Next.

Figure A - 28: Oracle Database 11g Release 2 Installer— Installing Database — Step 7 of 13 dialog box
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10. In the Oracle Database 11g Release 2 Installer - Installing database — step 8 of 13 dialog
box, select the Enterprise Edition option and click on Next.
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Figure A - 29: Oracle Database 11g Release 2 Installer— Installing Database — Step 8 of 13 dialog box
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\ default features have been installed successfully.

11. In the Oracle Database 11g Release 2 Installer - Installing database — step 9 of 13 dialog
box,

a. To accept the default destination folder, click on Next OR
b. To select a different destination folder, click on Browse.

Click on Next.
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Figure A - 30: Oracle Database 11g Release 2 Installer— Installing Database — Step 9 of 13 dialog box
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12. In the Oracle Database 11g Release 2 Installer - Installing database — step 10 of 13
dialog box, select the General purpose/Transaction processing option and click on Next.
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Figure A - 31: Oracle Database 11g Release 2 Installer— Installing Database — Step 10 of 20 dialog box
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13. In the Oracle Database 11g Release 2 Installer - Installing database — step 11 of 20
dialog box, enter the Oracle database name: (ORACLE_SID)

Figure A - 32: Oracle Database 11g Release 2 Installer— Installing Database — Step 11 of 20 dialog box
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o The Global Database Name value has been updated as ‘CSIC8.csi.local’ and the
| SID is automatically updated as CSICS8.

14. In the Oracle Database 11g Release 2 Installer - Installing database — step 12 of 20

dialog box, on the Character sets tab, select the Use Unicode (AL32UTF8) option and click on
Next.

Figure A - 33: Oracle Database 11g Release 2 Installer— Installing Database — Step 12 of 20 dialog box
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15. In the Oracle Database 11g Release 2 Installer - Installing database — step 13 of 20

dialog box, select the Use Oracle Enterprise Manager Database Control for database
management option and click on Next.
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Figure A - 34: Oracle Database 11g Release 2 Installer— Installing Database — Step 13 of 20 dialog box
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16. In the Oracle Database 11g Release 2 Installer - Installing database — step 14 of 20
dialog box,

a. To accept the default destination folder, select the File System radio button and click on Next.
Else, to select a different destination folder, click on Browse.

To continue the installation process, click on Next.
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Figure A - 35: Oracle Database 11g Release 2 Installer— Installing Database — Step 14 of 20 dialog box
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17. In the Oracle Database 11g Release 2 Installer - Installing database — step 15 of 11
dialog box, select the Do not enable automated backups radio button and click on Next.
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Figure A - 36: Oracle Database 11g Release 2 Installer— Installing Database — Step 15 of 20 dialog box
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18. In the Oracle Database 11g Release 2 Installer - Installing database — step 16 of 20
dialog box, select the Use the same password for all accounts radio button. Enter details in

the Password field and click on Next.

| NOTE
“SYSTEM”, “SYSMAN”, “DBSNMP”.

When you choose this option, the same password will be used for “SYS”,
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Orach: Database 1 1g Beleass 2 Inntaller - Installing dat abase
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Figure A - 37: Oracle Database 11g Release 2 Installer— Installing Database — Step 16 of 20 dialog box

19. In the Oracle Database 11g Release 2 Installer - Installing database — step 17 of 20

dialog box, the Installer will check for requirements based on your selection before proceeding
with the installation.
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Figure A - 38: Oracle Database 11g Release 2 Installer— Installing Database — Step 17 of 20 dialog box
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20. In the Oracle Database 11g Release 2 Installer - Installing database step 18 of 20 dialog
box, verify the details. To make changes to the changes to the settings, click on Back. Else, to
continue to the next step, click on Save Response File button.

Figure A - 39: Oracle Database 11g Release 2 Installer— Installing Database — Step 18 of 20 dialog box
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21. To save the db.rsp in the local location for reference, click on the Save button.

Figure A - 40: Save Response File dialog box
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22. The Installation progress is displayed on the screen as shown below:

Figure A - 41: Oracle Database 11g Release 2 Installer— Installing Database — Step 19 of 20 dialog box
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23. The Installation progress is displayed on the screen as shown below:

Figure A - 42: Oracle Database 11g Release 2 Installer — Installing Database — Step 19 of 20 (2) dialog box:
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24. Click on OK.

Figure A - 43: Oracle Database 11g Release 2 Installer— Installing Database — Step 19 of 20 (3) dialog box
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25. Save the Enterprise Manager Database URL and click on Close.

Figure A - 44: Oracle Database 11g Release 2 Installer — Installing Database — Step 20 of 20 dialog box:
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4. Create Centric8 Database by Script

Before installing Centric 8 Database, create an Oracle Instance and ensure that it is up and
running. The ORACLE_SID and ORACLE_HOME variables should exist in the database Server.

The Centric Software database scripts will create Centric 8 Database to serve PLM Server.

= create_reset_db.bat is a major script to be created in Centric 8 Database. It should be
executed by Oracle SYSTEM User.

1. The script will check if the Oracle Instance is created to meet pre-requisites.

2. It will create 4 basic Tablespaces (CENTRICHUB, CFV_DATA, C8_DATA, C8_INDEX) if they do not
exist.

3. It will create user (if the user does not exists) and create schema for Centric 8 Database.

C:\PI\DatabaseScripts>create_reset_db.bat
Usage:

Create_ RESET DB connect_string userid2 password2 ORACLE_DATA DIR1
[ORACLE_DATA_DIR2] [ORACLE_DATA DIR3]
connect_string - Is of format 'uid/pwd@dbname’

uid - User having tablespace and user creation rights. Typically

SYSTEM.

pwd - Password of the user.

dbname - Database/SID where schema will be created. (Eg: CSIHUB)
userid2 - Userid to create as Centric Administrator. (Eg: csidba)
password2 - Password to assign to Centric Administrator. (CSIDBA password)
ORA_DATA DIR1 - Directory for default tablespace files 1! with slash at the end!!!
[ORA_DATA _DIR2] - Directory for secondary storage AND INDEX. OPTIONAL for better
performance
[ORA_DATA_DIR3] - Directory for INDEX. OPTIONAL for better performance

Bl GRRCLE _DSTE_DIHY
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C:\PI\DatabaseScripts>create reset _db.bat system/Manager7@csihub csidba csidba
C:\Oraclellg\oradata\csihub\ E:\Oraclel1g\oradata\csihub\

Creating Centric Hub Database tablespaces and Centric Administrator account.
ECHO is off.

STEP 1: CHECK Database ENV: TBS and USER

ECHO is off.

STEP 2: Clean up Original atabase ENV: TBS and USER csidba csidba
ECHO is off.

STEP 6: Create Tables

ECHO is off.

STEP 7: Create TYPEs

ECHO is off.

STEP 8: Create Views

ECHO is off.

STEP 9: Create Implementation

ECHO is off.

STEP 9: Create Interface

Check the log file Create5.0DB.log for any possible errors.

T Sk Rl s v  ivaiviied Praseged

The C8 Database Installation is completed.

5. Create Centric 8 Database Manually

Before creating the Centric 8 database manually, the following two prerequisites must be
verified:

. NLS_CHARACTERSET must be AL32UTF8.
=  Ensure that the XML DB is installed.
1. Verify NLS_CHARACTERSET

When database instance is created, the NLS _CHARACTERSET should be set as AL32UTF8.
C:\sqglplus / as sysbda

SQL> SELECT value$ FROM sys.props$ WHERE name = 'NLS_CHARACTERSET";
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It should return AL32UTF8.

If the answer is different, the database has to be recreated with appropriate initial
parameters.

Install database instance with proper initial parameter as explained in section Create Oracle
Database.

2. Install XML DB

Oracle XML DB is part of the seed database and is installed by Database Configuration
Assistant (DBCA) by default. No additional steps are required to install Oracle XML DB.

» How to verify that XML DB is installed in the database

1. Login in database as SYS user using SQL Plus.

a. C:\ sqlplus sys/password as §ysdba

b. SQL>select comp_name from dba_registry where comp_name like '%XML%';

COMP_NAME

Oracle XML Database

Indicates XML DB is installed in the database and there is no additional step required.
2. “No rows selected” indicates that the XML database is not installed.
3. To install XML Database,

a. SQL> @?/rdbms/admin/catgm password SYSAUX TEMP YES

e
note  ~dbpwd is the password for xdb. It can be different from the system password. It
| will be a lengthy process.

b. SQL> GRANT EXECUTE ON utl_file TO xdb;
c. SQL> GRANT EXECUTE ON dbms_lob TO xdb;

d. SQL> ALTER SYSTEM SET DISPATCHERS = "(PROTOCOL=TCP)(SERVICE=<SID>XDB)"
SCOPE=both;

4. Use dbms_utility.compile_schema to compile invalid objects if there are any returned rows:

SQL> select distinct owner from all_objects where status="INVALID’;
OWNER

CSIDBA

PUBLIC

SQL> exec dbms_utility.compile_schema('CSIDBA");

SQL> exec dbms__utility.compile_schema('PUBLIC");
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5. Repeat Step 3 till “no rows selected” is no longer displayed.

6. To verify that the XML Database is installed, repeat step 1b (shown below):
SQL> select comp_name from dba_registry where comp_name like '%XML%';
COMP_NAME
Oracle XML Database

7. Create Required Tablespaces: CENTRICHUB, CFV_DATA, C8_DATA, C8_INDEX

a. Use SQL Plus as SYSTEM user to create all tablespaces. For performance reason, separate
CENTRICHUB and C8_INDEX into different devices.

b. Manual Script:
C:\>Sqlplus SYSTEM/Password@SID
SQL> CREATE TABLESPACE $TABLESPACE LOGGING
DATAFILE '$DIRECTORY_FULL_PATH\$TABLESPACE.ora’
SIZE 2000M REUSE AUTOEXTEND ON NEXT 500M
EXTENT MANAGEMENT LOCAL AUTOALLOCATE
SEGMENT SPACE MANAGEMENT AUTO;

¥ 3

.L_NETE Replace $DIRECTORY_FULIL. _PATH and §TABLESPACE

c. Batch File:

C:\PI\DatabaseScripts\Admin>createTS.bat SYSTEM/Manager7 C:\OracleDB\ G:\OracleDB\
H:\OracleDB\

Update Tablespace

Check the log file CREATE_TS.log for any possible errors.
d. Script File:
Use SQL Plus to login database as sys or system.
C:\PI\DatabaseScripts\Admin>sqlplus system/Manager7
SQL> @createTS C:\OracleDB\ G:\OracleDB\ H:\OracleDB\
8. Create Centric 8 Database User (CSIDBA)
a. The CSIDBA must be created using SYSDBA role for granting SYS.DBMS_LOCK privilege.
b. Manual Script

C:\>Sqlplus SYSTEM/Password@SID as SYSDBA
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Type the following commands at the SQL Plus prompt:

CREATE USER CSIDBA PROFILE DEFAULT IDENTIFIED BY CSIDBA DEFAULT
TABLESPACE CENTRICHUB TEMPORARY TABLESPACE TEMP ACCOUNT UNLOCK;
GRANT ALTER SYSTEM TO CSIDBA;

GRANT CREATE PROCEDURE TO CSIDBA;

GRANT CREATE SEQUENCE TO CSIDBA;

GRANT CREATE TABLE TO CSIDBA;

GRANT CREATE TABLESPACE TO CSIDBA;

GRANT CREATE TRIGGER TO CSIDBA;

GRANT CREATE TYPE TO CSIDBA;

GRANT CREATE VIEW TO CSIDBA;

GRANT DROP TABLESPACE TO CSIDBA;

GRANT FORCE ANY TRANSACTION TO CSIDBA;

GRANT SELECT ANY DICTIONARY TO CSIDBA;

GRANT UNLIMITED TABLESPACE TO CSIDBA;

GRANT CONNECT TO CSIDBA;

GRANT RESOURCE TO CSIDBA;

GRANT EXECUTE ON SYS.DBMS LOCK TO CSIDBA;

GRANT EXECUTE ANY PROCEDURE TO CSIDBA;

GRANT debug connect session to CSIDBA;
GRANT debug any procedure to CSIDBA;
c. Batch File

C:\PI\DatabaseScripts\Admin>CreateUser .bat SYSTEM/Password@SID CSIDBA
password

d. Script File
Use SQL Plus to login database as sys or system
C:\PI\DatabaseScripts\Admin>sqlplus system/password@SID as sysdba
SQL> @admin_createuser CSIDBA password
e. Create Database Schema
Database schema should be created as CSIDBA user.
Go to the SQL scripts location as following:
C:\>Sqlplus CSIDBA/password@SID @CreateSchema.sql
C:\>Sqlplus CSIDBA/password@SID @CreateSoftware.sql
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6. Upgrade Centric 8 Database To Current Version

To upgrade the Centric PLM Software to a newer version, initially you need to migrate the
Centric 8 Database to a newer version. Customer requires updating database environment
to meet Centric 8 database prerequisites and run migration scripts to migrate Centric 8
database schema and software without losing data.

» How to upgrade the C8 Database

MigrateToCurrent.bat script provides a single process to migrate Centric 8 database to meet
prerequisites. The script will execute following steps:

1. Export database using data pump before the upgrade process.
= The exported damp file will stored in Oracle provided DATA_ PUMP_DIR directory.

= To verify the directory location:

e SELECT directory_path FROM all_directories

Where directory_name = 'DATA_PUMP_DIR’;
2. Verify NLS_CHARACTERSET parameter is set to be AL32UTF8

= If the requirements are not met with, migration script will be terminated.

= The database must be recreated if it has been created using any other CHARACTERSET
other than AL32UTF8.

3. Verify XML DB component is installed.

= If requirements are not met with, the migration script will be terminated. Users can install
XML DB as per instructions provided in the section How to install XML Database.

4. Create new tablespaces: C8_DATA and C8_INDEX if these tablespaces do not exist.

5. Grant all required privileges.

6. Run Migrate script to migrate schema to current version.

7. Import/Export (Data Dump) Utility for Centric 8 Database

Before running the migration script, ensure that you take a database dump to avoid any
mistakes and data lost. Before exporting data, you should the terminate application server
and disconnect from the database to guarantee data consistency.

Oracle Data Dump utility provides an easy way to restore the database in case of errors that
may occur during the migration process. It is executed on command prompt.

Centric 8 provides ExportC8 and ImportC8 utilities to import and export C8 database.
Details are provided in the Centric 8 Database Utilities section. A typical Setup for Data Dump
is as follows:

ORACLE ADMINISTRATOR 167



Centric 8 INSTALLATION GUIDE

Use Oracle Directories

1. View database directories: Use all_directories to view default directories.

SQL> select directory_name from all_directories;

DIRECTORY_NAME

DMPDIR
XMLDIR DATA_PUMP_DIR
ORACLE_OCM_CONFIG_DIR
2. Create your own directory as SYSTEM user and Grant to CSIDBA:
SQL>CREATE DIRECTORY DMPDIR AS 'F:\C8_DMP*;
SQL>GRANT READ,WRITE ON DIRECTORY DMPDIR TO CSIDBA;

Export Database

1. Expdp/Impdp can be run at local host or remote server command prompt and the dump files
will exist in the Database server directory.

2. Run expdp utility as the SYSTEM user credential. For exporting consistent data, users must use
the FLLASHBACK_TIME parameter

C:\> expdp SYSTEM/password@SID schemas=CSIDBA directory=DMPDIR
dumpfile=EXP052813.DMP logfile=imp.log FLASHBACK_TIME=SYSTIMESTAMP

Import Database

1. Copy the dump file to directory before to be imported.

2. Drop CSIDBA user. Make sure there are no CSIDBA users connecting to database.
C:\>Sqlplus system/password@SID
SQL=> drop user CSIDBA cascade;
Recreate the schema user.

4. Create the cf_safeToNumber and safeToBoolean functions as CSIDBA user.
C:\>Sqlplus CSIDBA/password@SID
CREATE OR REPLACE
FUNCTION cf_safeToNumber

( str VARCHAR2

)

RETURN NUMBER DETERMINISTIC
AS

num NUMBER(37,10);
BEGIN
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num := CASE WHEN INSTR(str, 'E', 1, 1) > 0 THEN TO_NUMBER(str,
'90.99999999999999999EEEE") ELSE TO_NUMBER(str,
'99999999999999999999.99999999999999999999")END;

RETURN num;
EXCEPTION
WHEN OTHERS THEN
RETURN NULL;
END;
/
CREATE OR REPLACE
FUNCTION cf_safeToBoolean
( str VARCHAR2

)
RETURN NUMBER DETERMINISTIC
AS
BEGIN
RETURN
CASE
WHEN str = ‘true' THEN 1
WHEN str = ‘false’ THEN O
ELSE NULL
END

END cf_safeToBoolean;
/
5. Run impdp utility as the SYSTEM user credential.

C:\> impdp SYSTEM/password@SID schemas=CSIDBA directory=DMPDIR
dumpfile=EXP052813.DMP logfile=exp.log

6. Clean up import errors: recreate IX_AVE_BOOLEAN ON index and recompile procedures.
C:\>Sqlplus CSIDBA/password@SID
SQL> DROP INDEX IX_AVE_BOOLEAN;
SQL> CREATE INDEX IX_AVE_BOOLEAN ON ATTRIBUTE_VARIANT_ELEMENT
(ValueBoolean) TABLESPACE C8_index;
SQL> exec dbms_utility.compile_schema('CSIDBA");

7. Run UpdateSequence.sql script to fix any possible sequences out of sync issues.
C:\>Sqlplus CSIDBA/password@SID @$PTAH/utility/updateSequence.sql

8. Run validateData.sql script to fix any possible data out of sync issues.

C:\>Sqlplus CSIDBA/password@SID @$PTAH/utility/validateData.sql
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Transfer data between schemas (REMAP_SCHEMA):

CSIDBA schema can be transferred to other Users through Oracle Data Pump import process.

1. Copy the dump file to directory before to be imported.

2. Create the new schema user (ex. NEWUSER) to import to.

3. Create the cf_safeToNumber and safeToBoolean functions as NEWUSER user.

C:\>Sqlplus NEWUSER/password@SID
CREATE OR REPLACE
FUNCTION cf_safeToNumber

( str VARCHAR?2

)

RETURN NUMBER DETERMINISTIC
AS

num NUMBER(37,10);
BEGIN

num := CASE WHEN INSTR(str, 'E', 1, 1) > 0 THEN TO_NUMBER(str,

'90.99999999999999999EEEE") ELSE TO_NUMBER(str,
'99999999999999999999.99999999999999999999") END;

RETURN num;
EXCEPTION

WHEN OTHERS THEN

RETURN NULL;
END;
/
CREATE OR REPLACE
FUNCTION cf_safeToBoolean
( str VARCHAR?2
)
RETURN NUMBER DETERMINISTIC AS
BEGIN

RETURN

CASE
WHEN str = "true' THEN 1
WHEN str = ‘false' THEN O
ELSE NULL
END

END cf_safeToBoolean;
/
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4. Run impdp utility as the SYSTEM user credential. Require REMAP_SCHEMA keyword

C:\> impdp SYSTEM/password@SID schemas=CSIDBA directory=DMPDIR
REMAP_SCHEMA=CSIDBA:NEWUSER dumpfile=EXP052813.DMP logfile=imp.log

5. Recreate virtual columns for ATTRIBUTE_VARIANT_ELEMENT table

C:\>Sqlplus NEWUSER/password@SID @updateAVE.sql

OR

Type the following commands at the SQL Plus prompt:

ALTER TABLE ATTRIBUTE_VARIANT_ELEMENT drop (VALUENUMBER, VALUEBOOLEAN);
ALTER TABLE ATTRIBUTE_VARIANT_ELEMENT ADD (VALUENUMBER

NUMBER(37,10) AS (cf_safeToNumber(ValueString)));

ALTER TABLE ATTRIBUTE_VARIANT_ELEMENT ADD (VALUEBOOLEAN

NUMBER(1,0) AS (cf_safeToBoolean(ValueString)));

CREATE INDEX IX_AVE_BOOLEAN ON ATTRIBUTE_VARIANT_ELEMENT

(ValueBoolean)

TABLESPACE C8_index;

6. Execute DropSoftware.sql and CreateSoftware.sql scripts to create Objects and Types not created
via impdp.

C:\>Sqlplus NEWUSER/password@SID @DropSoftware.sql
C:\>Sqlplus NEWUSER/password@SID @CreateSoftware.sql

7. Recompile procedures and gather statistics for NEWUSER user by executing following commands
as SYSTEM user:

exec dbms__utility.compile_schema(‘NEWUSER");
exec dbms_stats.gather_schema_stats('NEWUSER");

8. Run UpdateSequence.sql script to fix any possible - sequences not in sync - issues.

C:\>Sqlplus NEWUSER/password@SID @$PTAH/utility/updateSequence.sql

9. Run validateData.sql script to fix any possible - data out of sync - issues.

C:\>Sqlplus CSIDBA/password@SID @$PTAH/utility/validateData.sql
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8. Centric 8 Database Utilities

ExportC8.bat

ExportC8 script uses Oracle Data Pump expdp utility to export C8 database to an Oracle
directory with an export user default dmp file name.

Usage

ExportC8 ORACLE_SID systempassword Userid DirectoryName

ORACLE_SID Database/SID where schema created.
(Eg.: CSIHUB)

S J/ﬂ‘e‘ﬁgﬁﬂﬁward Oracle SYSTEM user's password

UserlD Userid to create as Centric Administrator.
(Eg.: csidba)

DirectoryName Oracle Directory Name to store the export file.

(Eg.: DATA PUMP_DIR)

Result

A Data PUMP dump file (EXP_CSIDBA_MMDDYYHH.DMP) will be stored in DATA_PUMP_DIR
directory.

#

NOTE  DirectoryName is the directory name stored in All_Directories table.
|

ImportC8.bat

ImportC8 script uses Oracle Data Pump impdp utility to import a C8 database from a User’s
dmp file.

Usage

ImportC8 ORACLE_SID systempassword Userid Password DirectoryName DumpFileName

ORACLE_SID Database/SID where schema created.
(Eg.: CSIHUB)
S J/ﬂ‘e‘ﬁgﬁﬂﬁward Oracle SYSTEM user's password
UserPassword Password for Centric Administrator
DirectoryName Oracle Directory Name to store the import file.
(Eg.: DATA _PUMP_DIR)
Dﬂmsz'/eNgme Oracle Dump file to be imported into database.
P

NOTE Import C8 only supports same username import.
|
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Rebuildldx.sql

Rebuildldx.sql is an SQL script which will rebuild indexes online. It should be executed by the
Centric Administrator (CSIDBA).

Usage

SQLPIus CSIDBA/password @rebuildldx.sql

UpdateSequence.sql

UpdateSequence.sgl is an SQL script which will update all sequences used by Centric
Administrator (CSIDBA) to sync the sequences number to avoid primary key non- unique
constraint violation.

Usage

SQLPlus CSIDBA/password @ updateSequence.sql

9. Tuning Consideration

C8 Import/Export Integration Process

Avoid running both these activities during peak hour. Exporting process should setup the
process to export data to a different database which also is better located in a different
server.

Online Redo Log consideration

Centric PLM software is an online transaction oriented application which actively modifies
data. A few guidelines are available for configuring the redo log file.

Log file size

Oracle database default file size is 52MB. C8 recommends enlarging file size to 200MB at
first.

= Log file member: Oracle database default member number is 3. C8 recommends
increasing member number to 12 first.

= Log file location: It will be the best to move all log files to an isolated location to reduce
10 contention.

= (C8 exporting process should export data to different database.

After the modification, verify the alert log to check whether or not the setting is proper. The
checking period should be during the C8 usage peak time but exclude the import/export
process.

=  “Checkpoint not complete” should not exist. When the messages appear, increase log file
member.

= Log switch frequency should be under 10 times per hour. To reduce the log switch
frequency, the log file size should be increased.
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B. WILDFLY CLUSTER

1. Requirements

Itis recommended to contact Centric before proceeding with the Wildfly Cluster Setup.
1. Filevault folder must be shared between clustered Wildfly Application servers.

2. WebAccess folder must be shared between clustered Wildfly Application servers. Both Read and
Write permissions must be enabled on shared WebAccess folder.

3. The following Ports must be open between clustered Application servers:

TCP
= 7700
= 8009
= 57700

4. To open TCP ports, refer Open TCP Ports on Windows Firewall.

5. To set up SQL Environment, refer Setup SQL Database Server.

6. To set up Oracle Environment, refer Setup Oracle Database Server.
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2. Environment Setup

The picture in the following page depicts a typical Wildfly Cluster Setup.

Figure (Appendix B) - 1: A typical Wildfly Cluster Setup
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Open TCP Ports on Windows Firewall

1. On the Start menu, select Administrator Tools » Windows Firewall » Advanced Security
option.
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Figure (Appendix B) - 2: Administrator Tools nenn
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2. In the Windows Firewall with Advanced Security dialog box, click on Inbound Rules on the
left side. Then, on the right-side, under Actions, click on New Rule.

Figure (Appendix B) - 3: New Rule
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3. In the New Inbound Rule Wizard dialog box, click on the Port radio button. Click on Next.

Figure (Appendix B) - 4: New Inbound Rule Wigard
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4. In the Protocol and Ports window, click on the TCP and Specific local ports radio button and
then click on Next.
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Figure (Appendix B) - 5: Inbound Rule Wizard (2)
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5. In the Action window, click on Allow the connection radio button and click on Next.

Figure (Appendix B) - 6: Inbound Rule Wizard (3)
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6. In the Profile window, select all the check boxes and click on Next.

Figure (Appendix B) - 7: Inbound Rule Wizard (4)
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7. In the Name window, type Wildfly Cluster TCP Ports and click on Finish.

Figure (Appendix B) - 8: Inbound Rule Wizard (6)
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8. Click on Outbound Rules and repeat steps 3 - 7.
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Figure (Appendix B) - 9: Windows Firewall with Advanced Security
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Setup SQL Database Server

1. Run C8 server Installer, choose to install Database only option, create new database options.
2. Click on Finish to complete the installation.

Refer Chapter 4, Dual Server Software Installation and Computer 2 Installation

3. On the Start menu, select Programs » Microsoft SQL Server 2008 R2 » SQL Server
Management Studio. The Connect to Server dialog box is displayed.

Figure (Appendix B) - 10: Connect to Server
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Click on Connect
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4. In the Object Explorer window, connect to the correct C8 database and open Query window.

Type the following script and click on Execute
IF OBJECT_ID(‘dbo.JGroup_Ping’) IS NOT NULL
DROP TABLE dbo.JGroup_Ping;
GO
-- SQL Server equivalent
CREATE TABLE dbo.JGroup_Ping
( Own_Address VARCHAR(200) NOT NULL
, Cluster_Name VARCHAR(200) NOT NULL
, Ping_Data VARBINARY(MAX) NULL
CONSTRAINT PK_JGroup_Ping PRIMARY KEY CLUSTERED(Own_Address, Cluster_Name)
) ON [PRIMARYT];
Figure (Appendix B) - 11: SOL Query Window
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Setup Oracle Database Server

1. Run C8 server Installer, choose to install Database only option, create new database options.
2. To complete installation, click on Finish.

Refer DUAL SERVER SOFTWARE INSTALLATION page 40 and Computer 2 Installation on page 54

3. Open Oracle developer.
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Figure (Appendix B) - 12: Oracle Developer window
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4. From the Database dropdown list, select the appropriate Database and enter the User/Schema
and Password.

5. Click on Connect to Centric 8 PLM database and open Query window.
6. Type the following script and click on Execute.

CREATE TABLE JGroup_Ping

( Own_Address VARCHAR(200) NOT NULL

, Cluster_Name VARCHAR(200) NOT NULL

, Ping_Data LONG RAW DEFAULT NULL

);

ALTER TABLE JGroup_Ping ADD CONSTRAINT PK_JGroup_Ping PRIMARY KEY (Own_Address,
Cluster_Name)

USING INDEX TABLESPACE C8_index;
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Figure (Appendix B) - 13: Query Window
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Setup Cluster Appl

Run C8 Server Installer, choose to install Wildfly, remote database, and enter Filevault.

For WebAccess shared folder path installation refer WebAccess Shared Directory Installation on
page 185.

To complete installation, click on Finish.

To update Wildfly Settings for Shared WebAccess refer WebAccess Wildfly Settings

To update WebAccess folder path in 1IS Settings refer WebAccess 1IS Settings. Mention the
server credentials of the server that holds the WebAccess shared folder.

» How to verify WebAccess Shared Directory installation

1. Open standalone-pi-db-ha-tcp.xml file (can be located in:..\C8\ wildfly-
8.1.0\ standalone\configuration folder) in notepad.
#
NOTE In the file name, “db” refers to mssqgl or oracle depending upon the
| 3 database used
2. Verify that the shared WebAccess folder path is updated here:
com.centricsoftware. AppServer.WebAccessLocalPath = SHARED WEBACCESS_FOLDER _PATH
com.centricsoftware. AppServer.NavigationFile =
SHARED_WEBACCESS_FOLDER_PATH\\Scripts\ \ Navigation.xml
3. For example, if Shared WebAccess Folder path is \\LLB-APP03\WebAccess, then it will be updated
as \\\\LB-APP03\\WebAccess.
4. Run C8 Applications Installer, select Centric 8 and the optional modules. To complete installation,
click on Finish.
5. Login to C8.
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NOTE Verify that the Login is successful.

-

Refer DUAL SERVER SOFTWARE INSTALLATION: Computer 2 Installation on page 54.

Enable / Disable Services

4,

In Notepad, open standalone-pi-mssql-ha-tcp.xml (for SQL Database) or standalone-pi-oracle-ha-
tep.xml (for Oracle Database) located in ..\C8\wildfly-8.1.0\standalone\ configuration folder.

Look for the following lines:

<service name="RollupService" class='com.centricsoftware.pi.service.rollup.RollupService’
active="true'>

<dependency name="com.centricsoftware.pi.Registration"/>

</service>

<service name="JobService" class='com.centricsoftware.pi.service.job.JobService' active="true'>
<Dependency name="com.centricsoftware.pi.Registration"/>

</service>

If you want to disable the service, on the service line, change ‘true’ to ‘false’.

Save and close the file.

Enable Wildfly Clustering in Wildfly Service

1.
2.

4,

In Notepad, open Standalone.conf.bat (located in..\C8\wildfly-8.1.0\bin folder).
Look for the following lines:

set "JAVA_OPTS=%JAVA_OPTS% -Dwildfly.server.default.config=standalone-pi- oracle.xml"

Change standalone-pi-oracle.xml to standalone-pi-oracle-ha-tcp.xml for oracle database. In case you
are using SQL database, change it to standalone-pi-mssql-ha-tcp.xml file.

Save and close the file.

Setup Cluster App2

1.
2.

Run C8 Server Installer, choose to install Wildfly, remote database, and enter Filevault.

For WebAccess shared folder path installation refer WebAccess Shared Directory Installation on
page 185.

To complete installation, click on Finish.

To update Wildfly Settings for Shared WebAccess refer WebAccess Wildfly Settings

To update WebAccess folder path in 1IS Settings refer WebAccess IIS Settings. Mention the
server credentials of the server that holds the WebAccess shared folder.

» How to verify WebAccess Shared Directory Installation

1.

In Notepad, open standalone-pi-db-ha-tcp.xml file (located in..\ C8\wildfly-
8.1.0\standalone\configuration folder).
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2. Verify that the shared WebAccess folder path is updated here:

com.centricsoftware. AppServer.WebAccessLocalPath = SHARED_WEBACCESS_FOLDER_PATH
com.centricsoftware. AppServer.NavigationFile =
SHARED_WEBACCESS_FOLDER_PATH\\Scripts\ \ Navigation.xml

For example, if Shared WebAccess Folder path is \\ LB-APP03\WebAccess, then it will be updated
as \\\\LB-APP03\\WebAccess

3. Save and close the file.

Enable / Disable Services

1. In Notepad, open standalone-pi-mssql-ha-tcp.xml (for SQL Database) or standalone-pi-oracle-ha-
tep.xml (for Oracle Database) located in..\ C8\wildfly-8.1.0\standalone\ configuration folder.

2. Look for the following lines:

<service name="RollupService" class='com.centricsoftware.pi.service.rollup.RollupService’
active="true'>

<dependency name="com.centricsoftware.pi.Registration"/>
</service>

<service name="JobService" class='com.centricsoftware.pi.service.job.JobService’
active="true'>

<dependency name="com.centricsoftware.pi.Registration"/>
</service>
If you want to disable the service, on the service line, change ‘true’ to ‘false’.

4. Save and close the file.
Enable Wildfly Clustering in Wildfly Service

1. In Notepad, open Standalone.conf.bat (located in..\C8\wildfly-8.1.0\bin folder).
2. Look for the following lines:

Set "JAVA_OPTS=%JAVA_OPTS% -Dwildfly.server.default.config=standalone-pi- oracle.xml"

3. Change standalone-pi-oracle.xml to standalone-pi-oracle-ha-tcp.xml for oracle database. If you are
using SQL database, change it to standalone-pi-mssql-ha-tcp.xml file.

4. Save and close the file.

Start Wildfly on Cluster App 1

1. Ensure that Wildfly started successfully.
2. Check for errors in the pi_centric.log file.

3. Wait for Centric Initialization Completed message to be displayed.

Start Wildfly on Cluster App 2

1. Ensure that Wildfly started successfully.

2. Check for errors in the pi_centric.log file.
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3. Wait for Centric Initialization Completed message to be displayed.

Configure Load Balancer

1. Setup Load Balancer URL.

2. Configure load balancer settings to redirect requests between Cluster App servers.

Login to Centric 8 using Load Balancer URL

1. Ensure that the login is successful.

Setup Print and Image Service on any Cluster APP servers

Use local machine name for Print and Image service configuration.
Ensure that the following is used:

1. Load Balancer URL in Server URL parameter
2. Cluster all server name in Service Name parameter.
3. Shared folder for Output parameter.

Refer PDF Print Service Guide and Image Service Install Guide documents.

WebAccess Shared Directory Installation

Pre-requisites
1. Create a WebAccess shared folder.

2. Ensure that the server in which the shared directory is created is able to communicate with the
server in which the C8 application is going to be installed.

e Use the ping command to test the communication between the two
| servers.

3. Make sure the Directory is accessible by typing //servername/WebAccess in Run. Also, ensure
that you have full rights to that shared folder.
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Figure (Appendix B) - 14.: Choose WebAccess Location
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4. To select a different destination folder, click on Browse.

5. Enter the shared folder path\\server-name\WebAccess

WebAccess Wildfly Settings

e Once the installation is completed, ensure that the WebAcces
| contents are visible in the shared directory.

1. Select Start » Administrative tools » Services.
2. In the Services window, right click on Centric Wildfly 8.1.0 Service and select Properties.

3. In the Centric Wildfly 8.1.0 Services Properties dialog box, on the Log On tab, in the Log on
as section, click on this account.

4. Click on Browse and locate the Administrator who performed the installation on this machine.

5. In the Centric Wildfly 8.1.0 Service Properties dialog box, enter details in the Password and
Confirm Password fields. To close the dialog box, click on OK.

6. The Service dialog box is displayed with a confirmation message stating that the user is granted

the Log on as a service right. Click on OK.

WebAccess 11S Settings

1. Select Start » Administrative tools » Internet Information Services (11S) Manager.
2. Expand Servername » Sites » Default website.

3. Under Default Website, right-click on WebAccess and select Manage Virtual Directory »
Advance Settings.

4. Under the Physical Path, change the existing directory path to the shared directory \\server-
name\ WebAccess.
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5. Under Physical Path Credentials:

= Select Specific user and click on Set

= Under user name, enter with the user account who has permission to see the network
shared folder.

= In the password field, enter the password for the user mentioned above.
= Re-enter the password and click on OK.

6. Restart IIS.

3. Cache Mechanism

C8 uses Wildfly standard cache mechanism. In cluster node, when a piece of information is
updated on one Wildfly node, all other nodes must be informed of that modification to update
their local cache. This communication is configured using tcp protocol.

This protocol guarantees that communication is made between all nodes. In case of failure,
a new try will happen until correct information is sent from one node and all the other nodes
receive it.

Issues with the cache mechanism

It may happen that after a long period of execution (months), one cluster node does not
synchronize anymore with the other nodes. This can be detected by users, depending on
different information displayed on the cluster node they are redirected to. A lot of NAKACK
(Negative Acknowledgements) warning messages can be viewed as Cache is not 100%
reliable. Restarting one node does not fix the issue. The issue can be fixed only with a full
C8 restart.

Reset Cache

» To reset cache with a full C8 restart
Stop all Wildfly Services.

Stop all additional services (image services, PDF services).

1
2
3. Ensure wildfly cluster configuration files are all set as expected.
4. Start Wildfly services.

5

Start all additional services (image services, PDF services).

On completion of the above step, cache will behave as expected.
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Cache test process

&

NOTE
|

It is assumed here that there are 3 nodes in the cluster, but the
process can apply to any number of nodes.

P WM

“

9.

On AppServerl, login to Centric 8 using localhost/WebAccess URL.

Navigate to Home P Documents tab; create new document.

On AppServer2, login to PLM using localhost/WebAccess URL.

Navigate to Home » Documents tab; ensure that the document created on AppServerl can be
viewed.

On AppServer3, login to PLM using localhost/WebAccess URL.

Go to Home » Documents tab; ensure that the document created on AppServerl can be

viewed.

Change document name from AppServer3 app server.

Navigate to AppServerl and AppServer2 and verify that you can see the updated document

name.

Change the document name from AppServer2 app server.

10. Verify that the document name is updated on other app servers.

In case the document is not visible on other nodes, or the document name is not up to date
on other nodes, it indicates that the cache is not working properly.

It is therefore important to check the following:

1
2
3.
4

Verify that emptying the browser cache on each server works properly.

Page refresh gives expected results.

Verify the cluster configuration files are set properly.

Ensure that no other cluster can interfere.

O

S
IMPORTANT

If any of the points listed above are not verified, there is a chance

that cache is not working properly. You must then contact Support.
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C. WILDFLY MEMORY USAGE

1. Changing Wildfly Usage
You can change the Wildfly usage in Centric 8 by changing the standalone.conf.bat file located
in your Centric 8 program folder on your system.

» To change the standalone.conf.bat file

1. In Notepad, open the standalone.conf.bat file. The file is located in your installation directory in the
following location: <Centric8InstallDirectory>\C8\wildfly-8.1.0\bin

2. Search for the following string in the standalone.conf.bat file:

rem JVM memory allocation pool parameters. Modify as appropriate. set "JAVA_OPTS=-Xms512M
-Xmx2048M -XX:MaxPermSize=512M"

Where Xms is the minimum memory requirement for Wildfly service, and Xmx is the maximum
memory requirement for Wildfly service. The value of Xmx should not exceed half of the physical
RAM. For example, if you have a 32GB machine, the Xmx maximum value is 16GB.

3. Update the Xmx value to change the Wildfly usage.
4. Save and close the standalone.conf.bat file.

5. Restart the Wildfly service.

2. Troubleshoot Wildfly Service

Wildfly is the application server used in Centric 8. When you start the Wildfly service, batch
files run in the background. You must allow this processing to complete before taking any
additional action on the server. If you stop the Wildfly service before the batch files finish
running, the batch files are suspended; the Wildfly service cannot start until the batch files
finish running.

Java Memory Error

If you are unable to log into Centric 8, java may have run out of memory. Open the
pi_centric.log file and look for the following error message:

java.lang.OutOfMemoryError

Each business object has an associated java class. These classes are stored in java
permanent heap memory. By default this value is set to a maximum value of 64MB. Because
there are numerous java classes, this memory may run out.

To avoid this error, you can increase the java permanent heap memory settings using the
Wildfly standalone.conf.bat file:

1. Select Start » Programs » Administrative Tools » Services.

2. Right-click on Centric Wildfly-8.1.0 Service and select Stop.
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3. In Notepad, open the standalone.conf.bat file. The file is located in your installation directory in the
following location: <Centric8InstallDirectory>\C8\wildfly-8.1.0\bin

4. Search for the following string in the standalone.conf.bat file:

rem JVM memory allocation pool parameters. Modify as appropriate. set "JAVA_OPTS=-Xms512M
-Xmx2048M -XX:MaxPermSize=512M"

The parameter is already set to “-XX:MaxPermSize=512m" so that this line of code appears as:
set "JAVA_OPTS=-Xms512M -Xmx2048M -XX:MaxPermSize=512M"

5. Save and close the standalone.conf.bat file.

6. Restart the Wildfly service.

Wildfly Service Warning

During installation, if you encounter the following warning message when you attempt to
start the Wildfly service, Wildfly service is likely suspended and you must stop the batch files
and restart the Wildfly service.

Figure (Appendix C) - 1: Services dialog box
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To stop the suspended batch files:

1. Open the Task Manager on the server where you are installing or upgrading the Centric 8
server.

2. In the Task Manager, click on the Processes tab.

3. Locate and select Java.exe.

4. Click End Process. In the Task Manager Warning dialog box, click on Yes.
5

Close the Task Manager.

Batch File Suspension

To avoid forcing the Java.exe file to end using the Task Manager, once you start the Wildfly
service, do not attempt to stop the service during processing.
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The Service Control progress window is displayed (as shown below) until processing is
complete:

Figure (Appendix C) - 2: Service Control Window

Service Conkrol |
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Always allow the service to start and stop without interference, allowing a few extra moments
for the batch files to finish any additional background processing once the Service Control
window no longer displays.

Wildfly Failure to Stop

If you attempt to stop the Wildfly service in the Services window, the following warning
message is displayed:

Figure (Appendix C) - 3: Services window
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This warning message indicates that the Wildfly service has timed out which may due to one
of the following reasons:

= Centric 8 was partially uninstalled, or the uninstaller froze midway through the process;
Use the Task Manager to end this process, and then stop the Wildfly service.

= You attempted to close the Services window before Wildfly stopped the service. Use the
Task Manager to end the Java.exe process as described in the section, Wildfly Service

Warning.
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D. LARGE FILE UPLOAD TIMEOUT

1. 1IS Connection Settings

If users uploading large files are experiencing connection timeout, you can adjust the Internet
Information Service (11S) connection settings to accommodate large file size and slow
network connection speed.

Use the following steps to adjust the 11S connection settings:

#

NOTE These steps can be used to adjust the IIS connections settings on

Windows Server 2003 (11S6), 2008(11S7) and 2012(11S8).

P W N~

bl

N

On the Centric 8 application server open 11S Manager.
In the left pane, expand the local computer and expand Web Sites.
Under Web Sites, right-click on the Default Web Site and select Properties.

In the Properties dialog box, in the Connections section, enter the maximum number of
seconds for which IIS should maintain an idle connection before resetting in the Connection
timeout field; the default value is 120 seconds.

Click on OK.
Click the Action menu and select Refresh. Close the IIS Manager.
Once you update the connection settings, adjust the maximum content length:

=  Adjust Content Length for 11S7 and 11S8

2. Adjust Content Length for 11IS7 and 11S8

1
2
3.
4
5

6.

On the Centric 8 application server open IIS Manager.

In the left pane, expand the local computer and expand Web Sites.
Under Web Sites, select Default Website.

Open feature on Request Filtering.

Click on Edit Feature Settings and modify the field Maximum allowed content length to a
value of ‘500000000'.

Restart 1IS and close IIS Manager.

Increase Max Post Limit in Wildfly

This setup is common for both 11S7 and 11S8.
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» How to increase Max Post Limit in Wildfly

1.

Navigate to C:/ Program Files » Centric Software » C8 » wildfly-8.1.0 » Standalone »

Configuration.
If you are using a MSSQL database,
»  Click on Standalone-pi-mssql.xml.

Figure (Appendix D) - 1: Standalone-pi-mssql.scml file
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= In the max-post-size parameter, type the maximum size as required (see figure below).

Figure (Appendix D) - 2: max-post-size parameter details

- <Core-environments
<process-id>
<uuid/ >
< /process-id>
<fcore-envirgnment:
<recovery-environment status-sockat-binding ="txn-status-manager” socket-binding="1
< fsubsystam>
- zsubsystem xmins="urn:jboss:demain:undertow:1.1">
=buffer-cache name="dafault™/=
- <aerver name="default-server >
<http-listener name="http" socket-binding="http" max-post-size="TILLEFLINR"/ >

<ajp-listener name="ajp" socket-binding="ajp" max-post-size="104857600"/>

Else, if you are using an Oracle database,
* Click on Standalone-pi-oracle.xml.

Figure (Appendix D) - 3: Standalone-pi-oracle.xnl file
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e © | Dt ot | rype San

b certficates 2015 &:10 AM Fie Folder

L. standalone-pi-mssal_aml_histoey' 712015 10:43 P File Folder
T | appbcation-roles. properties 015 6:10 AM FROPERTIES File L ¥R
2| sppheation-users properties TS L110AM  PROPERTIES Fle 18
| Emporter .oy GMIOMRDIS 2:13 P 5V File (e
T | kogang . progerteed TN 0156:15 M PROPERTIES Fila 9K
= | mgmit-groups. properties: F132015 6110 AM PROPERTIES File 18
= | AT S, D oDt RIS 610 AM PROPERTIES Fily P )
T | pi-configuration. properties. 2015 6:19 AM PROPERTIES File 1208
7| pinitisipesmissions. propesties S/ZI[2015 1056 PM PROPERTIES Fle Zi8
2 | pi-widly-8. 1,0, properties T 015611 AM PROPERTIES Fily 3B
%] standabone. TMYZ0ISH104M XML Document e
= stanhadone-fil TS EN0AM N Dooument 518
= sarvialonam-ful-haonl 015 6:10 AM ML Do Z0VB
= standalone-ha.oml 2015 &:10 AM ML Document 38
= standalone-pi-msa aml TNIR0IS &1 AM ML Doy, e
= | sandalone-pi-fssg-ha, ol TIZI201512:23 AM ML Dxirreand 26 KB
% standslone-pr-mssg-ha-topaosl 132015 E:111 AM ML Documenk 260D
= | standalone-pi-or acle-ha, sl FEf2045 12:23 AM ML Document 26 B

= In the max-post-size parameter, type the maximum size, as required.
Figure (Appendix D) - 4: max-post-size parameter
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4. Restart Wildfly Services.

5. Navigate to Start » Services. Right-click on Centric Wildfly — 8.1.0 Service.

Figure (Appendix D) - 5: Services Window
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6. To restart Wildfly Services, click on Restart.
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[IS Connection Timeout (for 11S7 and 11S8)

Requests by Centric 8 server that last longer than the set limit will be automatically
terminated. You need to increase the set limit in environments that use large files and/or
have slower network speeds. The default value is set to 120 seconds.

1. To open the 1IS Manager, from the Start menu, select Administrative Tools » Internet

Information Services (11S) Manager.

2. Expand the Connections tree and select Sites » Default Web Site.

Figure (Appendix D) - 6: Connections tree
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3. Right-click on the Default Web Site and select Manage Web Site » Advance Settings.

Figure (Appendix D) - 7: Connections tree - Adpanced S ettings
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4. In the Advance Settings dialog box, under the Behavior section, expand Connection Limits.
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Figure (Appendix D) - 8: Advanced S ettings
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5. Update the value for Connection Time-out (seconds) to 900 and click on OK.

6. To restart the Web Site through 11S Manager, click on Restart.
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[IS Maximum Allowed Content Length (for 11S7 and 11S8)

Requests by Centric 8 server that last longer than the set limit will be automatically
terminated. You need to increase this value in environments that use large files. The default
value is 30000000 bytes (about 28.6 MB).

1. From the Start menu, right-click on the Command Prompt and select Run as Administrator.
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Figure (Appendix D) - 9: Start Menu
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2. In the Command Prompt dialog box, go to the C:\Windows\system32\inetstv directory.
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3. Run the following command:

appcmd set config -section:requestFiltering -
requestLimits.maxAllowedContentLength:500000000

Figure (Appendix D) - 10: Command Prompt

= Administrator: Command Prompt - 8 n

appemd zat config —sectionzvequestFiltering —reques
: S EARAARFAR

This example sets a limit of 500000000 bytes (about 477MB). Adjust the value as per the
requirement.

4. From the Start menu, select Administrative Tools » Services.
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Figure (Appendix D) - 11: Start Menn
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5. To restart 1IS, right-click on 11S Admin Service and select Restart.

Figure (Appendix D) - 12: Restart 11S Admin Service
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E. CONFIGURING SMTP ON WINDOWS 2008
SERVER

1. Configuring SMTP Server with IIS 6.0 Manager

If you are using the recommended 64-bit operating system with Windows 2008 server, and
Microsoft 11S Web Server version 6.0, you must configure the SMTP Server.

This appendix describes how to complete the SMTP Server configuration on Windows 2008
using the following steps:

= Step 1: Install SMTP Server Service

= Step 2: Install 1I1S 6.0 Manager

=  Step 3: Configure SMTP with 1I1S 6.0 Manager

= Step 4: Configure Centric 8 SMTP Server Properties

Step 1: Install SMTP Server Service

» Toinstall the SMTP Server service OR to verify that it is already installed

1. Locate and start the Windows Server Manager application. From the Start menu, select
Programs » Administrative Tools » Server Manager.

2. In the Server Manager window, in the left pane, click on Features; the Features list is
displayed in the right pane, as shown in the figure below:

Figure (Appendix E) - 1: Server Manager Window
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3. In the Features list, if the SMTP Server is displayed, it indicates that the SMTP Server Service is
installed; proceed to Step 2: Install 1IS 6.0 Manager

ELSE, continue with step 4 below.

4. In the right pane, click on Add Features; the Add Features Wizard is displayed.

5. In the Features list, to turn the SMTP Server on, select the SMTP Server checkbox.

Figure (Appendix E) - 2: Add Features Wizard — Select Features
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6. To continue, click on Next.

7. In the Add features required for SMTP Server? Dialog box, click on the Add Required
Features button,

Figure (Appendix E) - 3: Add Features Wizard (2)
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8. In the Add Features Wizard - Confirm Installation Selections dialog box, click on the
Install button,

Figure (Appendix E) - 4: Add Features Wizard - Confirm Installation Selections
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9. You will see the following dialog as the installation proceeds.

Figure (Appendix E) - 5: Add Features Wizard - Installation Progress
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10. Once the installation is complete, close the Wizard. The SMTP Server is displayed in the Features
list in the Server Manager window. Proceed to the IIS 6.0 Manager installation as described in
Step 2: Install 11S 6.0 Manager.

Step 2: Install 1S 6.0 Manager

To install the Microsoft 1IS 6.0 Manager, or to verify that it is already installed, use the
following steps:

1. To start the Windows Server Manager application, from the Start menu, select Programs »
Administrative Tools » Server Manager menu item.

N

Click on the Web Server (11S) in the left-pane.

3. In the right-pane look for 11S 6 Management Compatibility in the list of features, under
Management Tools.

4. If the 11S 6 Management Compatibility and sub-features shows up as installed in the list,
proceed directly to Step 3. Configure SMTP w/ I1S Manager.

5. To add the 11S 6 Management Compatibility, click on the Add Role Services link, located in
the right pane, on the right side of the dialog box.

Figure (Appendix E) - 6: Services Manager Window - Add Role Services
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6. From the Add Features Wizard dialog box, in the Role Services list, select the 11S 6
Management Compatibility checkbox.

-

NOTE Ensure that all the 11S6 feature checkboxes are selected.
|
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7. To continue, click on Next.
Figure (Appendix E) - 7: Role Services Window
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8. To continue, on the Confirm Installation Selections dialog box, click on the Install button.

9. Close the wizard when the completion message is displayed. The 1S 6 Management Compatibility
is now installed.

Step 3: Configure SMTP with 1IS 6.0 Manager

1. To start the Windows Server Manager Application, from the Start menu, select Programs »
Administrative Tools » Internet Information Services (11S) 6.0 Manager menu item.

2. Expand the Server Name object (ex. C8-DEMO)

3. Right-click on [SMTP Virtual Server #..1] object and choose Properties.
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Figure (Appendix E) - 8: Internet Information Services (11S) 6.0 Manager Menu item
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4. In the Properties dialog box, click on the Access tab
5. Click on the Authentication button.

Figure (Appendix E) - 9: Properties dialog box
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6. Verify that the Anonymous access checkbox is selected and then click on OK.

Figure (Appendix E) - 10: Authentication dialog box — Anonymous access
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7. On the Properties dialog, click on the Connection... button.
8. Select the Only the list below radio button.

9. Click on the Add... button.
Figure (Appendix E) - 11: Connection dialog box
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10. Click on the Single Computer radio button.
11. In the IP address: text box, enter 127.0.0.1.

12. To return to the Properties dialog box, click on OK.
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Figure (Appendix E) - 12: Computer dialog box
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13. In the Properties dialog, click on the Relay... button.
14. Select the Only the list below radio button.

15. Click on the Add... button.

Figure (Appendix ) - 13: Relay Restrictions dialog box
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16. Click on the Single Computer radio button.
17. In the 1P address text box, enter 127.0.0.1.

18. To return to the Properties dialog box, click on OK.
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Figure (Appendix E) - 14: Computer dialog box
computer |

Add ore of fhe folovang 1o the kst
¥ Single computer
1P acddbess
127. 0.0 .1 DNS Lockup...

" Gioup of computers

A St 4

ok | Caeel | Hep

19. On the Properties dialog box, click on the Messages tab.

20. In the Send copy of Non-Delivery Report to: text box, enter the email address of the person

responsible for managing this Centric8 server.

Figure (Appendix E) - 15: Properties dialog box — Messages tab
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21. On the Properties dialog box, click on the Delivery tab.

22. Click on the Advanced... button.
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Figure (Appendix E) - 16: Properties dialog box — Delivery tab
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23. Set the Masquerade domain to the domain name of the business running Centric 8.

Examples:
= Any Centric Software servers should display - centricsoftware.com
= Charlotte Russe would display - charlotterusse.com, etc.

24. The Fully-qualified domain name: should be set to match the DNS name this server is known as.

Examples:

= C8-DEMO is an internal machine, which is how users will reference the machine. (i.e. c8-
demo.centricsoftware.com).

= Charlotte Russe’s mirror site is known as crmirror, so this field would be set to crmirror,
and along with the Masquerade domain field, it would yield as
crmirror.charlotterusse.com.

= This is name that the SMTP server will provide to destination email servers, as it sends
emails from Centric 8.
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Figure (Appendix E) - 17: Advanced Delivery dialog box
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25. To return to the Properties dialog box, click on OK.

26. To exit, in the Properties dialog box, click on

OK.

27. Restart the SMTP service to apply this settings.

-
NOTE

without any relaying errors.

The SMTP service on this server is now configured to accept mails
only from applications running on this machine (i.e. Centric 8) and
| will send mails to email addresses with different domain names,

Configure SMTP to connect to email servers that require authentication

To send email(s) through an email server that requires authentication, such as an Exchange
Server, or an outsourced service, such as google mail, etc., the following additional

configuration steps are required.

1.

To start the Windows Server Manager Application, from the Start menu, select Programs »

Administrative Tools » Internet Information Services (11S) 6.0 Manager Menu item.

CONFIGURING SMTP ON WINDOWS 2008 SERVER

Expand the Server Name object (ex. C8-DEMO)

Right-click on [SMTP Virtual Server #..1] Object and select Properties.
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Figure (Appendix E) - 18: Internet Information Services (11S) 6.0 Manager Menn
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4. In the Properties dialog box, click on the Delivery tab.

5. Click on the Outbound Security... button.

Figure (Appendix ) - 19: Properties dialog box
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6. In the Outbound Security dialog box, select the Basic authentication radio button.
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7. In the User name: text box, enter the user name details (given to you by your email
Administrator for connecting to your Exchange or outsourced email server).

8. In the Password: field, enter details of the account password received from your email
Administrator.

9. If the Exchange Server or the Outsourced Server requires TLS encryption, select the TLS
encryption checkbox.

Figure (Appendix E) - 20: Outhound Security dialog box - TLS encryption
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10. To exit the Properties dialog box, click on OK.

11. To apply the settings, restart the SMTP service.

NOTE The SMTP Service on this server is now configured to forward all
| emails to an Exchange Server or outsourced email service.

Step 4: Configure Centric 8 SMTP Server Properties

For Wildfly 8.1.0

For Wildfly 8.1.0, the default file name and location are in the C:\Program Files\Centric
Software\C8\wildfly-8.1.0\ standalone\ configuration folder.

The SMTP information can be found in:

=  MSSQL

Wildfly-8.1.0\standalone\ configuration\ standalone-pi-mssqgl.xml
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= Oracle
Wildfly-8.1.0\standalone\ configuration\ standalone-pi-oracle.xml
1. Locate and open the appropriate xml file for Centric 8 using WordPad.
2. Locate the following section:
<outbound-socket-binding name="mail-smtp">
<remote-destination host="localhost" port="25"/>
</outbound-socket-binding>
3. Update the parameters highlighted in bold as is necessary (as shown below):
<remote-destination host="localhost" port="25"/>
4. Exit WordPad, saving the changes you have made.

5. To apply/activate the revised settings, restart the Centric 8 Wildfly service.

R The Centric 8 server will now use the Windows SMTP server to send
| email notifications to users.

2. Configuring SMTP Server with 11S 7.0 Manager

If you are using the recommended 64-bit operating system with Windows 2008 server, and
Microsoft I1S Web Server version 7.0, you must configure the SMTP Server.

This section describes how to complete the SMTP Server configuration on Windows 2008
using the following steps:

=  Step 2: Install 1IS 7.0 Manager

= Step 3: Configure SMTP with IIS Manager

=  Step 4: Configure SMTP with 1IS 7.0 Manager

Step 1: Install SMTP Server Service

To install the SMTP Server service, or to verify that it is already installed, use the following
steps:

1. From the Start menu select Programs » Administrative Tools » Server Manager.

2. In the Server Manager window, in the left pane, click on Features; the Features list is
displayed in the right pane:
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Figure (Appendix E) - 21: Server Manager Window
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3.

installed; proceed to Step 2: Install 11S 7.0 Manager on page 216

ELSE continue with step 4 below.

In the Features list, if SMTP Server is displayed then it indicates that the SMTP Server Service is

In the right pane, click on the Add Features link; the Add Features Wizard is displayed.

In the Features list, to turn on the SMTP Server, select the SMTP Server checkbox.
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Figure (Appendix E) - 22: Add Features Wizard - Select Features
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6. To continue, click on Next.

7. In the Add features required for SMTP Server? dialog box, click on the Add Required

Features: button.

Figure (Appendix E) - 23: Add Features Wizard
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8. In the Add Features Wizard — Confirm Installation Selections dialog box, click on the

Install button,
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Figure (Appendix E) - 24: Add Features Wizard - Confirm Installation Selections dialog box
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9. Once the installation is complete, you can close the Wizard; the SMTP Server now displays in

the Features list in the Server Manager Window. Proceed to the IIS 7.0 Manager installation
as explained in Step 2: Install 1S 7.0 Manager.

Step 2: Install 11S 7.0 Manager

» To install the Microsoft I1S 7.0 Manager OR to verify that it is already installed

1. From the Start menu, select Programs » Administrative Tools » Server Manager.

2. In the Server Manager window, in the left pane, click on Web Server (11S); the Role

Services list is displayed in the right pane.
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Figure (Appendix E) - 25: Services Manager Window
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3. In the Role Services list, expand Management tools; if IS 7 Management Compatibility is
displayed it indicates that the IIS 6.0 Manager is already installed and you can proceed to Step 3:
Configure SMTP with IIS Manager on page 222

ELSE, continue with step 4 below.

4. In the right pane, click on Add Role Services; the Role Services Wizard is displayed.

5. In the Role Services list, to turn on the 11S 7 Management Compatibility, select the 11S7
Management Compatibility checkbox.
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Figure (Appendix E) - 26: Role Services - Select Role Services dialog box
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6. Click on Next.
7. To continue the installation, in the Confirm Installation Selections dialog box, click on Install.

8. Once the installation is complete, you can close the Wizard; the 11S 7 Management compatibility
service now displays in the Role Services list in the Server Manager Window. Proceed to the
SMTP configuration as explained in Step 3: Configure SMTP with IIS Manager on page 204.

Step 3: Configure SMTP with IS Manager

To configure the SMTP with the 1IS Manager, or to verify that it is already installed, use the
following steps:

1. From the Start menu, select Programs » Administrative Tools » Server Manager.

2. In the Server Manager Window, in the left pane, expand the Web Server (11S) and click on
Internet Information Services (11S) Manager; the Connections list is displayed in the right
pane.

In the Connections list, click on the Server Name; the Server Home Page is displayed.

4. Under ASP.NET, double-click on the SMTP E-Mail icon.
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Figure (Appendix E) - 27: Service Manager
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5. The SMTP E-mail pane is displayed as shown below,

Figure (Appendix E) - 28: SMTP E-mail pane
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6. In the SMTP E-mail pane, enter the following information:

a. In the E-mail address text box, enter the email address that identifies the server; this address
must match the address for the server’s email domain. For example,
address@customerdomain.com

b. Select Deliver e-mail to SMTP server.

c. To turn on the Use localhost, select the Use localhost checkbox, and in the Port field, accept
the default value (25).

d. In the Actions pane, click on the Apply to verify your selections option and then close the
Server Manager.

7. To apply the settings, restart 1IS.

Step 4: Configure SMTP with IIS 7.0 Manager

You can reset all of your directory paths using the I1S Manager. For this section, open the
I1S Manager and reset the following:

. ISAPI filter path,
= |ISAPI filter properties path,
= Virtual directory path and
= WebAccess path
Then, restart the I1S Manager.

» To open the IS Manager (for updating the path details)

1. From the Start menu, select Programs » Administrative Tools » Internet Information
Services (11S) Manager.

2. In the 11S Manager Window, in the left panel, expand the server name. Proceed with the
directory path updates to C8.

CONFIGURING SMTP ON WINDOWS 2008 SERVER 220


mailto:address@customerdomain.com

Centric 8 INSTALLATION GUIDE

F. CONFIGURING SMTP ON WINDOWS 2012 SERVER

1. Configuring SMTP Server

If you are using the recommended 64-bit operating system with Windows 2012 server, and
Microsoft 11S Web Server version 8.0, you must configure the SMTP Server.

This appendix describes how to complete the SMTP Server configuration on Windows 2012
using the following steps:

= Step 1: Install SMTP Server Service

= Step 2: Install 1I1S 8.0 Manager

=  Step 3: Configure SMTP with IIS Manager

=  Step 4: Configure SMTP with 1I1S 8.0 Manager

Step 1: Install SMTP Server Service

To install the SMTP Server service, or to verify that it is already installed, use the following
steps:

1. From the Start menu, select Programs » Administrative Tools » Server Manager.

2. In the Server Manager Window, in the left pane, click on Features; the Features list displays
in the right pane.

3. In the Features list, if the SMTP Server is displayed, it indicates that the SMTP Server Service is
installed; proceed to Step 2: Install 1IS 8.0 Manager on page 221,

ELSE, continue with step 4 below.
In the right pane, click Add Features; the Add Features Wizard is displayed.

To turn on the SMTP Server option, in the Features list, select the SMTP Server checkbox.
To continue, click on Next.
In the Add features required for SMTP Server pane, click on Add Required Features.

In the Confirm Installation Selections pane, click on Install.

W ® N & U; b

Once the installation is complete, you can close the Wizard; the SMTP Server is displayed in the
Features list in the Server Manager Window. Proceed to the IIS 8.0 Manager installation as
explained in Step 2: Install 11S 8.0 Manager on page 221.

Step 2: Install 1S 8.0 Manager

» How to install the Microsoft IIS 8.0 Manager OR verify that it is already installed
1. From the Start menu, select Programs » Administrative Tools » Server Manager.

2. In the Server Manager Window, in the left pane, click on Web Server (11S); the Role
Services list is displayed in the right pane.
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3. In the Role Services list, expand Management tools; if IS 8 Management Compatibility is
displayed, it indicates that the 1IS 8.0 Manager is already installed and you can proceed to Step
3: Configure SMTP with IS Manager on page 222,
ELSE, continue with step 4 below.

4. In the right pane, click on Add Role Services; the Role Services Wizard is displayed.

5. In the Role Services list, to turn on the 1IS 8 Management Compatibility, select the 11S 8
Management Compatibility checkbox.

6. Click on Next.

7. To continue installation, in the Confirm Installation Selections pane, click on Install.

8. Once the installation is complete, you can close the Wizard; the 1I1S 8 Management compatibility

service is displayed in the Role Services list in the Server Manager Window. Proceed to the
SMTP configuration as explained in Step 3: Configure SMTP with IIS Manager.

Step 3: Configure SMTP with IS Manager

» To configure the SMTP with the IIS Manager, or to verify that it is already installed

1. From the Start menu, select Programs » Administrative Tools » Server Manager.

2. In the Server Manager Window, in the left pane, expand the Web Server (11S), and select
Internet Information Services (11S) Manager; the Connections list is displayed in the right
pane.

In the Connections list, click on the server name; the server home page is displayed.

4. Under ASP.NET, double-click on the SMTP E-Mail icon,

Figure (Appendix F) - 1: Server Manager Window
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5. The SMTP E-mail pane is displayed as shown below,

Figure (Appendix F) - 2: Server Manager Window
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6. In the SMTP E-mail pane, enter the following information:

a. In the E-mail address text box, enter the email address that identifies the server; this address
must match an address for the server’s email domain. For example,
address@customerdomain.com

b. Select Deliver e-mail to SMTP server.
c. Turn on Use localhost, and in the Port field, accept the default value (25).

7. To verify your selections, in the Actions pane, click on Apply and then close the Server
Manager.

8. To apply/activate the settings, Restart 11S.

Step 4: Configure SMTP with IIS 8.0 Manager

You can reset all of the directory paths using the 1S Manager. For this section, open the IIS
Manager and reset the following:

= ISAPI filter path,

= ISAPI filter properties path,

= Virtual directory path and WebAccess path.
Then, restart the 11S Manager.
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» To open the 1IS Manager (to update the path details)

1. From the Start menu, select Programs » Administrative Tools » Internet Information
Services (11S) Manager.

2. In the 11S Manager Window, in the left panel, expand the server name. Proceed with the
directory path updates to C8.
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G. LICENSING AND ADMINISTRATOR PASSWORD
MANAGEMENT

1. Managing User Licenses

If users, suddenly, find that they are unable to log in to Centric 8, it is possible that the
organization may have exceeded the maximum number of allowable user licenses set up
during installation. All active users in the system are measured against the total number of
allowable user licenses.

Exceeding the maximum number of allowable user licenses causes a forced
lockout from Centric 8; contact your corporate system administrator or the

* Centric Customer Technical Support Center:
NOTE
L Telephone : 866.796.6218 (8:00 am — 8:00 pm Eastern Standard Time)
Fax : 1.603.448.2812 (Attention: Customer Technical Support)
E-mail . support@centricsoftware.com

To make more licenses available, you can set a user’s status to inactive. For more information
refer to the Centric 8 Administrator Guide.

2. Install New User License

Toinstall a new user license in Centric 8

1. From the Start menu, select Programs » Administrative Tools » Services.
2. Unzip the C8.lic to the certificates folder in the following location:
<Centric8InstallDirectory>\C8\wildfly-8.1.0\ standalone \configuration\ certificates

3. Once the file C8.lic has successfully been added to the certificates folder, restart the Wildfly
service.

= To restart the Wildfly Service,

e From the Start menu, select Programs » Administrative Tools » Services.
e In the Services Window, right-click on Centric Wildfly Service and select Start.

e Allow a few moments for the batch files to finish running in the background.

Change Admin Password: Post Installation Steps

To change your Administrator password, you must first log into Centric 8 with Administrator
rights and modify the password in the Ul.
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Change Password in Centric 8 Ul

» How to change the password in the Ul

1.
2.

4,

Log into Centric 8 as the site administrator.

On the User Management tab, in the User Login column, click on the Administrator User
Login Name. The User Profile tab is displayed.

On the User Profile tab, click on Change User Login/Password. The Change User
Login/Password dialog box is displayed.

Enter details in the Password and Confirm Password fields, and click on Save.

Confirmation

On completing the Change Password in Centric 8 Ul procedure, confirm that the password is
properly reset in Centric 8.

» How to confirm that the password is reset properly

1.
2.

Log into Centric 8 as the site Administrator.

If you are unable to log in, verify that you entered the correct user name and new password. If
you continue to receive the message User Name and/or password is invalid, verify that no
errors exist in the pi_sessions.log file located in the <Centric8InstallDirectory>\C8\Log folder.

If no errors exist, try logging in again.

’ The C8 Print and Image Services use the C8 Administrator password.
NOTE Whenever the C8 Administrator password is changed, make sure to change the
L__ password information in the relevant files for C8 Print and Image Services.

3. Install Mobile App License

To Install Mobile App license

1.

Unzip the license file to the ios folder in the following location:

.\ C8\WebAccess\ios folder

s

T 1. |If license file is not available, contact the Administrator

2. If ios folder does not exist, create a new one

2. Rename that file to C8MobilePermissions.plist

3. Open I1S Manager and select the computer name from the left pane

4,

In 11S section, right click on MIME Types and select Open Feature
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Figure (Appendix G) - 1: 118 Manager Window

3 EInternet Information Services (IIS) Manager

@@ [‘j » PERFLABS
Fle Wiew Help
@) PERFLAB3 Home
Q- |78 ope
— ; - - : - &~ Ma
PERFLAES (PERFLABS\AdMpistr | T1MF Bl - mshonal |Growby: area s
ASP.NET = |~ Res
P Sta
i & & [ “ = ® s
T U B/ = "
MET MET \MET Errar MET (MET Trust  Application ier
Authorizati,,  Compilation Pages Globalization Levels Settings Vie
w = ‘ » @ Help
L [ b, & = oni
Connection  Machine Key  Pages and Providers  Session State  SMTP E-mail
Strings Controls
115
2 B d (o E
ASP Authentication il COMpression Default Directary
Docurment Browsing
= & i
« H9
Error Pages Failed Request  FastCGI Handler HTTP Redirect HTTP
Tracing Rules Setkings
3 A g
% 4=t .
ISAPI and CGI  ISAPI Filters Logging
Restrictions Open Feature
= B & Restart
Lﬂ” &# t’ Start
Reouest Server Worker ;I
B Stop
= Content Yiew
4] Bl [ETrestres ven i View Application Pools
Ready View Sites

5. From the Actions column, click on Add

Figure (Appendix G) - 2: 11S Manager Window
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6. Enter the following in the Add MIME Type dialog box:
File name extension — .plist

MIME type — application/xml
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Figure (Appendix G) - 3: Add MIME Type Dialog box
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7. Click on OK and restart 11S
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H. PDF PRINT SERVICE

For information on the PDF Print Service, refer to the PDF Print Service Installation Guide.
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|. IMAGE SERVICE

For information on Image Service, refer Image Service Installation Guide.
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J. LDAP SETUP WITH SSL

This section explains the configuration requirements for enabling LDAP Authentication with
SSL.

1. Pre-requisite

LDAP Administrator must create a user group in LDAP of Users allowed to access Centric8
through LDAP.

2. SSL CERTIFICATE INSTALLATION

1.

If a SSL Certificate is required to be deployed, obtain the certificate file from the Customer and
copy it to the Centric 8 server machine.

Install the Certificate in the C8 jre certificate store, as follows:

=  Open a command prompt as Administrator and navigate to Centric 8 Installation
folder\jdk1.8.0_45\bin

»  Type: keytool -import -trustcacerts -alias YoCOMPANY_ NAME%Y -file% PATH_TO
_CERTIFICATE_FILE%Y -keystore

%C8_INSTALLY\%JAVA_DIR%\lib\security\ cacerts

= Default keytool password is “changeit”

= Type ‘YES’ to install the certificate

= The following parameters need to be updated for LDAP configuration
Pi-configuration.properties file (found in ...\C8\wildfly-8.1.0\ standalone\ configuration folder)

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPAddress =
##LDAP_SERVER_ADDRESS##

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPSearchBase =
##LDAP_SEARCH_BASE##

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPGroupBase =
##LDAP_GROUP_BASE##

com.centricsoftware.server.ldentityProvider.CENTRIC _IDENTITY_PROVIDER.LDAPBindUser =
##LDAP_BIND_USER##

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPBindPassword =
##LDAP_BIND_PASSWORD##

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPGroupType =
##LDAP_GROUP_TYPE##

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPUserType =
##LDAP_USER_TYPE##

com.centricsoftware.server.ldentityProvider.CENTRIC_IDENTITY_PROVIDER.LDAPType =
##LDAP_TYPE##
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Refer to the table below for a description of the parameters and some example settings for

these parameters.

Table (Appendix ]) - 1: Description of Parameters and example settings for Pi-configuration.properties file

LDAP_SERVER_ADDRESS=

LDAP_SEARCH_BASE

LDAPGroupBase=

LDAP_GROUP_BASE

LDAP_BIND_USER

LDAP_BIND_PASSWORD

LDAP_GROUP_TYPE

LDAP_USER_TYPE

LDAP_TYPE

PAGESIZE

Idap://192.168.
10.174:389

cn=CentricUser
s,ou=Groups,dc
=centricsoftwar
e,dc=com

cn=TestGroupl

,cn=Users,dc=I

ab,dc=frametec
h,dc=com

cn=CentricUser

s,ou=Groups,dc
=centricsoftwar
e,dc=com

cn=admin,dc=c
entricsoftware,d
c=com

2:C™K(?"B=%

groupOfNames

posixAccount

OpenLDAP

LDAPPageSize=
500

set during config

set during config

set during config

set during config

set during config

set during config

groupOfNames
(OpenLDAP)Grou
p (Active
Directory)

posixAccount
(OpenLDAP)User
(Active
Directory)

Left blank
(implies Active
Directory)

Idap:// or Idaps://
+ip/port or server
name

Distinguished name' of
root search directory
(could be base LDAP
domain or lower
directory)
Distinguished name of
group object containing
C8 users to import

Distinguished name' of
root search directory
(could be base LDAP
domain or lower
directory)

Either distinguished
name of binding user
(OpenLDAP), or
username@domain
(Active Directory)
Encrypted password
(generated as part of
install process but need
to regenerate if
binduser is changed on
LDAP server)

Object type for group
container (Variable for
OpenLDAP, Group for
Active Directory)

Object type for user
object (Variable for
OpenLDAP, User for
Active Directory)

Active Directory (or
blank), OpenLDAP

If no value is specified,
then the default is 500

This is like a file path in
reverse notation, where
cn is the end of the path
ou is the parent path
and dc is the 'drive

This is like a file path in
reverse notation, where
cn is the end of the path
ou is the parent path
and

dc is the 'drive

This is like a file path in
reverse notation, where
cn is the end of the path
ou is the parent path
and

dc is the ‘drive

User DNs contained in
member attribute list
(OpenLDAP), or in
memberOf attribute list
of Group (AD).

User must have
username set in
sAMAccountName (AD)
or uid (OpenLDAP).
Foreign ID taken from
objectGUID (AD) or
uidNumber (OpenLDAP)

This option is used when
synchronizing a large
number of LDAP users,
i.e. 1000+ users

3. Once the parameters are updated, save and close the file. Restart Centric Wildfly service.
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Confirm the certificate has been installed correctly.

= Enter the following command in the command prompt (navigate to the same directory
used when installing the certificate)

keytool -list -keystore %JAVA_ HOME%\lib\security\cacerts
Example:
keytool -list -keystore C:\C8\jdk1.8.0_45\jre\lib\security\cacerts
= No password is required, but ‘changeit’ should work if desired.

= In the displayed list, search for the alias name you entered in the section SSL Certificate
Installation - Step 2 on page 231 in the list that is displayed.

Import Users from LDAP

1
2
3.
4

Log into C8, navigate to Setup » User Management » LDAP tab.
Verify the LDAP server details like Server address, search base string etc.
Verify whether the Force SSL checkbox has been selected, if SSL is enabled on LDAP Server.

On the toolbar, click on the Synchronize icon. You can view a message saying how many users
are imported, in the lower right corner of the page.

Optional Steps

1.

2.

To synchronize users daily, select Job Enabled checkbox. To change the Job schedule, navigate
to Setup » Service » Job Service tab. In the Job Schedule table, change the execution time.

To import LDAP users as active, click Import As Active User.
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K. HTTPS SUPPORT

RO This section applies only if you have already installed SSL Certificate in your
| server.

Configuration Files

After the SSL Certificate has been installed on 11S, change the following configuration files:
<program files>\Centric Software\C8\wildfly-8.1.0\standalone\ configuration\standalone-pi-mssql.xml to

com.centricsoftware. AppServer. HomeURL

Image Services

1. Update the CSImageService.cfg file.
2. # Server URL for obtaining print requests

3. Server URL=https://HostUrl/csi-requesthandler/RequestHandler

PDF Print Services

1. Update the PDFService.cfg file.
2. # Server URL for obtaining print requests

3. Server URL=https://HostUrl/csi-requesthandler/RequestHandler

If Firewalls are installed on the Windows Server and network, update it to
allow traffic through on port 443 (https).

N The Centric 8 server must be able to resolve the Host name to an IP address
| on this machine.

There are cases where Administrators do not have external names resolved to
an IP address inside their own network.

4. After making changes to the configuration file, ensure that a valid IP address that matches the IP
address on the server is returned. Else, the Centric8 application will not function properly.

5. Ensure that each of the configuration files uses https://HostUrl. Note that inserting an IP
address instead of the host URL, will prevent the Centric8 application from functioning properly.

6. The URL must match the certificate name (i.e. Host Url).

7. For example, if the certificate name is example.somecompany.com, the URL must start with
https://example.somecompany.com/....

8. If the URL does not match the certificate name, then the Print and Image services will not work
as expected.
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» How to test whether or not the hostname returns a valid IP address

1
2
3.
4

Open a command prompt and type PING Host Url. Press ENTER.
An IP address is displayed.
Type IPCONFIG and press Enter.

Verify that the IP address returned by the PING is displayed in the IPCONFIG report.

If the PING response is unknown host or an IP address that does not match with that of the
server, complete the following steps given below:

You will need help from the Customer’s IT Administrator to perform these
steps.

NOTE

1. Edit the Windows system hosts file and add the following line (The hosts table can be found in
C:\Windows\System32\drivers\ etc)
2. In the Start menu, locate the Notepad app icon.
3. Right-click on the Notepad app, and select Run As Administrator option.
= If you do not select the Run As Administrator option, the file will be opened in Read-
only mode and the changes will not be saved.
4. At the end of the file, type the line (IP address) 127.0.0.1 Customer name, save the changes and
exit notepad.
5. Now, when you type PING Customer name and press Enter, the following IP address will be
displayed:
127.0.0.1
* This is a special IP address which refers to the machine you are currently
NOTE logged on. Any reference to 127.0.0.1 will point back to the machine you are
| currently system on which you are currently logged in.

6. Restart Wildfly; the Print, and Image services will pick up the changes made to the configuration

files.
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L. ENABLE HTTP COMPRESSION IN 1S

Enable HTTP Compression in I1S to improve client performance slow networks.

-

NOTE This step is required for Mobile Apps to improve performance.
|

1. Open Internet Information Service (11S).

Figure (Appendix 1) - 1: Internet Information Serice (I1S)
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2. On the left pane, click on a server name. On the right hand side, under IS, right-click on
Compression and select the Open Feature option.
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Figure (Appendix L) - 2: 11S Window
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3. Select the Enable dynamic content compression and Enable static content compression

checkboxes. Click on Apply on the right hand side. Go to Step 7.

Figure (Appendix 1) - 3: Compression Window
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4. If dynamic content compression module is not installed, open Server Manager.
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Figure (Appendix L) - 4: Serwer Manager
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5. Click on Roles. In the Roles Window, in the Web Server (11S) section, click on Add Role
Services.
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Figure (Appendix L) - 5: Roles Window
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6. In the Add Roles Service dialog box, under Performance, select Static Content Compression

and Dynamic Content Compression checkboxes and click on the Install button.

Figure (Appendix L) - 6: Select Roles Window
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7. From the Start menu, select 11S Manager. In the Connections section on the left, click on the
server name in 11S. On the right hand side, under the Management section, right-click on the
Configuration Editor and select Open Feature.

Figure (Appendix L) - 7: Configuration Editor - Open Feature
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8. From the Section drop-down list, expand System.webServer and select httpCompression
Figure (Appendix 1) - 8: Configuration Editor
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9. Select dynamicTypes and click on the Browse button.
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Figure (Appendix L) - 9: Configuration Editor (2)
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10. No changes are required if,

= In the Collection Editor dialog box, if you see the mimeType */* and the enabled field

is set to True, no changes are required.

Figure (Appendix L) - 10: Collection Editor (3)
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ELSE,

= In the Collection Editor dialog box, if you see this mimeType */* and the enabled field
is set to False,

e Click on it.

¢ In the Properties section, from the enabled drop-down list, select Truxe.

Figure (Appendix 1) - 11: Collection Editor - Properties section
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11. If no mimeType is available,

= In the Collection Editor dialog box, on the right —hand side, in the Actions section, click
on Add.

Figure (Appendix 1) - 12: Collection Editor - Properties
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12. In the Properties window, in the enabled drop-down list, select Trze and type */*in mimeType
field.

Figure (Appendix L) - 13: Properties Window
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13. Close the Configuration window and restart the 11S.

Offline App Cache

Centric 8 5.5 release uses HTML5 which introduces application cache, which means that a web
application is cached, and accessible without an internet connection.

Advantages of Setting Offline App Cache

Application cache gives the following advantages:
e Offline browsing : Users can use the application when they're offline
e Speed : Cached resources load faster

¢ Reduced server load: The browser will only download updated/changed resources
from the server

Supported Browsers for Offline App Cache

The numbers in the table specify the first browser version that fully supports Application Cache

ENABLE HTTP COMPRESSION IN 1IS 243



Centric 8 INSTALLATION GUIDE

Browser Chrome 1E Firefox Safari

Application Cache 4.0 10.0 3.5 5.0

L
NOTE  The Application Cache is not supported in IE9 version

» To setup Offline Cache

1. Open IIS manager
2. Click on machine name from the Connections pane

3. In the IIS section, right-click on MIME Types and select Open Feature

Figure (Appendix 1) - 14: ILS Manager Window
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4. Click on Add from the Actions pane
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Figure (Appendix L) - 15: MIME Types Window
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5. Enter the following in the Add MIME Type dialog box:

File name extension: .appcache

MIME type: text/cache-manifest

Figure (Appendix 1) - 16: Add MIME Type Window

File name extension:

s

MIME type:
|

o I Cancel

6. Click on Ok and restart 11S. To restart 11S, click on the machine name and click Restart from the
right pane

» Toclear Browser Cache
= In Chrome:
1. Navigate to Options » More Tools » Clear Browsing Data

2. From the Obliterate the following items from: drop-down menu, choose the
beginning of time

3. Enable Cookies and other site and plugin data and Cached images and files
checkboxes

4. Click on Clear browsing data
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Figure (Appendix 1) - 17: Clear Browsing Data Window

Clear browsing data

Obliterate the following items fron: | the beginning of time ¥

| Browsing history

|| Download history

Cookies and other site and plugin data

| Cached images and files

| Passwords

| Autofill form data
| Hosted app data

| Content licenses

Learn more

Saved content settings and search engines

brow

wsing habits.

= In Firefox:

Clear browsing data | | Cancel |

will not be cleared and may reflect your

1. Navigate to Tools » Options » History » Clear Recent History

2. From the Time range to clear: drop-down menu, choose Everything

3. From the Details section, enable Cache and Offline Webisite Data

4. Click on Clear Nowv to clear the borswer cache

Figure (Appendix 1.) - 18: Clear Al History Window

Clear All History X
Timerangeto clea | Everything i
J_.-"'\\ All selected items will be cleared.
"_—lé, This action cannot be undone,
[ A . Details
[] Browsing & Download History e
[] Form & Search History
[] Coockies
[ Cache
[ Active Logins
| ] Offline Website Data |
[ Site Preferences v

Cancel
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= In Internet Explorer:

1. Navigate to Tools » Internet Options » Browsing History » Delete

2. In the Delete Browsing History popup, enable Temporary Internet files and website
files and Cookies and website data

3. Click on Delete to clear the browswer cache

Figure (Appendix 1) - 19: Delete Browsing History Window
[

? XoF
! =. Get started with Surface Pro...
el

General Security Privacy Content Connections Programs A Delete Browsing History W
Home page —
[] Preserve Favorites website data

Keep cookies and temporary Internet files that enable your favorite
hitp://ge.microsoft.com/fwlink/PLinkiD=394657 websites to retain preferences and display faster.

To create home page tabs, type each address on its own

v Internet files and website files

Use current Use default Use new | i i By
| yiewing
Startup - — ‘Cookies and website datal
() Start with tabs from the last session T tored-orTyon computer by websites to save
preferences or improve website performance.
(®) 5tart with home page
OHistory
Tabs — List of websites you have visited,
Change how webpages are displayed in tabs. Tabg
[[] Download History
Browsing history — List of files you have downloaded.

Delete temporary files, history, cookies, saved passwords, and wi
form information. [] Ferm data

[Delete b ing histo it Saved information that you have typed into forms,
elete browsing history on exi

| Delete... Setting [|passwords
1 Saved passwords that are automatically filed in when you sign in
Appearance — to a website you've previously visited.
; Colors Languages Fonis Aooesmig [ Tracking Protection, ActiveX Filtering and Do Not Track

A list of websites excuded from filtering, data used by Tracking
Protection to detect where sites might automatically be sharing details
| about your visit, and exceptions to Do Not Track requests.

OK Cancel

T IE I Iy ST

About deleting browsing history Delete I | Cancel

. This action cannet be undone.
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M. CHANGE SMTP SERVER INFORMATION IN
WILDFLY

» To change SMTP Server information in Centric 8

1. In the Services window, stop Wildfly Services.

Figure (Appendic M) - 1: Services Window
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2. If using SQL Server, edit Standalone-pi-mssqgl.xml file (located in ..\C8\wildfly-
8.1.0\standalone\ configuration folder) in XML editor application (Notepad++).
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Figure (Appendix M) - 2: Confignration Window
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3. If you are using SQL Server with wildfly Cluster Setup, then edit Standalone-pi-mssql- ha-tcp.xml in
all Cluster Servers. (located in ..\ C8\wildfly-8.1.0\ standalone\configuration folder) in XML editor
application (Notepad++).

Figure (Appendix M) - 3: Configuration Window (2)
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4. If you are using Oracle Server, edit Standalone-pi-oracle.xml (located in ..\C8\wildfly-
8.1.0\ standalone\ configuration folder) in XML editor application (Notepad++).
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Figure (Appendix M) - 4: Configuration Editor (3)
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5. If you are using Oracle Server with Wildfly Cluster Setup, then edit Standalone-pi-oracle- ha-tcp.xml
in all Cluster Servers. (located in ..\C8\wildfly-8.1.0\standalone\ configuration folder) in XML editor
application (Notepad++).

Figure (Appendic M) - 5: Configuration Editor (5)
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6. Search for the following lines and make changes as explained below:
a. Change the Local Host to your SMTP Server name

b. Change the Port number 25 to your SMTP Port number

Make sure your SMTP Port number is open in your local Firewall settings.

(located in ..\C8\Wildfly-8.1.0-
\standalone\ configuration \folder).

er'rs If you modify Host and Port informaiton, remove standalone-pi- mssql_xml_

Figure (Appendic M) - 6: Modify host and port information in the Wildfly-8.1-0 folder

<socket-binding-group names="standard-sockets” default-interfaces"public">
<socket-binding name="ajp” port="5{|boss.a| p.port:80059)" />
<socket-binding name="http" port="5{jboss.http.port:5080]" />
<spcket-binding name="https" port="5%{jboss.https.port:8443)" />
<socket-binding name="management-http" interface ="management” port="5{jboss. management.hitp.port:9390]" />
<socket-binding name="management-hitps" interlace="management" pori="5{|boss.management.hitps. port:o393)" [
<socket-binding name="tun-recovery-environment” port="4712" =
<socket-binding name="tun-status-manager” port="4713" />
<putbound-socket-binding name="mail-smip">
<remote-destination hnrst:Fbcalhnst" port="25" > ]
< foutbound-socket-binding >

</socket-binding-group>

7. Check whether or not your SMTP Server accepts anonymous authentication.

» To check whether your SMTP Server accepts anonymous authentication,

=  From the Start menu, select Administrative Tools » Internet Information Services

(11S) 6.0 Manager.

Figure (Appendixc M) - 7: 11S 6.0 Manager
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In the Internet Information Services (11S) 6.0 Manager window, click on the expand

button before your server name. Right-click on [SMTP Virtual Server#1] and select
Properties.

Figure (Appendixc M) - 8: SMTP Server
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In the Properties window, on the Access tab, click on the Authentication button.
Figure (Appendix M) - 9: SMTP 1 irtual Server #1 Properties dialog box
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Make a note of the type of authentication selected and click on OK.
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Figure (Appendix M) - 10: SMTP Virtual Server #1 Properties - Authentication dialog box
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= In [SMTP Virtual Server # 1 Properties] window, on the Delivery tab, click on the

Outbound Security button.

Figure (Appendix M) - 11: SMTP Virtual Server #1 Properties dialog box
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= Make a note of the type of authentication selected and click on OK.
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Figure (Appendix M) - 12: Outbound Security dialog box
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= If on the Access and Outbound Security tabs, the Anonymous access radio button is
selected, then the next step is not required.

ELSE, continue.

If the SMTP server does not accept anonymous authentication, then enter SMTP user/password
details as follows,

<subsystem xmlIns="urn:jboss:domain:mail:2.0">
<mail-session name="default" jndi-name="java:/Mail/Default">

<Il--<smtp-server outbound-socket-binding-ref="mail-smtp"
username="##SMTP_SERVER_USERID##"

password="##SMTP_SERVER_PASSWORD##" />-->
</mail-session>
</subsystem>
Add the following line and change ## values to correct values.
For Example -
<subsystem xmlIns="urn:jboss:domain:mail:2.0">
<mail-session name="default" jndi-name="java:/Mail/Default">
<smtp-server outbound-socket-binding-ref="mail-smtp" username="MySMTPUser"
password="MySMTPUserPassword" />
</mail-session>

</subsystem>

10. Save and close the file.

11. Restart Wildfly Service.
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N. JASPER SETUP

Pre-requisite Installation Files

MSSQL JDBC Driver: sqgljdbc4.jar

JasperServer + iReports 4.2 Installer (either x86 or x64, operating system dependent)
Setup Instructions

= Creating a Report DB in SQL Management Studio

= JasperServer / iReport Installation

Creating a Report DB in SQL Management Studio

1. From the Start menu, select SQL Server Management Studio. Enter the Server name, User
login Id and Password. Then, click on Connect.

Figure (Appendixc N) - 1: Connect to Server dialog box

l_lf{:ll'llll'.‘li t to Server
Microsoft
2 SQL Server2008r2
Server lype: [f'alab-'lse Engrne EI
Sesver name: [2KeS2KERZAR =
Authentication: [SOL Server Authentication =l
Logie js2 2
Password 1
[~ Ramember pazrword
[ Commect | cCancal |  Hep Dptions 5>

2. On the Object Explorer window, drill-down on the Security folder and right-click on the Login
folder.

3. To create a new login id, select New Login.
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Figure (Appendixc N) - 2: Object Explorer Window - New Login
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4. In the Login — New dialog box, select the SQL Server Authentication button.

5. Enter the login name as Reportuser.

-
NOTE It is possible to create a login in any name.

6. In the Password and Confirm Passwords fields, type Reportuser.

7. De-select the Enforce password policy checkbox.

Figure (Appendixc N) - 3: Login — New dialog box — Enforce password policy checkbox
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8. On the Login — New dialog box, in the left pane, click on Server Roles.

9. Select the sysadmin check box and click on OK.

Figure (Appendixc N) - 4: Login — New dialog box
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10. In the Object Explorer window, click on the Disconnect icon.

Figure (Appendixc N) - 5: Object Explorer window

Object Explorer

11. To connect into SQL Server with login id as Reportuser , in the Object Explorer window, click on
the Connect icon.

Figure (Appendixc N) - 6: Object Explorer Window (Connect)

Dbject Explorer
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Figure (Appendixc N) - 7: Connect to Serwer dialog box

-_'fullrlrl. L bo Server m

o Mo
-~ SQL Server 2012
Server ype: |Database Engre =
Senver name: |HQE1-TS :I
Authenticabion |50L Serves Authentication =
Loginc [Reportuses =]
Eumd Iu-..u-.1
™ Remember pazoword
[[Comect | Cocel |  Hep | gptions>s |

12. In the Object Explorer window, right-click on the Database folder and select the New
Database... option.

Figure (Appendixc N) - 8: Object Explorer dialog box - New Database..
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13. In the New Database dialog box, in the Database Name field, enter the Database name and
click on OK.
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Figure (Appendix N) - 9: New Database dialog box
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NOTE
| Databases folder.

The created database is displayed in the Object Explorer window under the

JasperServer/iReport Installation

1. If you are on a 64 bit server, click on the file jasperreports-server-cp-4.2.1-windows-x64-installer.exe

ELSE, if you are on a 32 bit server, click on jasperreports-server-cp-4.2.1-windows-x86-installer.exe

2. Right-click and select Run As Administrator to run the Jasper Report exe file, if supported by

your OS.

= Default folder is fine

= Use bundled Tomcat

= Use bundled PostgreSQL (the SQL datasource will be added after installation)

= Tomcat Server Port : 8081
= Tomcat Shutdown Port : 8006
= Database Server Port : 5433
= Install sample reports : No
= Install iReport : Yes
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Figure (Appendix N) - 10: Run as administrator option
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3. In the Setup dialog box, click on Next.
Figure (Appendixc N) - 11: Setup dialog box
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4. In the Setup License Agreement dialog box, select 1 accept the agreement option and click
on Next.
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Figure (Appendixc N) - 12: License Agreement dialog box
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5.
4.2.1 and click on Next.

Figure (Appendixc N) - 13: Installation Folder dialog box
= Setup

Instaliation folder

Please, choose a Folder o instal JasperReports Server CP 4.2.1

e

I ES

J’ JASPERSOFT

< Back I Nec:t:rl

Cancel

In the Setup Installation Folder dialog box, select a folder to install JasperReports Server CP

6. Select 1 wish to use the bundled Tomcat option and click on Next.
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Figure (Appendixc N) - 14: Setup dialog box

= Setup M=l
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i ) ASPERSOFT
Tomcat installation:
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7. Select 1 wish to use the bundled PostgreSQL database option and click on Next.

Figure (Appendixc N) - 15: Setup dialog box: - Database Installation
LFSetup M=l E

Database Installati
s -).IASPERSOFT

Plaass selact which database configuration you wish to use

1% 1 waish to use the bundled Postgre50L databass

T 1 wish to use an existing PostgreS0L databace

< Back i Mext > | Cancel

8. Enter the Tomcat Port Configuration. Enter 8087 in the Tomcat Server Port field and §006 in

Tomcat Shutdown Port field. Click on Next.
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Figure (Appendix N) - 16: Setup dialog box - Tomeat Port Configuration

=Setup .

Tosmecat Port Configur ation
JI#SPEP.SOFT

Flaase enter the Tomcst corfigurstion parameters you wish to use,

Tomeak Server Port: facen

Tomcat Shotdown Port:  [5006

<ok | met> | cancel |

9. In the Database Server port field, enter the port of your database as 5433. Click on Next.

Figure (Appendisc N) - 17: Setup dialog box - Database Server Parameters
- setup ME B

Database Server Parameters -)JASPERE.OFT

Plaase enter the port of your datshase.
Cistabarse Server port 43

cBack | Net> | conce |

10. In the section Would you like to install sample databases and sample reports, click on the
No radio button. Click on Next.
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Figure (Appendixc N) - 18: Setup dialog box: - Install Sample Data
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11. In the Setup — Install iReport Designer dialog box, select the Yes radio button. Click on Next.

Figure (Appendisc N) - 19: Setup dialog box - Install iReport Designer
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12. The progress of iReport installation is displayed in the progress bar.
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Figure (Appendixc N) - 20: Setup dialog box — Installation progress bar
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13. On completion of the Installation process, click on Finish.

Figure (Appendixc N) - 21: Setup dialog box: - Completion of the JasperReports Server CP 4.2.1 Setup Wizard
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14. Navigate to Start » Services.

15. Right-click on Centric Wildfly-8.1.0, select Stop.

Figure (Appendix N) - 22: Services Window
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16. Right-click on JasperreportsTomcat, and select Stop.

Figure (Appendic N) - 23: Services Window (2)
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17. Go C:\Program Files\jasperreports-server-cp-4.2.1\ireport\ireport\modules\ ext

Delete the following .jar files:

*  batik-anim.jar

*  batik-awt-util.jar

*  batik-bridge.jar

" batik-css.jar

*  batik-dom.jar

= batik-ext.jar

= batik-gvtjar

*  batik-LICENSE.txt

®  batik-parser.jar

®  batik-script.jar

®  batik-svg-dom.jar

" batik-svggen.jar

*  batik-utiljar

" batik-xml.jar
e =
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Figure (Appendixc N) - 24: Delete jar files
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18. To restart the previously stopped Services (Wildfly-8.1.0 and JasperreportsTomcat), in the left
pane, click on the Restart link.

Figure (Appendixc N) - 25: Services dialog box - Restart (Wildfly)
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Add SQL Datasource Support to JasperServer

1. Go to C:\Program Files\jaspetreports-setver-cp-4.2.1\apache-tomcat\lib

2. Copy the file sgljdbc4.jar to this directory.

#
\ETE This file will be present in the common repository.

3. Navigate to C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver \META-INF\ context.xml

4, Add the following Resource parameter before the </Context> tag:
<Resource name="jdbc/SQL" auth="Container" type="javax.sql.DataSource"
maxActive="100" maxldle="30" maxWait="10000"

username="Reportuser"” password="Reportuser"
driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver" validationQuery="SELECT 1"

testOnBorrow="true" url="jdbc:sqlserver://localhost:1433;databaseName=Report"/>
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sREsource nases® jdieg fEeodmart® autle*Centainer® Cype="jarad.igl.bataSeurce”
maxlet ves 100" maxldle=" 30" max¥aiv=" 10000
upername=" jagperdh " passvcrd=" pasresrd”
ar Pverd bansiiame =" gry. poslaresgl . Briver”
wal idat Londeer =" SELECT 1"
reatinbrrrov"trae*
el jller paa baresal S S bocalhost 50 520 eodmar | Puselind code=1 puch e charac L erEncoding
cRepouscn mame="Judbe S0l wut *Cantainer” Lype=" javes.sql.batafource”
maxhot ives"1B0" saxidle="10" saxdait="10909"
userpane=* Reperluser® passvord=Reporiuner”
driwerc assiisee= pom microsoll . sglscerer . Jdbc . AL irrverDriver®
vl idat 1ondeer y=  SELECT 4*
teptimBorrew=" trne" urb="jdbo: palecrrer: Sllocalhost i 1433 et akasecHame=Remorl" />

-4 fCONTERT

5. Navigate to Services » All Programs » JasperReports Server CP 4.2.1.
6. Click on Start or Stop Services.

7. To stop the service, click on Stop Service.

8. To start the service, click on Start Service.

4 Adrmdngtres Took

b Certre @

L FlsTils FTP (et

L Ghosturpt

9. Launch Jasper Report client in your browser: http://localhost:8081 /jasperserver/

a. Login as jasperadmin with password as _jasperadmin.
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Figure (Appendixc N) - 26: Login to Jaspersoft

Welcome to Jaspersoft

— [y
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TLL LD

b. In the Server Repository dialog box, in the Folders pane, right-click on Root folder and select
Add Folder.

Figure (Appendix N) - 27: Server Repository dialog box

Dinsrensor’ QU

E. 1 View . Manage .

Y Folders Repository

c. In the Add Folder dialog box, in the Name (required): text box, type datasonrces.
d. Click on the Add button.
Figure (Appendixc N) - 28: Add Folder dialog box

Add Folder

Narme (required):
datasource

Description:

G

e. Right-click on Datasources and select Add Resources » Data source.
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f. In the Add Source dialog box, enter the following details:

Type : JDBC Data Source
Name (required) :C8_Reporting
Resource 1D : C8_Reporting

Description (Optional) : Driver. Com.microsoft.sqlserver.jdbc.SQLServerDriver

URL : jdbc:sqlserver://localhost:1433;databaseName=Report
User Name : Reportuser

Password : Reportuser

Time Zone : Use database setting.

Save Location : /datasources

Figure (Appendixc N) - 29: Add Data Source dialog box
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g. To verify the new connection, click on the Test Connection button.

JASPER SETUP 270



Centric 8 INSTALLATION GUIDE

Figure (Appendixc N) - 30: Test Connection
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h. Click on the Submit button.

N Similarly, creater another folder for reports. To create a reports folder, refer to
LS step ¢ above.

Configuration Setups in iReport

1. From the Start menu, select All Programs. Click on iReport 4.1.1, to launch the iReport.

B

B Pkt i
Form Lefl Larw n Caprrns.

2. Navigate to Tools » Options.

Figure (Appendixx N) - 31: Jasper iReport Designer 4.1.1
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3. In the Options dialog box, select the Classpath tab. Click on the Add JAR button on the right.
Navigate to the SQL Server jar file and select it. Click on OK.

Ebrrm e | o | s |

4. Click on the Report Datasources icon.

m Lasperinlt Feport De-shgney 4.0.1
|File Edt Wiew Format Preview Took Window Help

5. In the Connections/Datasources dialog box, click on New.

Figure (Appendix N) - 32: Connections/ Datasources dialog box
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6. Select the Database JBDC connection option and click on Next.
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7. To check if the connection is successful, enter the details and click on Test.

8. The Connection test successful message box is displayed. Click on OK.

9. Click on Save.
=]
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10. In the Connections/ Datasource dialog box, click on Close.

-

LI"ETE The newly created Data source is displayed in the Home Page.
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Wildfly8 Jasper Reports Setup Instructions
1. Open Edit module.xml (path: %Wildfly8
Installation%\modules\com\centricsoftware\pi\main\module.xml)
. In between the <resources> tags, add:

<resource-root path="com-jaspersoft-ireport.jar"/>
<resource-root path="com-jaspersoft-ireport-jasperserver.jar'/>
<resource-root path="commons-beanutils-1.8.0.jar"/>
<resource-root path="commons-digester-1.7.jar"/>
<resource-root path="commons-logging-1.0.4.jar"/>
<resource-root path="itext-2.1.7.jar"/>
<resource-root path="jasperreports-4.1.2.3.jar"/>
<resource-root path="jasperserver-api-common-4.2.0.jar"/>
<resource-root path="jasperserver-api-common-impl-4.2.0.jar"/>
<resource-root path="jasperserver-common-ws-4.2.0.jar"/>
<resource-root path="jcommon-1.0.15.jar"/>
<resource-root path="jfreechart-1.0.12.jar"/>
<resource-root path="poi-3.6.jar"/>

2. Copy the following jar files to C8 modules directory (path: %Wildfly8
Installation%\modules\com\centricsoftware\pi\main) :

= C:\Program Files\jasperreports-server-cp-4.2.1\ireport\ireport\modules\com-jaspersoft-
ireport.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\ireport\ireport\modules\com-jaspersoft-
ireport-jasperserver.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\commons-beanutils-1.8.0.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\commons-digester-1.7.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\commons-logging-1.0.4.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\itext-2.1.7.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\jasperreports-4.1.2.3.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\jasperserver-api-common-4.2.0.jar
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= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\jasperserver-api-common-impl-4.2.0.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\jasperserver-common-ws-4.2.0.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\jcommon-1.0.15_jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\jfreechart-1.0.12.jar

= C:\Program Files\jasperreports-server-cp-4.2.1\apache-
tomcat\webapps\jasperserver\WEB-INF\lib\poi-3.6.jar

3. Restart the Centric Wildfly service to complete the changes

-

NOTE
|

With the given changes there are no additions made to C8\wildfly-
8.1.0\bin\standalone.conf.bat as there were previously
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Excel Export Format

The following settings are available for Excel export format:
External viewer

An absolute path to the executable to use for Excel preview.
Remove empty space between rows

Flag that indicates whether the empty space should be suppressed.
White page background

Flag that indicates whether white page background should be used in the export generated
document.

Auto-detect cell type

Flag that indicates whether excel cell type should auto-detect and set in the generated Excel
document.

Ignore pagination

Flag that indicates that the report should be printed on a single page. If true, the height of
the page is increased automatically to fit the whole document.
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0. CONFIGURE HTTPS

Pre-requisites

1. SSL Certificate should be in the .pfx format.

Adobe PLM Connect, requires an SSL certificate issued from only one of the three
Certificate Authorities namely GlobalSign, Verisign, and Thawte. Adobe does NOT
# support any other Certificate Authority, such as GoDaddy.
NOTE

— If you are using Adobe PLM Connect with Centric, you MUST have a certificate issued
from one of these three Certificate Authorities (GlobalSign, Verisign, and Thawte).

2. Installation Password for the SSL Certificate .pfx file is required. The password is generated at the
time SSL Certificate is created by the Certificate Authority.

3. Download the URL Rewrite 2.x from Microsoft Download Site

(http://www.iis.net/downloads/microsoft/url-rewrite)

4. Verify that all Firewalls are set to allow traffic on the https port (443)

Check the local windows server for Firewall settings; whether it is built-in Microsoft
Windows Firewall or possibly a third-party software Firewall solution.

NOTE If you have any hardware firewalls, ensure that https port (443) traffic is allowed

— through to the Windows Server. These firewall settings may require actions by the
Customers IT Support and Network Administrators. Ensure that these settings are
made prior to attempting installation of the certificate.

Install URL Rewrite Extension

Once you have the SSL Certificate in .pfx format and the Certificate password, install the URL
Rewrite module.

» How to install the URL Rewrite module

1. Browse to the URL http://www.iis.net/downloads/microsoft/url-rewrite and click on Install this
extension button.

Figure (Appendix O) - 1: URL Rewrite module URL details
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2. To install the Web Platform Installer, click on the Install Now button.

Figure (Appendix O) - 2: Web Platform Installer dialog box

Installs powered by the Microsoft Web Flatform Installer

By downloading and using the Web
Platform Installer {Web PI), you agree
to the license terms for the 'web PI.

Please leave this window open until the Microsoft web Platform Installer starts.

3. To install the .exe file, in the Open File » Security Warning dialog box, click on Run.

Figure (Appendix O) - 3: Open File - Security Warning dialog box
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you brust. What's the risk?

-

4. To begin the Installation process, in the Web Platform Installer 5.0 dialog box, click on
Install.
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Figure (Appendix O) - 4: Web Platform Installer 5.0 dialog box

¥ seb Matlam sl sl L0 -,I.:l,:_l .
© URL Rewsite 2.0

URL Rty 20 Tor B0 T astaredt 1 Foamdwnod of rube 218 LRL prarisns viath, mins s port st ciiteteondd apaiits. mila 1
wred wth reres cnpabdity o 1et WTTH regra ot bascdern iead B3 1eever vasablia. Tha new 1t of festura prowsden
renafirinn with comphits confrol over the UL frscturs uiedl by soofeg o hgeoy sk ppbostons St cernat b
rrecdderd 43 ribraly o wotr e taeth aroee frardy ULy

it fom: & b il
Varsorc 10

bt dute: Wadrasduy, Wiy 10, 1028

ol Een |

5. To accept the License terms and conditions, Click on 1 Accept.

Figure (Appendix O) - 5: Web Platform Installer 5.0 dialog box (2)
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6. To complete the installation process, click on Finish.
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Figure (Appendix O) - 6: Web Platform Installer 5.0 dialog box (3)
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7. To exit from the application, click on Exit.

Import the SSL Certificate

1. From the Start menu, open Internet Information Services (11S) Manager.

Figure (Appendix O) - 7: Start Menn
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2. Click on a server name in the left pane.
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3. In the middle pane, under the 11S section, click on Server Certificates.

4. In the right pane, click on Open Feature.

Figure (Appendix O) - 8: Connections Window
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5. The middle pane displays Server Certificates...
6. In the right pane, under Actions, click on Import...
Figure (Appendix O) - 9: Connections Window - Actions pane
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7. In the Import Certificate dialog box, click on the Browse button.

8. Browse to the location where you have saved the SSL Certificate in .pfx format.
Figure (Appendix O) - 10: Import Certificate dialog box
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[ |
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9. Select the required Certificate name and click on the Open button.
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Figure (Appendix O) - 11: Select Certificate
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10. The selected certificate is displayed in the Certificate file (.pfx) field in the Import Certificate
dialog box.

11. In the Password: text box, type the password for the SSL Certificate.

N;TE The SSL Certificate password is generated during the SSL Certificate creation and is
| provided by the Certificate Authority.

12. From the Select certificate store drop down box, choose Web Hosting and click on OK.

-

NOTE In the Select Certificate Store section, by default Personal will be selected.
|

Figure (Appendixc O) - 12: Import Certificate dialog box (2)
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13. Verify that the Imported Certificate appears in the middle frame of the Server Certificates
window.
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Figure (Appendix O) - 13: Server Certificates Window
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14. In the left frame of the Internet Information (11S) Manager Window, drill-down into the Sites

folder and click on Default Web Site.

Figure (Appendix O) - 14: Connections Window
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15. In the right frame, under Actions, click on the Bindings... menu item.

Figure (Appendixc O) - 15: Actions section - Bindings
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16. In the Site Bindings dialog box, click on the Add... button.
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Figure (Appendix O) - 16: Site Bindings dialog box
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17. In the Add Site Binding dialog box, add the following:

= From the Type: drop-down list, select https

= From the IP address: drop-down list, select All Unassigned unless the customer
identifies a specific IP address.

* In the Port: text box, type 443
= The Host name: field is either greyed out or empty.
= From the SSL certificate: drop-down list, select the certificate that you just imported.

18. To accept the settings, click on OK.

Figure (Appendix O) - 17: Add Site Binding dialog box
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19. In the Site Bindings dialog box, in the Site Bindings table, verify that the Type A#ps with Port
443.
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Figure (Appendix O) - 18: Site Bindings dialog box - Site Bindings table
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20. To complete the Certificate configuration, click on the Close button.

N;TE The URL Rewrite icon will now be displayed in the Internet Information Services
| (11S) Manager Window in the Default Web Site Home pane.

» Make sure SSL certificate Server URL is added as trusted site to IE internet options
NOTE dialog
L3

Configure Automatic HTTP to HTTPS rewrite

1. Open Internet Information Services (11S) Manager.
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Figure (Appendix O) - 19: Start menu
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2. In the left frame, drill-down the Sites folder and click on the Default Web Site.

Figure (Appendix O) - 20: Sites folder
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3. In the 11S section, select URL Rewrite.
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Figure (Appendix O) - 21: 1IS section - URL Rewrite
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4. In the right-hand pane, under Actions section, click on Open Feature.

Figure (Appendix O) - 22: 11S' - Actions section
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5. The center pane displays the URL Rewrite details.

6. In the right pane, in the Actions section, click on Add Rule(s)

Figure (Appendix O) - 23: URL Rewrite details window
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7. The Add Rule(s) dialog box is displayed.

8. In the Inbound Rules section, click on Blank Rule and then click on the OK button.
Figure (Appendix O) - 24: Add Rule(s) dialog box
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9. In the Edit Inbound Rule dialog box, add the following:

= In the Name: text box, enter a descriptive name, such as Redirect http to htips

= In the Match URL frame, from the Requested URL: drop-down list, select Matches the
Pattern.

* From the Using: drop-down list, select Regular Expressions.
= In the Pattern: to text box, type (.*)

= The Ignore case checkbox is selected by default.

Figure (Appendix O) - 25: Edit Inbound Rule dialog box
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10. In the Conditions frame, from the Logical Grouping: drop-down list, select Match All.

Figure (Appendix O) - 26: Conditions Window
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11. In the Add Conditions dialog box, add the following:
= In the Condition input: dialog box, type {HTTPS}
®"  From the Check if input string:, select Matches the Pattern

= In the Pattern: field, type “"OFF§
= Verify that the Ignore case checkbox is selected.

12. Click on the OK button.
Figure (Appendix O) - 27: Add Condition dialeg box
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13. In the Edit Inbound Rule dialog box, add the following:
= In the Action frame, from the Action type: drop-down list, select Redirect

. In the Action Properties section,
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e In the Redirect URL: type Jips://{HTTP_HOST}/{R:1}

Verify that the Append query string checkbox is selected.

From the Redirect type: drop-down list, select Permanent (301).

14. In the right pane, in the Actions sections,
= Click on Apply.

= Click on Back to Rules.

Figure (Appendix O) - 28: Actions section
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Figure (Appendixc O) - 29: Web Platform Installer Window
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Modify Centric 8 configuration files to function properly using the https protocol

»

MNOTE
H Customer Name.

‘xxxx’ denoted in the configuration lines below must be changed to reflect the actual

1. Edit standalone-pi-zssgi-xml and change the following two configuration lines,

= com.centricsoftware.AppServer.HomeURL = http://XXXX/WebAccess/home.html

Change as follows:

CONFIGURE HTTPS

290



Centric 8 INSTALLATION GUIDE

= com.centricsoftware.AppServer.HomeURL=
https://xxxx.centricsoftware.com/WebAccess/home.html

com.centricsoftware.AppServer.HomeExternalURL = http://XXXX/WebAccess/home.html
Change as follows:

com.centricsoftware.AppServer.HomeExternalURL=https://xxxx.centricsoftware.com/WebAccess/
home.html

2. Edit PDFService.cfg and change the following two configuration lines:
= Service Name=XXXX
Change as follows:
Service Name=xxxx.centricsoftware.com
= Server URL=http://XXXX/csi-requesthandler/RequestHandler

Change as follows:

Server URL=https://xxxx.centricsoftware.com/csi-requesthandler/RequestHandler

o Failure to make these changes will result in PDF generation failure, especially when
using Internet Explorer to generate PDF files.

e
IMPORTANT

3. Edit ImageService.cfg and change the following two configuration lines:
= Service Name=XXXX
Change as follows:
Service Name=xxxx.centricsoftware.com
= Server URL=http://XXXX/csi-requesthandler/RequestHandler
Change as follows:

Server URL=https://xxxx.centricsoftware.com/csi-requesthandler/RequestHandler

o Failure to make these changes will result in Image generation failure.

s
IMRORTANT

Change PDF and Image Service Protocol to HTTPS

Do the following changes to PDF and Image Service Protocol in the Centric Software:
1. Navigate to Service » Image/PDF tab.

2. In the Image Service Settings and PDF Service Settings sections, click on Edit icon from the
Actions column
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Figure (Appendix O) - 30: Image/ PDF Service Protocol
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3. In the Edit dialog box, from the Service Protocol (for Image Service)/PDF Service Protocol (for
PDF Service) drop-down menu choose https and click on Save

Figure (Appendix O) - 31: Image Service Protocol Edit window
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Figure (Appendix O) - 32: PDF Service Protocol Edit window
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Activate changes

1. Navigate to Start » Control Panel.
2. Click on Administrative Tools.

3. Click on Services.
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Figure (Appendix O) - 33: Start Menu - Services
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4. In the Name column, locate the Centric WildFly-8.1.0 Service.

5. Right-click on this service and choose the Restart option.

Figure (Appendix O) - 34: Services Window - Wildfly Restart option
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6. View the pi_centric.log file. When it indicates Centric 8 has successfully started, in the Name
column, locate the World Wide Web Publishing Service.

7. Right-click on this service and select the Restart option.
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Figure (Appendix O) - 35: Services Window - WWW Publishing Service Restart option
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Verify that you can access the Centric 8 application

1. The following URL will display the Centric 8 login page:

https://xxxx.centricsoftware.com/webaccess

2. The following URL will re-direct you to https://xxxx.centricsoftware.com/webaccess and display
the Centric 8 login page:

http://xxxx.centricsoftware.com/webaccess

3. The following two URLs will display an error message — This is no longer a valid URL to use.

http: //XXXX//WebAccess

http://localhost/webaccess

4. The only valid URL is as follows:

https://xXxxx.centricsoftware.com/webaccess

CONFIGURE HTTPS 294


https://xxxx.centricsoftware.com/webaccess
https://xxxx.centricsoftware.com/webaccess
http://xxxx.centricsoftware.com/webaccess
http://xxxx/WebAccess
http://localhost/webaccess
https://xxxx.centricsoftware.com/webaccess

Centric 8 Installation Guide

Index

A

About
Getting more information, vi
Installation Guide, vi
Using the Guide, vi

Adding Wildfly Plug-In, 66
Add Wildfly Plug-in, 66
Register ISAPI filter, 66

Backup Procedures
Automatic, 92
Database Backup
SQL Server Management Tools, 87
FileVault, 90
Manual Backup, 87, 98
Oracle DB, 109

C

Centric 8
Backup and Recovery Procedures, 81-82, 81-82, 81-82
Backup Procedures
SQL Server, 87
Backup Procedures for SQL Server
Backup, 87, 98
Checklist
Performance Tuning, 85
Post Installation, 84
Create
Database by Script, 149
Database Manually, 150
Database
Import/Export Utility, 154
Database Upgrade, 154
Database Utilities, 159
HTTPS Support, 219
Image Service, 215
Installation, 69
LDAP Setup
with SSL, 216
Modules, 71
Monitoring Servers, 83
PDF Print Service, 214
Recommended Practices, 81-83
Uninstall, 120

Centric 8 Database
Import/Export Utility, 154-58
Centric 8 Installation
Operation Application, 75
PLM Application, 69, 71
Centric 8, Backup
Frequency of Backups and Recovery, 81
Checklist
Installation, 13-14
Post Installation, 84
Configuration
SMTP
on Windows 2012 Server, 208
Windows 2000 Server, 187
with 11S 6.0, 187
with 11S 7.0, 200
Wildfly Configuration, 66
Configuration and Testing, 66
Configure
HTTPS, 258
Conventions, vi
Create
Centric 8 Database by Script, 149
Centric 8 Database Manually, 150

D

Database
SQL Server
Backup, 87
Restoration, 97, 98
Drive Structures
Dual Server, 15
Single Server, 15
Dual Server Software
Computer 1 Installation, 40
Computer 2 Installation, 52,167, 169

F

FileVault
Location, 104-8
Restoration, 104
Location, 104

Image

295



Centric 8 Installation Guide

Upload Timeout, 179 HTTPS, 14
IIS Connection Settings, 179 Oracle 11G Software, 14
Upload Timout Oracle Database, 15
Adjust Content Length for 11S7, 179 Oracle DB Components, 15
Index System Admin Privilege, 14
Database Tables, 83
Installation, 9 S
Application Software, 69
Centric 8 PLM Application, 69, 71 Setup
Dual Server, 10 Cluster App1, 169-70
Dual Server Software, 40, 167, 169 Cluster App2, 170-71
Pre-requisites, 14 Jasper, 236
Roadmap, 9 Single Server
Single Server, 9 Microsoft SQL Server, 24
Single Server Software, 17 Oracle Database, 29
Installation Checklist, 13 Software Installation, 17
Hardware, 13 SQL Server
Software, 13 Backup Procedures, 87-97
Supported Browsers, 13 Database Restoration
Different Server Instance, 98, 103
L Restoration Procedures, 97, 98
Licensing, 212 T
User License
Install, 212 Testing
Manage, 212 Server Installation, 68
o w
Oracle Administrator Wildfly
Create Database Change SMTP Server Information, 229
11.2.0.3+, 122 Cluster, 161
11.2.0.4+, 123 Environment Setup, 162-74
Pre-requisites, 122 Requirements, 161
Tuning Consideration, 160 Cluster App2, 171
Oracle DB ClusterApp1, 171
Backup, 109 Configure, 66
FileVault Backup, 112 Failure to stop, 178
FileVault Restoration, 117 Memory Usage
Restore Database, 112 Change, 176
Plug-in, 66
P Previously Installed Version, 66
Service Warning, 177,178
Pre-requisites, 14 Troubleshoot, 176
Drive Structures, 15 Virtual Directory, 66
for Virtual Directory Setup, 67
Centric 8 Installation, 14 Wildfly Plug-in
HTTPS Configuration, 255, 258 Web Server 8.0, 66
Oracle Administrator, 122 Wildfly, Virtual Directory Setup
WebAccess Shared Directory Installation, 172 IIS Web Server 8.0, 67

296



Centric 8 Installation Guide

Table of Figures

FIGURE 1-1: SINGLE SERVER INSTALLATION iiiiiiiiiiiiieieieieeeeeeeeeeeeeeeeseeseeseeseeseeseeeeeesessseessesesssesessseseseeseeseseesseseseseseseeeseseseseserenen 9
FIGURE 3-1: WELCOME DIALOG BOX.eeettieeeieieieieieeeieeeeeeeeeeseseseseeeeesssesssessessesssssesesesesssesssssesssesesssesssseesesesssesesessseseseeesesesereren 17
FIGURE 3-2: END USER LICENSE AGREEMENT DIALOG BOX ceeveveerrereereeeeeeeeeeeeeeeereeeeeeeeeeessessesssesssesesssesssesesesesssesesesesesessessesesesenen 18
FIGURE 3-3: USER INFORMATION DIALOG BOX. 1eeeeeeeeeririeieeeeeeeeseeeseeeeeseeeeesesssesssesssesssesssesesssssssesesssesssesssesssssssssesssesesessseseseeesen 18
FIGURE 3-4: USER INFORMATION DIALOG BOX 1eeeeeeeeeieieieeeieeeeeereseeeeeeeseeeeesesssesssesssesssesssesesssesssssesssesesssssssssssssesssesssesesssessseseren 19
FIGURE 3-5: INSTALL CENTRIC 8 OR DATABASE ONLY DIALOG BOX ceeevveeerererereeeeereeeeeeeeeeeseeesesesesesesesesssesesssesesssssesesesesesssesessseseren 19
FIGURE 3-6: CHOOSE CENTRIC 8 LICENSE LOCATION DIALOG BOX ceveerreeerrereereeeeeeeeeeeeeeeeeseeeseseeeseseseseseseseeesssesssssesesesesesesesesssssenen 20
FIGURE 3-7: CHOOSE NEW OR EXISTING APPLICATION SERVER....cccitttiiiiiiiiereeeieeeeeeeeeeeseseseseseeeeesesesseeseessesesesssssesssssesesssssesssesesen 21
FIGURE 3-8: SELECT AUTHENTICATION MODE DIALOG BOX - CENTRIC AUTHENTICATION .ceteieiereiereeeeeeeeeeeeeeeeesereeeeeeeseseseeeeeseseseeesens 22
FIGURE 3-9: SELECT AUTHENTICATION MODE DIALOG BOX - LDAP AUTHENTICATION ..ceeteiereeereeeeereeeeeeeeeeeeereeeeeeereeesesereeeeeseeeseeesens 22

FIGURE 3-10: ENTER LDAP SERVER INFORMATION DIALOG BOX vvvuuuneeerererruunareeeseeesssnneseeesssssssnmeeeesssssssnnsneeesssssssnneeessssssssnnneneees 23

FIGURE 3-11: CHOOSE JAVA DEVELOPMENT KIT (JDK) INSTALLATION DIRECTORY DIALOG BOX ..veeeeeurreeeeureeeesureeeeaseeeesisseesensseseeanns 23
FIGURE 3-12: SELECT DATABASE TYPE DIALOG BOX.eeeeteeeeeerereeereeeeeeeeeeeeeeeeeeesesesesesesesesesesssseesesesessseseseseseseseeesesesessseseseseessssenen 24
FIGURE 3-13: CHOOSE DATABASE SERVER LOCATION DIALOG BOX.eeeeeeeeeeereeeeeereeeeeeeeeeeseseeeeeseeesesesesesesesesssesessessssesesesessesseeesssenen 25
FIGURE 3-14: MS SQL SERVER INFORMATION DIALOG BOX eeeeeeeereerreeereeeeeeeeeeeeeeeeeeeeesesssesesssssesesesssessseessesesssssesssesssesssssssssesssen 25
FIGURE 3-15: ENTER CENTRIC8 ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX eeeevverereeeeeerereeeeeeeeereeeeereeeeeseeeeeseeesesenens 26
FIGURE 3-16: ENTER CENTRIC 8 DATABASE INFORMATION DIALOG BOX.eeeeteererererreereeeeeeererereseeeeeeereseseseeeeesesessesseseseseseseseseeessseren 26
FIGURE 3-17: CHOOSE NEW OR EXISTING DATABASE DIALOG BOX..eeeeteererirereeeeereeeeeeeeeeeseeeeeeseeseeesesssesssssssssssssssssssesssesssssssssssesen 27
FIGURE 3-18: CHOOSE DATABASE LOCATION DIALOG BOX.eeeeeeeeeerereeeeereeeeeeeeeseseeesesesseesssssesssesssesesssesssssssesssssssssssssssesssssesssssenen 27
FIGURE 3-19: CHOOSE FILE VAULT LOCATION DIALOG BOX.eeevteerereereereeeeeeeeeeereeeeeeeseseeesesesesssesssesesssesssssesesesssssesesesssesesssesessmenen 28
FIGURE 3-20: CHOOSE WEBACCESS LOCATION DIALOG BOX.eeeetereeirieirireeeeeeeeeseeeeeeeeeseseseeesesssesssesesssesesesssssssssssesesesesssssssessssseren 28
FIGURE 3-21: CHECK SETUP INFORMATION DIALOG BOX.eeeeeeereeererieieeeereeeeeseseseseseseeesesesssesesssssssesesssesssssssssssssssesesssssessessesssesenen 29
FIGURE 3-22: SETUP COMPLETE DIALOG BOX.eeeteteeeeeeeeeeeeeeeereeeeeeeerseeeeesseeeseesesseesesesesesseesesseesesesesesesesesesesesssesesssesesesssesesesssenen 29
FIGURE 3-23: SELECT DATABASE TYPE DIALOG BOX.eeetteeeeeerereeereeeeeeeeeeeeeeeseeeseseseseeeeesesesesesssesssesesssesesesesesesesesesessseseseseseeesesenen 30
FIGURE 3-24: CHOOSE DATABASE SERVER LOCATION DIALOG BOX.teetteereeirereeeeereeeseeeeeseseeeseeeseseseeesssessssessesssssssssesesesesssssssssssesen 30
FIGURE 3-25: ENTER ORACLE SERVICE NAME DIALOG BOX eeeetveeererrerreeeeeeeeereeerereeesesesesesesesesssesesesesssesesesssesesssesesesesesesssesesesssnsen 31
FIGURE 3-26: ORACLE SERVER INFORMATION DIALOG BOX.eeeveeererrereeereeeereeeeeeeseeeeeeesesesesesesssesssesesssesessessesesssssesesssessseessssesssenen 31
FIGURE 3-27: ENTER CENTRIC 8 ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX.eeevererrrererereeereeeeeseeeeeseeeseseseeeeeseesseeeeens 32
FIGURE 3-28: ENTER CENTRIC 8 DATABASE ADMINISTRATOR USERNAME AND PASSWORD....cccvtieiiiiieiieireeeeeeeeeeeeeeeeeeeeeseeeseseeeseeeeens 32
FIGURE 3-29: CHOOSE NEW OR EXISTING DATABASE DIALOG BOX.eeeeveeeeeeerereeeeeeeeeeeeeeeeeeeeereseeeseeeeesesesesesssesesesssereressseessssesesssesen 33
FIGURE 3-30: CHOOSE NEW OR EXISTING DATABASE DIALOG BOX..eeeeteererieereeeeereeeeeeeeeeeseeeeeeeeesesesesssesssssesesssssssssssesesssesssesssesssen 33
FIGURE 3-31: CHOOSE FILE VAULT LOCATION DIALOG BOX.eeevteeeeeeereeeereeeeeeeeeseseeesesesesesssesesssesssesesssesesssssssssssssssssssssssssssesssesesen 34
FIGURE 3-32: CHOOSE WEBACCESS LOCATION DIALOG BOX.eeeeeeeereeereeereeeeeeeeeeeeeeeeeeeeeeeseseseseseseseresesesssesssesesesssesesesssssesesesessseren 34
FIGURE 3-33: ENTER SMTP MAIL SERVER NAME AND EMAIL ADDRESS DIALOG BOX.eeveverererereeeeerereeeeerereeeeeseseseeeseseseseseseesseseseserees 35
FIGURE 3-34: SELECT PROGRAM FOLDER DIALOG BOX..eettieiiiiiiererieieeeeeeeeeeseeeeeseeeseeesesesesesesesesssesesssesessessesssesssesesesssesssesessssseren 35

FIGURE 3-35: CHECK SETUP INFORMATION DIALOG BOX.eetetetieeererieeeeeeeeeeeeseeeseseeeeeeesseesesesesssesssesesssesssssssssssssssesessssseseessesssesesen 36
FIGURE 3-36: SETUP COMPLETE DIALOG BOX.eeeeeeeeeeeeeeeeeeeeeeeeeereeeereeeeeseseeseeesessesseeesesesssesesssesesesesssesesesseesesesesesesesesesseesesesssnnen 36
FIGURE 3-37: CONNECT TO SERVER DIALOG BOX 1eeteteiiieieieieieeeeeeseeeeeeeseseseseeesesssesesesssssssssssssessessesssesssssssssesesssesesesssesesssesesseeren 37
FIGURE 3-38: DETACH DATABASE DIALOG BOX teeeetiiiiiirieieieereeeeeeeeeeeeeseeseeseseeesesesesesssesssssesesssssesessssssssessssesssssessessesessseseseseresen 38
FIGURE 3-39: ATTACH DATABASES DIALOG BOX 1eveteeeeeeeeeereeeeeeeeeeeeeeeeeeseeeeeseesesseesesessssssessesssesesesssssesesesesesessesseseseseseseseseeeseseren 39
FIGURE 3-40: ATTACH DATABASES DIALOG BOX 1eveeeeeeeeeeeeeeeeeeeeeeeeereeeeeeeeeeeseeeessessesesseesssssssssesssesesssesesesesesessessesesesesesesesesessseren 39
FIGURE 4-1: WELCOME DIALOG BOX.eeetiieeiirieieieieieieieeeeeeseseeeseeeeesesesesssssssssesssesssesssssssssssssesesesesssesssssesesesesssesesesesesesesessseseren 41
FIGURE 4-2: END USER LICENSE AGREEMENT DIALOG BOX ceevevreeerrrereereeeeeeereeeeereeeeseeeesesseesesssesssesesssssesesesesesssssesesesesesesssesesesesen 42
FIGURE 4-3: END USER LICENSE AGREEMENT DIALOG BOX ceeeeveeerereereeeeeeeeeeeeeereeeeeeeeeeeseseessesseesssesesesesesesssesesssssesesesesesesesesesesenen 42
FIGURE 4-4: CHOOSE DESTINATION LOCATION DIALOG BOX.eeeteeeeeieereeereeeeeeeeeseseeeseeeeesesssesesssessessesssesesssssssssssssssesesssesssssssssesssen 43




Centric 8 Installation Guide

FIGURE 4-5: INSTALL CENTRIC 8 OR DATABASE ONLY DIALOG BOX ceeeveeererrereeeeeeereeereeeeeeeseeeseseseseseeesesssessessesesssssesssesssesesssssssssenen 43
FIGURE 4-6: CHOOSE CENTRIC 8 LICENSE LOCATION .ciiiiiiiiiiiiiieiieeieeeeeeeeeeeeeeeeeseeeseeeeseaeeeeesssesesesesssesesesseesessssseseseseseseeesesesereren 44
FIGURE 4-7: CHOOSE NEW OR EXISTING APPLICATION SERVER DIALOG BOX..eeeeerereeerereeerereeeeeeeeereeeeesesesssesesssssssssssesesssssssssssssssesen 45
FIGURE 4-8: SELECT AUTHENTICATION IMODE DIALOG BOX.eeetveeerereeeeeeeeeeeeeeeeeeeeeeeseeeeesesesesesssesssesesssesssseesesesssesesesesessseessessssmeren 45

FIGURE 4-9: SELECT AUTHENTICATION IMODE DIALOG BOX.eeetvteererrereeeereeereeeeeeeeeeeeeeeeeeeseseseessesesesesssesssssesesesessseseseseseessesesessseren 46
FIGURE 4-10: ENTER LDAP SERVER INFORMATION DIALOG BOX eeeeeeeeeieererereeeeereeeseeeseeesesesesesesssesesssesssssssesesssssssssssssesssssesssesesen 46
FIGURE 4-11: CHOOSE JAVA DEVELOPMENT KIT (JDK) INSTALLATION DIRECTORY DIALOG BOX .vveeuveerereesveesereesseessreessseessesssseesanes 47
FIGURE 4-12: SELECT DATABASE TYPE DIALOG BOX.eeetteeeeeeeereeereeeeeeeeeeeeeeeseeeseseseseeesesesseesesseesssesesssesessssseseseseseseseseseseseseessesenen 47
FIGURE 4-13: CHOOSE DATABASE SERVER LOCATION DIALOG BOX.eeeetrereeirereeereeeeeeeeeeeeeseeeseessesesesesssesssssssesssssssesesssssesssssssssesesen 48
FIGURE 4-14: DATABASE SERVER INFORMATION DIALOG BOX ceeeeeeeieirieereeeeeeeeeeeeeeeeeeeeesesseeseessesseesesssesesssesssssesssesesssssssssssssssasesen 48
FIGURE 4-15: DATABASE SERVER INFORMATION DIALOG BOX ceeveeeererereereeeeeeeeeeeeeeereseeeeesesesesesessseeesesssesesesesesssesesesesesesesssesssssenen 49
FIGURE 4-16: ENTER ORACLE SERVICE NAME ...ciiiiiiiiiiiiiiiieiieeeeeeeeeeeeeeeeeeeeeeeeeeeeeseeeeeseaeesseaesasesesessseseseseeeseseesseseeesesereeeseseeeeenen 49
FIGURE 4-17: ENTER CENTRIC 8 ADMINISTRATOR USERNAME AND PASSWORD.....cciitiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeseseeseseeeeseeeesssssessesesens 50
FIGURE 4-18: ENTER CENTRIC 8 DATABASE INFORMATION DIALOG BOX.eeeetverererereeereeeeereeereeeeeeeeeeeeesesesesesesesesssesesesesesesesesssesssesen 50
FIGURE 4-19: CHOOSE FILE VAULT LOCATION DIALOG BOX.tetvteerereerreeeeeeeeeeeeeeeeeeeseeeseseseseseessesesesesssesesesesesesesssesesesesesssssssessseren 51
FIGURE 4-20: CHOOSE WEBACCESS LOCATION DIALOG BOX.eeeeeeieririeieereeeeeeeeeeereeeeeeeeeeeeseeseseeesesesesssessssssssssssessssesssssesssssesssesesen 51
FIGURE 4-21: ENTER SMTP MAIL SERVER NAME AND EMAIL ADDRESS DIALOG BOX.eeevererererererereeereeereeeseeeseeeseesessesesessessssesssseesen 52
FIGURE 4-22: SELECT PROGRAM FOLDER DIALOG BOX.ettteeeeeereeeeereeeeeeeeeeeeereeereseeesesesesesesesesssesesesesesesesesssesesssssesesesesssesesesessseren 53
FIGURE 4-23: CHECK SETUP INFORMATION DIALOG BOX.eeteteireeererieererereeeseseeeseseseseeeseseessesesesssssesssssesssssssssssssssesesessseseessesssesesen 53
FIGURE 4-24: WELCOME DIALOG BOX.eeeettieirieirieieieeeeeeeeeeseseseseeseesesesessssssessesssesseesssssssesesssesssesesssesesssesesssessseseseseseeesesessseraren 54
FIGURE 4-25: END USER LICENSE AGREEMENT DIALOG BOX ceeveeerereereeeeeeeeeeeeeeeeeeeeeseeeesesseesesssesssesesesesssesesesesssssesesesesesesssesesssesen 55
FIGURE 4-26: USER INFORMATION DIALOG BOX 1eeeteeeeereeeereeereeeeereeeeeeeeeeeeeseeesessessesesesssssssesssssssesesssesssesesesesesssesesesesesssesesessseren 55
FIGURE 4-27: CHOOSE DESTINATION LOCATION DIALOG BOX.1teteereeereeereeeeereeeseeeeeeeeesesesseesesssesssesesssesesssssssssssssssesesssssssssessssseren 56
FIGURE 4-28: INSTALL CENTRIC 8 OR DATABASE ONLY DIALOG BOX 1eeeeeeeeereereereeeeeereeeeeeeseeesesesesesesesesssesesssssessssssssseseseseessessssseren 57
FIGURE 4-29: SELECT DATABASE TYPE DIALOG BOX.eeeveteeeeeerereeereereeeeeeeeeeeeseeeseseeeseseeesessseseessessseseessesesesssesesesesesesssesesesesesesssenen 57
FIGURE 4-30: MS SQL SERVER INFORMATION DIALOG BOX eeeeeeeereeirerereeeeeeeeeeeeeeeeeeeeeeesssssesssssesesesssesesssssesesssssesssesssesssssssssssesen 58

FIGURE 4-31: ENTER CENTRIC 8 ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX.eeeverererrrererereeeeeeeeereeeseseseseeeseessesssesesens 58
FIGURE 4-32: ENTER CENTRIC 8 DATABASE INFORMATION DIALOG BOX.eevtveeerererererererereeeeereeeeereeeeesesesesesesesessessesssesesesesesesessseren 59
FIGURE 4-33: SELECT DATABASE TYPE DIALOG BOX.eeteteieieieereeeeeeieeeeeeeeeeeeseeeseseseeesesesesssesesssesssesesssessssssessesssssesssssssesssesessresesen 59
FIGURE 4-34: ENTER SERVICE NAME ..ciiiiiiiiiiiiiiiiiieceeeeeee e eeeeeeeeee e e e e e e e e e e e e eeeee e e e e e e e e e e e e aeeeaeeaaesaaeseseseseseeeserereeeeeseeeseeeeeeeserereeenen 60

FIGURE 4-35: ORACLE SERVER INFORMATION DIALOG BOX.eeeeeeererreerereeeeeeeeeeeeeeeeeseseeesesesesesseesssesesesssssesesesesssssesesesssssesssesessseren 60
FIGURE 4-36: ENTER CENTRIC 8 ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX.eeeevvrererrrerereeeeeeereeereeeeereresereeesesesesesenens 61
FIGURE 4-37: ENTER CENTRIC 8 DATABASE ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX..eeveverererererereeeeeeeeeeeeeeeeereeeeens 61
FIGURE 4-38: CHOOSE NEW OR EXISTING DATABASE DIALOG BOX.eeeeveeeeeerrereeeeereeeeeeeeeeeeeeereeeeeeeeesesesesesesssesesssssesesessssessssesessresen 62
FIGURE 4-39: CHOOSE DATABASE LOCATION DIALOG BOX.eevereeerererereeeeeeereeeeeeeseeeseeesesesesesesssesesesesesesessessesesssesesessseseseessesessseren 62
FIGURE 4-40: SELECT PROGRAM FOLDER DIALOG BOX..eeteiieiireiiierieeeeeeeeeeeeseeeseseeeseeesesesssesssesesssesesssesesssssssssssssssesesesesssesssssssenen 63
FIGURE 4-41: CHECK SETUP INFORMATION DIALOG BOX.eetetetrieerereeireeereseeeeeeeseseseeeeeessesssesssssssseesesssesssssssssssssssesesesssessessesssssenen 63
FIGURE 4-42: SETUP COMPLETE DIALOG BOX.eeteeteereereeeeeeeeeeeeeereeeeeeesesssseeseeesessessssesesesssesesseesssesessseseseeeseseseseseseseseseseeeseeessseren 64
FIGURE 4-43: CONNECT TO SERVER DIALOG BOX 1eeteteiiieieieieeeeeeeereeeeeeeseeeeeseeseeseeesssesesesesssssssesssssssssesesssssssssssssesesesssesesssesesssesen 64
FIGURE 4-44: DETACH DATABASE DIALOG BOX 1eetetiiiiiieieieieereeeeeeeeeseeeseeeseseeseesesesssesssssssssesesssssssesssesssssssessssessesssssessseseseseseseren 65
FIGURE 4-45: DETACH DATABASE DIALOG BOX eeeetieeeeerereeeeeeeeereeeeeeeeeseeeeesesesessessesesesesesesesssesesesesesesesesesesesssesesesssesssesesesesesesen 65
FIGURE 4-46: EXPLORER WINDOW ..ceeeieieeeeiereereeeeeeeeeeeeeeeeeseeeseeseesesesessseseeesessessesssssesssssssesesesesesssesesesesesesesesesesesesesesesesesesesen 66
FIGURE 4-47: ATTACH DATABASE DIALOG BOX.eiteteieieieieeeeeereeeeeeeeeeeeesessseseeeeeseessssesssesssssesssesssesssssesesssssesesssssesesssesesssesesesesesen 66
FIGURE 4-48: LOCATE DATABASE FILES DIALOG BOX eeeieieiiiiiiiiieieieieeeeeeeeeeeeeeeeseeeseeesesesssssssssesssssesssesesssssesesssssesssssesesssssssssssenen 67
FIGURE 6-1: WELCOME DIALOG BOX.eeettteeeeiereerereeeeeeeeeeeeeeeeeeeseseeeeeseseessesesssessessesesssesesesesssesesesesesesesesesesessesseseseseseeeeesesesereren 73
FIGURE 6-2: END USER LICENSE AGREEMENT DIALOG BOX ceeeeeteeeieeeieeeeeeeeeeeeeeeeeeeeeeeesesesssssesssesseesesssesssssssesssssssesssssssessssssssssseren 74
FIGURE 6-3: ENTER CENTRIC 8 ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX.eeeverererereeererereeeeeeeeeseesseeesesessssseseeesesesens 74
FIGURE 6-4: CHOOSE APPLICATION DIALOG BOX.eevtteeerreeeeerereeereeeeeeeeeseseeeseeesesesesesesesessseseessesssesesssesesesesesesseesesesesssesesesesesssenen 75
FIGURE 6-5: CENTRIC 8 IMIODULES....cccititiiiiiieiieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeseeesesseeeeeeeeeeseeeeeesseseseseesseseeeeereseseeesereeeseseseeeseeerereren 76

298



Centric 8 Installation Guide

FIGURE 6-6: CHOOSE CENTRIC 8 IMIODULES (OPTIONAL)....eeetveeitteeeteesreesteesreesseessseessseessseessseesssesssseesssessssessssesssssessessssessanes 78
FIGURE 6-7: ENTER CENTRIC INSIGHT INFORMATION DIALOG BOX.eeeeeteeerererereeeeereeeeeeeseeeseeesesesereeesesssessssessssesssssesssesssessssssessssesen 78
FIGURE 6-8: CHECK SETUP INFORMATION DIALOG BOX eeteeeeeireeereeeeeeeeeseeeeeseeeeeseseseeesesesesesesssessessesssesssssssesssssssessssssseseessesssseesen 79
FIGURE 6-9: CENTRIC WILDFLY SERVICE RESTART REQUIRED DIALOG BOX ..evevererereeerererereeeeeeereeeeeseeesesesesesesesesesesesesesesesesssesesesenen 79
FIGURE 6-10: SETUP COMPLETE DIALOG BOX.eetteeeeeerereeeeeeeeeeeeeeeeeereeseesssseseeseessessssesesesssesesssesssesesssesssesesesesesesesesesssesseeseeessseren 80
FIGURE 6-11: WELCOME DIALOG BOX.eeeeteieiiiiirieieieieeeteeeeeeseeeseeeseeesesessssssessessssssessssesssssesesesesesesssessssessessseeeseseeesesessessesesereren 81
FIGURE 6-12: END USER LICENSE AGREEMENT DIALOG BOX ceeeteeeereereereeeeeeeeeeeeereeeeeeeseeesseesesssssesesesesesssesesesesssssesesesesesesssesesesesen 81
FIGURE 6-13: ENTER CENTRIC 8 ADMINISTRATOR USERNAME AND PASSWORD DIALOG BOX.eeeevvrerererererereeeeereeereeeeereresereeeeesesesesenens 82
FIGURE 6-14: CHOOSE APPLICATION DIALOG BOX.eeteteieteeeerereeeeeeeereeeeseeseeeeessesseesesesssesssssssesesssesesssesessessssessessesssssesesssesssssereren 82
FIGURE 6-15: CHECK SETUP INFORMATION DIALOG BOX.1etettirieererieieeeereeeeeeeeeseseeeeeeesesesssssssssssseesesssesssesssesssssssesesesssessessessseseren 83
FIGURE 6-16: CENTRIC WILDFLY SERVICE RESTART REQUIRED DIALOG BOX eevevererererererereeereeeeeeeeerereeeseseseeesesesesesesesesesesesesesessresen 83
FIGURE 6-17: SETUP COMPLETE DIALOG BOX.eeteeeieieieieieeeeeeeeeeeeseeeseeesessseseesseseessesesssesssssesssesssesesssesesssssesesssssesssesssesssesssesesesen 84
FIGURE 8-1: CENTRIC 8 SETUP PAGE...cciiiiiiiiiiiiiiiiiiceiececeeeeeeeeeeeee e et et e e et e e e e e e e e e e e e e e e e e e e e ae e e e e e e e e e e e e e e e e e et eeaeaeeeeseeeeaseeeeeeeeeeeseeeeeraren 91
FIGURE 8-2: EXPORT TO PDF OPTION iiiiiiiiiiiiiiiiiiieiieeeteeeeeeeeeeeeeeeeeeeseeeeeseeesesseeeeseseeeseseeesssesesesessseseseseseseseseseseseseseseseseseseseren 91
FIGURE 8-3: ADDING Al FILE ON THE DOCUMENTS TAB...ceetttttitereeteeeeeeeeeeeeeeeeeeeeeeeeeeeeeesesesesesesssesesesesesessseseseseseresesesesesesesesereren 92
FIGURE 9-1: CONNECT TO SERVER DIALOG BOX eeeeteieieieieieieereeeseeeseeesesesseeseeesessessesesssesssssesssssssssesssesssssssssssssssesssssesesessssssssseren 95
FIGURE 9-2: BACK UP DATABASE — C854 DIALOG BOX — GENERAL PAGE.....cciiiiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeseseeeeeeeeesseesssssssssssssssssssssasens 96
FIGURE 9-3: BACK UP DATABASE — C854 DIALOG BOX — OPTIONS PAGE ...cceveiiiiiiiiiiiiiiieieieieeeeeeeeeeeeeeeeeeeeeeeseseeesesesesesessessesesesenens 97
FIGURE 9-4: SUCCESSFUL BACKUP CONFIRMATION IMESSAGE ....ciittiiritieereeeeeeeeeseeeeeeeeeeesesseeseseeeeeeesesssesesseesessssessesesssesesssssssssesesen 98
FIGURE 9-5: FILEVAULT FOLDER LOCATION .cctttttiteteieeeeeeeeeteeeeeeeeseaeeseeeeeesseesesesesseseesesssssesesssesesssesssssesessessessseessesssessseesessesenen 100
FIGURE 9-6: SCHEDULED TASK WIZARD (1) DIALOG BOX..vveeveeetreesreeesuveesseeessseessseessseessesessssessssessssesssssssssessssessssensssesssesssesens 104
FIGURE 9-7: SCHEDULED TASK WIZARD (2) DIALOG BOX..vveeuveeeivreesueeessveenseeessseensseessssessesessssessssessssessssssssssssssessssessssesssessseens 104
FIGURE 9-8: SCHEDULED TASK WIZARD (3) DIALOG BOXu..veeeiuvreeeeiureeeeeseeeesiueeeeassseeeeassesesisssasasssssessssssssssssesasssssesssssssssssssasnn 105
FIGURE 9-9: SCHEDULED TASK WIZARD (4) DIALOG BOX..vveeuveeevreesreeessveesseeessseessseessssessesessssessssessssessssssssesssssesssssssseessssenssans 105
FIGURE 10-1: MICROSOFT SQL SERVER MIANAGEMENT IMIODULE DIALOG BOX eveeeeerereereererererereeeeeeeeeseeeseseeesesesesssesesesssesssesesenens 109
FIGURE 10-2: SPECIFY BACKUP DIALOG BOX ceeteeeiriiiiieieieieieeeeeeeeseeeeesesesessessesssessessesesssssssesesesessssessssesssssssesesssssesssessseeseeseeennn 109
FIGURE 10-3: LOCATE BACKUP FILE DIALOG BOX .eeieteieieieieieiririeeeeeeeeseeeseeeeesesesesseesesesssesssesssesesssssesssssessessssesssssssssessssessssessnen 110
FIGURE 10-4: SPECIFY BACKUP DIALOG BOX cevtveeeeeeerreeeeeeereereereeeeeeereeeeseesessesesssessssessssesssesssesesesesesssesesesssesesssesesssesssesssesessnen 110
FIGURE 10-5: RESTORE DATABASE CSIPIL... .ottt ettt ettt e e e e e e e e e e e e e e e e e e s e e e e e e e s e e e e e e e e e e s e e s e s e saeeessesesanans 111
FIGURE 10-6: BACK UP DATABASE - CSIPIL DIALOG BOX.ieiiiiiiiiiiiiieiiiiirieieeseeeeeeeeeseseeesesesesesseesesesesssessssessesssssssessssssssesessessnen 112
FIGURE 10-7: MESSAGE CONFIRMING SUCCESSFUL COMPLETION OF THE RESTORATION PROCEDURE ..ccevvvererererererererereeeeereeeeeeeeerenens 112
FIGURE 10-8: MICROSOFT SQL SERVER MANAGEMENT STUDIO c.ceetteeieereeeerereeereeeeeeeeeeeeeeeeereeeseeeseeesesesesesssesesessseresesesesesesesenens 116
FIGURE 11-1: ADMINISTRATOR: COMMAND PROMPT = SQLPLUS ..ccevteiiieiiiiiieiieeeeieeeseseeeeeseseeeeeseseseessssssessessessssessesssesssessessessnens 120
FIGURE 11-2: ADMINISTRATOR: COMMAND PROMPT — SQL PLUS (2) ...veeveeieeieeiesieeseeesieeieeteestessaeseeesaeesseessesneesseesseessesnsenns 121
FIGURE 11-3: CREATING A NEW FOLDER UNDER LOCAL DISK (C:) +veeevrreiuieeerieeiireestieesiteesteeestreesseeestaeesseeessseessseessseensseessseensenenns 121

FIGURE 11-4: ADMINISTRATOR: COMMAND PROMPT —SQL PLUS (3)
FIGURE 11-5: ADMINISTRATOR: COMMAND PROMPT
FIGURE 11-6: SERVICES WINDOW...eeieeteteeeeeerereeeeereeeeeeeeeeeesesesseseserseeesessessseseessesseeseesessssssseseseseseseseseseeesesesessseseeeseseeseeserennn
FIGURE 11-7: ADMINISTRATOR: COMMAND PROMPT .ciiiiiiiiiiiiiiiiiieececeeeeeeeeeeee e eee e e e e e e e e e e e e e e e e e e e s e e e s eeeseeeessesssasasssesssesssssenenans
FIGURE 11-8: ADMINISTRATOR COMMAND (2) ..covvvieeeeiieeeenneen.

FIGURE 11-9: ADMINISTRATOR: COMMAND PROMPT (3)
FIGURE 11-10: ADMINISTRATOR: COMMAND PROMPT (4)
FIGURE 11-11: ADMINISTRATOR: COMMAND PROMPT (5)
FIGURE 11-12: ADMINISTRATOR: COMMAND PROMPT (6)
FIGURE 11-13: SOURCE AND TARGET FILEVAULT PATH DEFINED IN THE CODE ..ceevtviiiieiieereeeeeeeeeeerereeeeeeeeeeeeesereeeeeseseeeseseesseseeenens 131

299



@® CentricSoftware’

Centric Software, Inc.

485 Alberto Way, Suite 200
Los Gatos, CA 95032, USA
Ph. No. - 1.408.574.7802

Technical Support

1.866.796.6218

8:00 AM-8:00 PM EST
Email: support@centricsoftware.com

Documentation Feedback

Email: documentation@centricsoftware.com



mailto:support@centricsoftware.com
mailto:documentation@centricsoftware.com

	PART I: INSTALLATION & CONFIGURATION REQUIREMENTS
	1. INSTALLATION ROADMAP
	1.1 INSTALLATION
	1.1.1 Single Server Installation
	1.1.2 Dual Server Installation
	1.1.3 Installation Roadmap



	PART II: INSTALLATION, CONFIGURATION & TESTING
	2. CENTRIC 8 INSTALLATION CHECKLIST
	2.1 HARDWARE CHECKLIST
	2.2 SOFTWARE CHECKLIST
	2.2.1 Supported Browsers

	2.3 PRE-REQUISITES

	3. SINGLE SERVER SOFTWARE INSTALLATION
	3.1 SINGLE SERVER SOFTWARE INSTALLATION
	User Information
	Install Centric 8
	Wildfly Service Installation
	Centric Authentication
	Select Database Type
	3.1.1 Microsoft SQL Server
	3.1.2 Oracle Database
	SMTP setup
	Relocate database files location



	4. DUAL SERVER SOFTWARE INSTALLATION
	4.1 Computer 1 Installation
	User Information
	Install Centric 8
	Install Wildfly Services
	Application Authentication
	Select Database Server Location
	Database Authentication and Centric Application Authentication
	SMTP Configuration

	4.2 Computer 2 Installation
	User Information
	Select Database
	Database Authentication and Application Authentication
	Create Database
	Move log file


	5. CONFIGURATION AND TESTING
	5.1 Configure Wildfly
	5.1.1 Previously Installed Wildfly
	5.1.2 Adding the Wildfly Plug-In & Virtual Directory Set Up
	5.1.2.1 To register the ISAPI filter
	5.1.2.2 To add a Wildfly Plug-in (Microsoft IIS Web Server 7.0 and 8.0)
	5.1.2.3 Virtual Directory Set Up (Microsoft IIS Web Server 7.0 and 8.0)

	5.1.3 Server Installation Testing


	6. APPLICATION SOFTWARE INSTALLATION
	6.1 Before Installing
	6.2 Centric 8 PLM Application Software Installation
	Enter the credentials
	Select Application
	Choose Modules
	Start Wildfly Services

	6.3 Centric 8 Operation Application Software Installation
	Enter Centric 8 Credential
	Select Application
	Start Wildfly Services



	PART III: BACKUP AND RESTORATION, UNINSTALLATION PROCEDURES
	7. RECOMMENDED PRACTICES
	7.1 Centric 8 Backup and Recovery Procedures
	7.1.1 Frequency of Backups and Recovery

	7.2 High Availability and Disaster Recovery Procedures
	7.3 Periodic Audit of Hardware and Network Usage; Plan for Upgrade
	7.3.1 Monitoring Centric 8 Servers

	7.4 Index Database Tables

	8. POST INSTALLATION CHECKLIST
	8.1 Post Installation Checklist

	9. BACKUP PROCEDURES FOR SQL SERVER
	9.1 Backup
	9.1.1 Manual Database Backup
	9.1.2 Backup – Database Backup (SQL Server)
	9.1.2.1 Back up the database using the SQL Server Management Tools

	9.1.3 Backup – FileVault
	9.1.3.1 Locate the FileVault path
	9.1.3.2 Search the pi-configuration.properties file
	9.1.3.3 Locate the FileVault folder in the database table
	9.1.3.4 Backup the FileVault


	9.2 Automatic Database Backup
	9.2.1 Application Server Script – Stop Server
	9.2.1.1 Stop the application server

	9.2.2 Database Backup Script – Backup Environment
	9.2.2.1 Set the backup environment and execute the SQL Server script

	9.2.3   Database Backup Script – SQL Server Script
	9.2.3.1 Create the SQL Server script

	9.2.4 FileVault Backup Scripts (Application Server) – Copy File Tree Script
	9.2.4.1 Locate the FileVault path
	9.2.4.2 Copy the file tree

	9.2.5 FileVault Backup Scripts (Application Server) – Scheduled
	9.2.5.1 Schedule the automatic backup

	9.2.6 Application Server Script – Start Server
	9.2.6.1 Start the application server



	10. RESTORATION PROCEDURES FOR SQL SERVERS
	10.1 Database Restoration
	10.2 Restore the Database
	10.2.1 Run the sp_change_users_login script on the master database

	10.3 Database Restoration: Different Server Instance
	10.3.1 Delete Log Files
	10.3.2 Run the sp_change_users_login script on the master database

	10.4 FileVault Restoration
	10.4.1 FileVault Location
	10.4.1.1 Locate the FileVault Path
	10.4.1.2 Rename or remove the current FileVault data
	10.4.1.3 Locate the original FileVault file location in the database
	10.4.1.4 Restore the FileVault
	10.4.1.5 Run the FileVault dependency script
	10.4.1.6 Restart Wildfly Service



	11. ORACLE DB BACKUP AND RESTORE PROCEDURE
	11.1 Backup
	11.2 Database Backup
	11.3 Backup FileVault
	11.3.1 Locate the FileVault path
	11.3.2 Search the pi-configuration.properties file

	11.4 Database Restore Procedure
	11.5 Restore Database
	11.6 FileVault Restoration
	11.6.1 FileVault Location
	11.6.2 Locate the FileVault path
	11.6.3 FileVault Dependancy Script for Oracle DB


	12. UNINSTALL CENTRIC 8

	PART 1V: APPENDICES
	Use Oracle Directories
	Export Database
	Import Database
	Transfer data between schemas (REMAP_SCHEMA):
	ExportC8.bat
	ImportC8.bat
	RebuildIdx.sql
	UpdateSequence.sql
	C8 Import/Export Integration Process
	Online Redo Log consideration
	Log file size
	Open TCP Ports on Windows Firewall
	Setup SQL Database Server
	Setup Oracle Database Server
	Setup Cluster App1
	Enable / Disable Services
	Enable Wildfly Clustering in Wildfly Service

	Setup Cluster App2
	Enable / Disable Services
	Enable Wildfly Clustering in Wildfly Service

	Start Wildfly on Cluster App 1
	Start Wildfly on Cluster App 2
	Configure Load Balancer
	Login to Centric 8 using Load Balancer URL
	Setup Print and Image Service on any Cluster APP servers
	WebAccess Shared Directory Installation
	WebAccess Wildfly Settings
	WebAccess IIS Settings

	Issues with the cache mechanism
	Reset Cache
	Cache test process
	Java Memory Error
	Wildfly Service Warning
	Batch File Suspension
	Wildfly Failure to Stop
	Increase Max Post Limit in Wildfly
	IIS Connection Timeout (for IIS7 and IIS8)
	IIS Maximum Allowed Content Length (for IIS7 and IIS8)
	Step 1: Install SMTP Server Service
	Step 2: Install IIS 6.0 Manager
	Step 3: Configure SMTP with IIS 6.0 Manager
	Configure SMTP to connect to email servers that require authentication
	Step 4: Configure Centric 8 SMTP Server Properties
	For Wildfly 8.1.0

	Step 1: Install SMTP Server Service
	Step 2: Install IIS 7.0 Manager
	Step 3: Configure SMTP with IIS Manager
	Step 4: Configure SMTP with IIS 7.0 Manager
	Step 1: Install SMTP Server Service
	Step 2: Install IIS 8.0 Manager
	Step 3: Configure SMTP with IIS Manager
	Step 4: Configure SMTP with IIS 8.0 Manager
	To install a new user license in Centric 8
	Change Admin Password: Post Installation Steps
	Change Password in Centric 8 UI
	Confirmation
	To Install Mobile App license
	Import Users from LDAP
	Optional Steps

	Configuration Files
	Image Services
	PDF Print Services
	Offline App Cache
	Advantages of Setting Offline App Cache
	Supported Browsers for Offline App Cache
	Pre-requisite Installation Files
	Setup Instructions
	Creating a Report DB in SQL Management Studio
	JasperServer / iReport Installation

	Add SQL Datasource Support to JasperServer
	Configuration Setups in iReport
	Wildfly8 Jasper Reports Setup Instructions
	Excel Export Format
	Pre-requisites
	Install URL Rewrite Extension
	Import the SSL Certificate
	Configure Automatic HTTP to HTTPS rewrite
	Modify Centric 8 configuration files to function properly using the https protocol
	Change PDF and Image Service Protocol to HTTPS
	Activate changes
	Verify that you can access the Centric 8 application


